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Introduction

This reference manual describes how to install and configure the OpX One broadcast-
automation system from Broadcast Software International (BSI). OpX One has been
designed from the ground up to deliver superior performance in single station environment.
OpX One offers an intuitive on-air environment, with full touch-screen capability, simple yet
powerful voicetracking, and an easy-to-use production interface.

Before using this manual, familiarize yourself with the Table of Contents on page 3. All first-
time users should read Chapter 1. A glossary of terms appears in Appendix C - Glossary
and troubleshooting suggestions are in Chapter 15.

Audience

This guide is intended for the person who installs, uses, and maintains the OpX One
software. This document assumes the reader has moderate hardware, computer, and
networking skills.

Document Revision Level

This section provides a history of the revision changes to this document.

Revision Document Version Date Description

A Version 1 March, 13, 2018 Initial release

Changes in this Revision

Initial version

Page 10 of 390




Product Overview

Document Conventions

This guide uses the following conventions to draw your attention to certain information.

Safety and Warnings

This guide uses the following symbols to draw your attention to certain information.

Symbol Meaning Description
< & Note Notes emphasize or supplement important points of the main text.
Tip Tips provide helpful information, guidelines, or suggestions for performing tasks more
effectively.
' Warning Warnings indicate that failure to take a specified action could result in damage to the
e ) device, or could result in serious bodily injury.

Typographic Conventions

This guide also uses the following typographic conventions.

Convention Description

Bold Indicates text on a window, other than the window title, including menus, menu options, buttons, fields, and labels.

Italic Indicates a variable, which is a placeholder for actual text provided by the user or system. Angled brackets (< >)
are also used to indicate variables.

screen/code Indicates text that is displayed on screen or entered by the user.

> bracket Indicates a shortcut for selecting menu options. For example, Edit > Settings means to select the Settings option
from the Edit menu.

<>angled Indicates a variable, which is a placeholder for actual text provided by the user or system. Italic font is also used to

brackets indicate variables.

[]square Indicates optional values.

brackets

{} braces Indicates required or expected values.

| vertical bar Indicates that you have a choice between two or more options or arguments.
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Product Overview

1 Product Overview

Topics: This chapter provides an overview of the OpX One

broadcast-automation system.
4 OpX One Modules (page
13)

A

A

4 Matching User Tasks with
Modules (page 14)
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Product Overview

1.1 OpX One Modules

OpX One is composed of separate modules. Each module can run on the same computer
for single-station installations, or they can run on separate computers for redundancy and
multi-station cluster setups.

Table 1-1 describes the OpX One modules. For more information about a module, go to the
page in the “See Page” column.

Table 1-1. OpX One Modules

Module Description See Page
File Server Tracks your audio files, their locations and attributes, stations to which they 33
belong, and data transfer between OpX One Audio Servers and OpX One Studio
Clients.
Audio Server Plays logs, executes macros, and performs record functions. 49
Auxiliary Audio Server Same as the main audio server, except that a studio client cannot connect to it. 122
This module can do background recording, as well as run a full station.
Studio Client Controls the audio server logs, plays back Hot Keys and used in voicetracking. 124
File Manager Performs all Info Editor functions, with the added ability to transfer files. 174
Clock Builder Creates clock templates. 204
Import-Merge Imports program logs from traffic- and music log-generating software, and merges 247
them into a single log along with clocks generated by the Clock Builder module.
Info Editor Creates and modifies audio file tags. Also, sets intro and segue points of cuts. 279
File Sync Transfers files between the file server and clients. Error!
Bookmark not
defined.
FTP Server Transfers files to audio servers. 292
Data Repeater Takes the PAD data output from the audio server, reformats the output if 301
necessary, and sends it to multiple destinations, such as RDS or stream
encoders.
Mobile Gateway/Client Used for IOS remote operation. 314
- The gateway runs on the OpX One network and allows access from the [0S
device.

« The client is the software that runs on the 10S device.

AS Watchdog Monitors the audio server process and restarts the Audio Server module if the 322
module becomes nonresponsive.
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Product Overview

1.2 Matching User Tasks with Modules

The information in this guide is designed so that you can begin using OpX One modules in
the shortest possible time, without having to read the entire guide. In fact, you might not
have to read some chapters and appendixes, except out of curiosity. To find out which
chapters and appendixes you need to read, identify the type of reader you are in

Table 1-2.
Table 1-2. Matching Readers with Modules
Chapter User Type
On-Air Satellite Program Engineer Traffic Support
Personality Program User Director Personnel | Technician

2 ° o

3 ° o

4 ([ ] [ ] [ ] [ ]

5 ° [ ° °

6 ° ° ° [

7 ° [ ° °

8 ° ° ° [ [

9 ° ° ° [ [

10 ° ° °

11 ° ° °

12 [ °

13 [ °

14 ° [

15 ° [

16 ([ ] (] [ ] [ ]

Appendix On-Air Satellite Program Engineer Traffic Support
Personality Program User Director Personnel | Technician

A [ ] [ ]

B ® °

C [ ] [ ]

D [ [ [ ] [ ] [ ]
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2 Installing the OpX One Software

This chapter describes how to install the OpX One
software.
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2.1 Installation Configuration

OpX One supports a single, all-in-one installation configuration. OpX One is designed to run
on a single workstation for on-air playout purposes (see Figure 2-1 for an example) for a
single station. Secondary production workstations can also be added (see Figure 2-2 for an
example) for log import, voice tracking, and adding audio files to the OpX One system.

OpX One is the stand-alone, single station version of the OpX automation system family.
For multi-station and redundant installations, take a look at OpX at www.bsiusa.com.

2.1.1 On-Air Workstation

Figure 2-1 shows the main OpX One installation configuration, where all modules are
installed and run from a single machine. All audio play-out derives from this workstation.

Figure 2-1. OpX One all-in-One Configuration
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2.1.2 Production Workstation

An OpX One production workstation is a workstation with the Studio Client module installed
along with the utility modules: Clock Builder, Import-Merge, and File Manager. The
production workstation will access all the same audio and program logs as the on-air
workstation. OpX One production workstations can be added to your network, so you can
import logs and voice track independently of the on-air workstation.

Production Workstation(s)

f Network

| On Air OpXJ
Figure 2-2. Production Workstation Configuration
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2.2 System Requirements

OpX One was designed and tested with the specifications in Table 2-1. Using hardware that
has not been tested and certified by BSI can cause issues that can be avoided by using the
following specifications.

Table 2-1. System Requirements

Specification Description
Processor Intel Xeon i5 or i7
RAM 4GB
File server File server with hard drive for operating system and applications, with one or more separate hard

drives for audio files. For clients/audio servers, use RAID 1. For file server, use RAID 10.

Operating system « Microsoft Windows 7

« Microsoft Windows 10

« Microsoft Windows Server 2008
« Microsoft Windows Server 2012

Network Two Gigabit Ethernet network-interface cards (NICs) and switches

Audio cards AudioScience 5xxx and 6xxx series PCI and PCle audio cards, including:
« Digital and analog audio cards

« Livewire cards

« AXIA or WheatStone AolP drivers

Broadcast tools + S588.2 - 8-channel audio switcher/16 channel GPIO
 S5S16.4 - 16-channel audio switcher/24 channel GPIO
 ACS 8.2 — 8-channel audio switcher/16 channel GPIO
 GPI-32 - 32-channel GPI

+ SRC 8-lll - 8-channel GPIO

« SRC 16 - 16-channel GPIO

Miscellaneous « Telos Axia audio drivers:

- Analog and digital audio nodes GPIO nodes
- Element control surfaces

« Audio nodes
« Control surfaces
» GPIO nodes

Audio files « Al audio files must have the same sample rate: 44.1 kHz, 32 kHz, or 22.05 kHz. If you have
audio files with differing sample rates, convert the files to a single sample rate. Tools such as
Adobe Audition have a batch-convert function to convert the sample rate for multiple audio files.

« You can mix mono and stereo audio files, as long as they are the same sample rate.

+ OpX One supports PCM wave 16-bit, MPEG 1 layer 2 (AKA MPEG 2), and mp3 audio files as
long as:
- Asuitable Windows ACM codec is installed for compressed format audio files, and

- The extension of each audio file is .wav (for example, “my audio file.wav”), even if the audio
file is formatted as an mpeg 2 or mp3 internally.
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2.3 Installation Instructions

This section provides instructions for installing the OpX One software.
Before you install the OpX One software:

- ldentify at least one static IP addresses that are available for use: one for the main on-air
OpX One PC, and one for each OpX One production PC. These are long-term IP
addresses that must remain static during the entire time you use OpX One, and they
must be on a single subnet. The installation uses this information in the configuration
files and shortcuts.

Q Tip: If you want to add modules to an OpX One workstation at a later time, run
the installer again and add just the modules you want. If you accidentally add a
module that is already installed, do not worry. The installer will not overwrite
your configuration and preferences for existing modules.

> To install the OpX One software
1. Exit all Windows programs.
2. Obtain the OpX_One_Setup.exe executable file and double-click it.

The Welcome screen appears.

Fowsw NN ==

OpX 1.6.5

Welcome to the installer for OpX 1.6.5.

It is strongly recommended that you exit all Windows programs
before continuing with this installation.

If you have any other programs running, please click Cancel and
close those programs before restarting this installer.

Otherwise, click Next to continue.

[ New> | [ cancel |
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3. Click Next.

The license agreement appears.

License Agreement
Please read the license agreement below and click Next to continue.

ATTENTION: PLEASE READ THIS DOCUMENT CAREFULLY. THE -
INDIVIDUAL OR ENTITY INSTALLING THIS SOFTWARE (the “"End-User") @
AGREES TO BE BOUND BY THE TERMS OF THIS LICENSE AND SUPPORT
AGREEMENT. IFYOU DO NOT AGREE TO THE TERMS OF THIS LICENSE

AND SUPPORT AGREEMENT, REMOVE THIS SOFTWARE FROM YOUR
SYSTEM, DO NOT USE THE SOFTWARE AND PROMPTLY RETURN THE
EEETQ:'GE[E)E’SCKAGE AND ITS CONTENTS, AND THE LICENSE PRICE WILL

BROADCAST SOFTWARE INTERNATIONAL
SOFTWARE LICENSE AND TECHNICAL SUPPORT AGREEMENT

) | agree to the terms of this license agreement
@ | do not agree to the terms of this license agreement

[ <Back | Mew> | [ cancel |

4. Read the license agreement, and then click | agree to the terms of this license
agreement .

0 Note: You must agree to the terms to proceed with the installation.

5. Click Next.

You are prompted to select the options you want to install on this computer.

Select Options
Select the options below and click Next to continue.

Please select the options below:

Install File Server

Install Audio Server

Install Studio Client

Install File Manager, Import/Merge, Clock Builder
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6. Check the options you want to install on this computer. Click Next.

You are prompted for a folder where the selected options will be installed.

B I, ==

Installation Folder
Select an installation folder and click Next to continue.

The software will be installed in the folder listed below. To install to a different folder,
either type in a new path, or click Change to browse for an existing folder.

Install OpX to:
-\Program Files (x86)\Broadcast Software International\OpX] Change...

Space required on drive: 62.3MB
Space available on selected drive: 408692 MB
<Back |[  MNew> | [ cancel | ‘

7. Accept the default location shown, or enter a different location or click the Change button
and select the location where you want to install the OpX One options.

The bottom of the page shows the amount of space required to install the selected
options and the amount of space available on the selected drive.

8. Click Next.

You are prompted for IP addresses of the local system and the OpX One file server
system.

(ﬁi Note: If you need to change the IP address of the OpX One file server system,
use Edit > Settings in the OpX One File Server module (see section 3.3).
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5 OpX Setup

Enter Data
Fillin the items below and click Next to continue.

Please provide the following information:

What is the IP address of the local system?
10.1.1.10

What is the IP address of the OpX file server system?
10.1.1.10

[ <Back |[  MNewt> | [ cancel |

9. Enter the IP addresses in their respective fields, and then click Next.

You are prompted to select a shortcut folder.

Shortcut Folder
Select a shortcut folder and click Next to continue.

Setup will add shortcut icons to the folder indicated below. If you don't want to use the
default folder, you can either type a new name, or select an existing folder from the list.
For NT, 2000 and XP users the folder will be created in the curent user's profile.

Shortcut Folder:

10. Accept the default folder shown or select a different folder, and then click Next.

The Ready to Install screen tells you that there is enough information to install OpX One
on your computer.
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Ready to Install
You are now ready to install OpX 1.6.5.

The installer now has enough information to install OpX on your computer.
The following settings will be used:
Install folder: C:\Program Files (x86)\Broadcast Software Intemational\OpX

Shortcut folder: Broadcast Software

Please click Next to proceed with the installation.

<Back || MNew> | [ Cancel

11. To review or change your settings, click Back until you reach the appropriate screen,
make the required changes, and then click Next until the screen above appears.

12. Click Next to install OpX One using the settings you specified. The OpX One software is
installed and the Installation Complete screen appears.

Installation Complete
Installation completed successfully.

0pX 1.6.5 has been successfully installed on your system.

Please click Finish to exit this installer.

13. Click Finish to close the screen.

14. Change the permissions of the BSI folder in %PROGRAMFILESS86 that everyone can
modify the folder. Otherwise, the system places user data in %PROGRAMDATi#tead of
%PROGRAMFILES%or Microsoft Windows systems:

a. Right-click the BSI folder, click Properties .
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b. Click the Security tab, and then click the Edit button.

. Permissions for Common Files
| Security \
Object name:  C:\Program Files\Common Files

Group or user names:
2, SYSTEM
2, Administrators gest-PC\Administrators)
82, Users test-PC\Users)
2, Trustedinstaller

Pemissions for CREATOR

OWNER Allow Deny

Full control O B
Read & execute =l =l
List folder contents o (]
Read [ 0 -

m

Leam about access control and permissions

[ OK ] [ Cancel Apply

c. Click the Add button.

d. Atthe Select Users or Groups dialog box, type Everyone in the Enter the object
names to select field.

e. Click Check Names .

f. At the Permissions for VNC Shortcuts dialog box, click Everyone in the Security tab,
check Modify in the Allow column, and click OK.

15. Proceed to the next section to register your OpX One system.
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2.4 Installing the USB Registration Key

After you install the OpX One software, you install the USB registration key. Registration is
performed using a hardware registration key on the supplied Universal Serial Bus (USB)
memory (data) stick.

The hardware key requires a software diver called the Sentinel Protection Windows driver in
order for the File Server to access the hardware. The driver can be provided on a BSI
installation CD (see section 2.4.1) or downloaded from the Drivers page on the BSI website
(see section 2.4.2). Always ensure that you have the latest BSI-tested driver when
purchasing a new product.

¢ Note: Install the driver and USB registration key and driver on your File Server
workstation only. Other BSI products may require their own hardware key. Only one
hardware key can be installed per workstation. If you received multiple registration
keys for BSI products you intend to run on a single machine, contact BSI Sales.

?\  Warning: Do not insert the registration key into a USB port on your file server until
the Windows software driver is installed using the following procedure.

2.4.1 Installing the driver from the BSI Installati  on CD

The following procedure describes how to install the Sentinel Protection Windows driver
from a BSI Installation CD. If you downloaded the driver from the BSI website, use the drive-
installation instructions in section 2.4.2 instead.

> To install the driver from the BSI Installation CD
1. Insert the supplied CD into your computer's CD-ROM or DVD-ROM drive.

The BSI utility launches automatically. In the unlikely event that the BSI utility does not
launch, use Windows Explorer to browse to your computer's CD-ROM or DVD-ROM
drive and double-click the Install.exe file on the CD. The application selection window

appears.
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3 roadcas;ﬂSoftware International
Software Installation CD

2. Using the Application drop-down list, click Sentinel Protection Installer — for BSI
Dongle . This is the first option from the drop-down list.

3. Click Install .

4. Proceed to section 2.4.3 to install the Sentinel Protection Windows driver.

2.4.2 Downloading the Driver from the BSI Website

The following procedure describes how to install the Sentinel Protection Windows driver
from a BSI Installation CD. To install the driver from CD, use the drive-installation
instructions in section 2.4.1 instead.

1. Launch a web browser and go to the BSI Drivers page at http://www.bsiusa.com.
2. Download the driver into a new folder.

3. After downloading the driver, extract the files into the new folder.

4. Double-click the .exe file that was extracted in the previous step.
5

. Proceed to section 2.4.3 to install the Sentinel Protection Windows driver.

2.4.3 Installing the Sentinel Protection Windows Dr  iver

After starting the Sentinel Protection Installer from the BSI Installation CD or by downloading
from the internet, use the following procedure to complete the installation.
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» To install the Sentinel Protection Windows driver

1. If the following security warning appears, click the Run button.

File Download - Security Warning 5]

Do you want to run this file?

Name: Sentinel Protection Installer 7.5.0.exe
Publisher. SafeNet, Inc.
Type: Application

While files from the Internet can be useful, this file type can
potentially harm your computer. Only run software from publishers
you trust. What's the risk?

2. At the next screen, click Next.

fi§ Sentinel Protection Installer 7.5.0 - InstallShield Wizard ’ x|

Welcome to the InstallShield Wizard for
Sentinel Protection Installer 7.5.0

The InstaliShield{R) Wizard will install Sentinel Protection
Installer 7.5.0 on your computer. To continue, click Next.

Protection Installer

3. When the License Agreement page appears, read the Software License Agreement. If
you agree to its terms, click the | accept radio button, and then click Next.

(3 Note: You must agree to the terms to continue with the installation.
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{i& Sentinel Protection Installer 7.5.0 - InstallShield Wizard x|
—_ -
License Agreement -
Please read the following license agreement carefully. Protection Installe‘r
License GrantWarranty for Software i’

This License describes limited rights granted by SafeNet, Inc. and/or one of its
subsidiaries (such grantor, "Seller") to the Buyer.

A.  The term "Software”, as used herein, shall mean a program or programs
consisting of machine readable logical instruction and tables of information
designed as libraries or drivers to work in conjunction with Seller's Sentinel

Keys ("Products”). Title to all Software furished to Buyer hereunder shall ~

vamanin in Qallay Callav avamba ta Diniar A nan avaliiaiis wan tvanafavabla

(% 1 accept the terms in the license agreement! Print l

(" 1do not accept the terms in the license agreement

Instalishield

<gack [ mext> | cancel |

4. Atthe Setup Type page, click Custom, and then click Next.

{& Sentinel Protection Installer 7.5.0 - InstallShield Wizard x|
——— —
Setup Type o ’sw l- '
Choose the setup type that best suits your needs. 4 Protection Installe-r

Please select a setup type.

" Complete

i All program features will be installed. (Requires the most disk
[l space.)

Choose which program features you want to install. Recommended
for advanced users.

< Back I Next > I Cancel

5. At the Custom Setup page, disable all options for installing the Sentinel Protection Server
driver component and the Sentinel Keys Server driver component by clicking the
Selection button, and then clicking This feature will not be available , as shown below.
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i Sentinel Protection Installer 7.5.0 - InstallShield Wizard x|
SRR ¥ Sentinel

Select the program feat: ou want installed. Protection Installe:r

Click on an icon in the list below to change how a feature is installed.
= =3 - | Sentinel System Drivers Pt [‘e"jc_": i)

=3~ Parallel Driver The network license manager for
:’ . protected applications with
&3 v | USB System Driver Sentinel Hardware Keys.

X _~| Sentinel Protection Server

1D &4l Sentinel K ver

(= | on

=38 This feature, and all subfeatures, will be installed on local hard drive.
This feature will not be available.

Install to:
C:\Program Files\Common Files\SafeNet Sentinel\Sentinel Keys Server\,

InstallShield

Help | Space < Back I Next > I Cancel

6. Click Next.

The installer is ready to copy its files to your computer’s hard drive.

{i Sentinel Protection Installer 7.5.0 - InstallShield Wizard x|
— ——
Ready to Install the Program
The wizard is ready to begin installation. Protection Installe-r

Click Install to begin the installation.

If you want to review or change any of your installation settings, click Back. Click Cancel to
exit the wizard.

< Back Cancel

7. Click Install .
The files are copied to your hard drive.

8. After the Sentinel Protection driver is installed, click Finish at the InstallShield Wizard
Complete page to complete the installation.
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{i& Sentinel Protection Installer 7.5.0 - InstallShield Wizard : x|

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed Sentinel
Protection Installer 7.5.0. Click Finish to exit the wizard.

Protection Installer

< Back Cancel

9. Reboot your computer.

10. After the computer reboots, insert the USB memory stick into an available USB port on
your computer.

Windows detects the hardware key and displays the Found New Hardware message in
the system tray.

1) Found New Hardware |X
SafeNet USB SuperProjUltraPro

11. You now have installed the USB Registration Key. Proceed to section 2.5 to enter the
Validation Code to register your OpX One system.
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2.5 Registering Your OpX One System

The File Server module handles registration information for your OpX One system. An OpX
One license allows you to define two station profiles on the File Server; one for the main
Audio Server, and a secondary one for the Auxiliary Audio Server. The number of Studio
Clients (or any other OpX One module) you can run on your network isn't limited in any way.

Before you enter your registration code into the OpX One File Server module, you must
install the Sentinel Protection driver, which is the driver for the USB Registration Key (see
section 2.4). If you have not already done so, install the driver, and then register your OpX
One system.

> To register your OpX One system

1. Insert the USB Registration Key driver into an available USB port on the workstation
running the OpX One File Server module.

&

2. Click the Windows Start menu and click Programs > Broadcast Software > OpX File
Server.

The OpX One File Server module opens and the Register page prompts you for an
authorization code.

¢ Note: Inthe unlikely event the Register page does not appear, go to the Edit menu
in the File Server module and click Register .

3. Enter your authorization code in the Authorization Code field. The authorization code
consists of five sets of four digits, separated by dashes (for example, ##H-HitiH-#HHE-
#HHHE-#H). Your authorization code is provided by your OpX One Distributor. If you do
not have an Authorization Code, or if you lost it, contact your distributor or BSI sales.
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Register x|
Senal Number
[601B-014E-2E72-850C B

Authorzation Code

| o

[Vox | % conce|

Figure 2-2. Register Window

4. After you enter your authorization code, click OK.

Your OpX One system is registered and your File Server is now ready to accept connections
from the Audio Server, Studio Clients, and all other OpX One modules.

2.6 Where to Go from Here

You have now installed OpX One on your on-air workstation. If you are installing the OpX
One modules on one or more production systems, repeat the procedure in section 2.3 for
each production workstation, installing the pertinent modules for each system. After you
finish installing OpX One on all your workstations, you are ready to configure the modules.
Proceed to the remaining chapters in this guide for information about configuring the OpX
One modules you intend to use. For assistance matching users and modules, see

Table 1-2 on page 14.
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Topics:

A

Starting the File Server
Module (page 34)

Quick Tour (page 35)

Configuring the File
Server Module (page 40)

Adding and Removing
Stations (page 42)

Enabling or Disabling the
Virtual Audio Server (page
46)

Enabling or Disabling the
Voicetrack Transfer
Module (page 47)

Remote Voice Track
Transfer Module (page
48)

3 File Server Module

This chapter describes the OpX One File Server module.

The OpX One File Server module acts as the traffic cop
that oversees the repository for all your audio files and
configuration files. The File Server tracks your audio
files, their locations, their attributes (Artist, Title, Genre,
etc.), and data transfer to and from the OpX One Audio
Server and OpX One Studio Clients. An OpX One
system contains a singular OpX One File Server and
audio server, but can contain multiple instances of the
Studio Client module and other utility modules.
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3.1 Starting the File Server Module

The File Server module is the foundation of the OpX One system. It directs communications
between the other OpX One modules. Therefore, you must start the File Server module

before you start any other OpX One module.

To start the File Server module

containing the OpX One serial number and authentication code.

Broadcast Software > OpX One File Server

If the OpX File Server window shown below
doesn’'t appear when it is running, it may be
minimized. To open the OpX File Server when it

i

In an available Universal Serial Bus (USB) port on your PC, insert the supplied dongle

On your PC, click the Start button on the Windows taskbar, and then click Programs >

is minimized, look for the File Server icon in the
“System Tray” by the Windows System Clock (as
shown at right). Hold down the CTRL key on your
key while double-clicking on the OpX File Server
icon to open the window shown below.

11:14 AM
03/13/2018

g & W i

-

£ OpX File Server - REGISTERED
File Edit About

=N
2
N

TCP Connections 0

FTP Connections 0

E=3 §ol =<~

v0.0.0.169

Note: If the message Security key / driver is not installed
section 15.1.

«

appears, see
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File Server Module

The following sections provide a quick tour of the File Server module interface.

' + OpX File Server - Registered - 10 Stations

Lo

—_ 1

O—

File Edit About

v
N

TCP Connections 2

10.1.1.10
10.1.1.10

FTP Connections 1
10.1.1.10

& || &0

| mlo— @

WBSI | WBSIRECORD | 3 WOPX KJUB
“All Justin's music, all the time!"
Folder Contents Description
D:AOpX\Spots SPOTS Spots
D:AOpX\News AUDID News
D:\OpX\Records RECORDS Records
D:A\OpX\SharedConfig SHAREDCONFIG  Shared Configuration
D:AOpX\KJUB\Music MUSIC Music
D:\OpX\KJUBALogs LOGS Program Logs o—
D:AOpX\KJUBNRunLogs RUNLOGS Run Logs
D:ADpXVKJUBACarts CARTS Carts
D:AOpX\KJUB\Hotkeys HOTKEYS Hotkeys
D:AOpX\KJUB\Yoicetracks VOICETRACKS Voicetracks
D:AOpXYKJUBAConfig CONFIG Configuration
D:ADpXVKJUBAT emporary TEMPORARY Temporary
D:AOpXNKJUBNImaging AUDIO Imaging
D:AORX\KJUBNFIll FILL Fill Material
D:AOpX\KJUBALiners AUDIO Liners
D:AOpXNKJUBMingles AUDIO Jingles
D:AOpX\KJUBAPromos AUDIO Promos

10.0.0.141 @—————— @)

Note: The image above shows a multi-station configuration of OpX. OpX One

allows only a single-station profile, plus a station profile for an Auxiliary Audio
Server, so OpX One users will have a maximum of two station profile tabs.

Number

Description

Menu bar. See section 3.2.1.

Tool bar. See section 3.2.2.

Connection list. See section 3.2.3.

File Server module version.

Station folder list. See section 3.2.4.

0000066

Each station appears as a tab. Click the tab to view the contents in the station folder. If the
number of folders exceeds what can be shown, use the - or 1% button to scroll left or

right.
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3.2.1 Menu Bar

The menu bar appears at the top of the File Server window. The following sections describe
the menu options.

3.2.1.1 File Menu

Enable Remove Voicetrack Stations =

Edit About enables or disables the Audio Server to allow
Enable Remote Voicetrack Stations studio clients to edit voice tracks on other OpX
Enable Remote Voicetrack Transfer One system locations. See section 3.5.

Exit Enable Remove Voicetrack Transfer =

enables or disables the Voicetrack Transfer
module. This module updates your local OpX
One File Server with the latest voicetrack and
log information from remote OpX One
systems. See section 3.6.

Exit = exits the File Server module.

3.2.1.2 Edit Menu

Settings = configures File Server module
File About settings. See section 3.3.

Setti . ,
SHngs Register = shows the serial number and

validation code for your OpX One software. If
the message Security key / driver is not
installed appears, see section 15.1.

Register

3.2.1.3 About Menu

Opens a window that shows the version and
Eile Edit [About] build date of the File Server module you are
running. This window also shows the amount
of memory and virtual memory being used,
and the amount of time that the File Server
module has been running. See Figure 3-1 for
an example. To close the window, click OK.
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v0.0.0.163

Build Date:
Aug 11 2014 07:24:00

Memory Usage:
11,912K /11,924K

VM Usage:
6,236K / 6,416K

-

Running Time: 1 Hour, 23 Minutes, 48 Seconds

Figure 3-1. Example of About Information
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3.2.2 Tool Bar

The File Server module tool bar appears below the menu bar.

0 3| & % | & O

Moving the screen pointer over a tool displays the tool’s function as a tooltip. For example:

File About
</
IN

TCP C add Station

Table 3-1 describes the tools on the tool bar.
Table 3-1. File Server Module Tool Bar

Tool Tool Name Description Tool Tool Name Description
Add Station Adds stations to the File Remove Folder This function is
Server module. See disabled. Contact BSI
j section 3.4.1. for information about
removing folders.
Remove Station This function is disabled. Enable Remote Enables remote
Contact BSI for Voicetrack voicetrack stations.
% information about ﬁ) Stations See section 3.5.

removing stations.

Add Folder Adds folders to a station. Enable Automatic | Updates the latest
- See section 3.4.2. Voicetrack voicetrack and log
= ) Transfers information between

the local and remote
OpX One systems. See
section 3.6.
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3.2.3 Connections List e

The Connections List shows the IP address of each module 192.168.1.90
accessing the File Server. If multiple modules are accessing the File 13313311132

Server at the same time from the same machine, the same IP
address might be shown multiple times.

The Connections List has two fields:

« TCP Connections at the top shows connections by any module
performing real-time control. Examples include Studio Clients,
Audio Servers and Auxiliary Audio Servers, the Import — Merge
module, or the Clock Builder module. A number at the top-right (3
in the example to the right) shows the number of current FTP Connections 1
connections. 192.168.1.94

« FTP Connections at the bottom shows any connections that are
transferring files. Examples include the File Manager module, Info
Edit module, or an Audio Server actively transferring audio files. A
number at the top-right (1 in the example on the right) shows the
number of current connections.

3.2.4 Station Folder List 08 51 S RSIREE0RD] (B
“WOPX - The Best Rock!"
1 1 Folder Contents Description
The Station Folder List creates a tab for v i AR
eaCh Statlon yOU add tO your OpX One gtgﬁtzﬁ‘::a’géonhg EEEQESEONFIG Es:fe[ddstonliguvalion
. D:AOpX\WOPX\Music MUSIC Music
system. Each tab shows a list of the folders DADEKWOPX\Logs LOGS Progiam Logs
D:AOpX\WOPX\RunLogs RUNLOGS Run Logs
H i H D:AD OPX\Carts CARTS Carts
available to each station and contains the DAL ATea e A8
. D:ADpX\WOPX\Voicetracks VOICETRACKS Voicetracks
foIIowmg columns: D:AORXAWOPXA\Config CONFIG Configuration
D:AOpX\WOPXAT emporary TEMPORARY Temporary
D:AOpX\WOPX\Imaging AUDIO Imaging .
- Folder = full path to the folder. DADBAWDPHLines AU o
D:AOpX\WOPX\ingles AUDIO Jingles
. Contents = type of data in the folder (for DADHNew Folde alDi0 M New Fldr
<

example, AUDIO, RECORDS, LOGS).

- Description = description of folder contents (for example, News, Records, Music).

¢ Note: The image above shows a multi-station configuration of OpX. OpX One
allows only a single-station profile, plus a station profile for an Auxiliary Audio
Server, so OpX One users will have a maximum of two station profile tabs.
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3.3 Configuring the File Server Module

« To open the OpX File Server when it is
minimized, look for the File Server icon in the
“System Tray” by the Windows System Clock (as ArE B0 11:14 AM -
shown at right). Hold down the CTRL key on your = 03f13/2018
key while double-clicking on the OpX File Server
icon.

The File Server module comes with default configuration settings that should suit most
users. Using the Settings option on the Edit menu, you can change these settings to suit
your requirements.

> To configure the File Sethngs =)
Server module settings
_ . I Delete Voicetracks After | 7] Zl Days
1. On the Edit menu, click
Settings ) ™ Enable Next Play Updates From Future Program Logs
The Settings dialog box [v Keep FTP Server Running

shown at right appears. Network Intexfac

[10.1.1.10 - OpX |

Compression For Remote Stations

2. Complete the fields in the
Bit Rate

dialog box (see [_j
128 | kbps

Stations To Search For Common Folder Duplicates

v WBSI
v KBSI

v 0K X Cancel |
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3. Table 3-2).
4. Click OK.
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Table 3-2. Fields in the Settings Dialog Box

Field Description Default

Delete Voicetracks After n Days Maximum number of days that the system retains voice tracks before Disabled
deleting them. To enable this option, check the check box, and then either
accept the preset value (7) or change it.

Enable Next Play Updates From When using the studio interface, enabling this option allows the jock to see Disabled
Future Program Logs when a selected item is going to play next, If this option is enabled, OpX
One looks at future logs as well as today’s log to find the item.

Keep FTP Server Running Allows the File Server to check whether the FTP server is running and Enabled
restarts it if it is not running.

Network Interface IP address of the OpX One network interface. See GUI

Bit Rate Allows you to change the native bitrate of the audio files in OpX One. Only 128 kbps
files that are encoded with that bit rate will be able to be imported.

Stations To Search For Common | Check to have OpX One search for files with the same name in other folders Enabled

Folder Duplicates for the stations you are managing.

3.4 Adding and Removing Stations

¢ Note: OpX One allows only a single-station profile, plus a station profile for an
Auxiliary Audio Server, so OpX One users will have a maximum of two station
profiles.

The OpX One system is organized by “station.” This means you must create a station on the
File Server for each Audio Server or Auxiliary Audio Server you want to run.

3.4.1 Adding Stations to Your File Server

The following procedure describes how to create a single station. To create multiple stations,
repeat this procedure for each additional station you want to create.

> To create a single station

1. On the tool bar, click ﬁ

The Add Station dialog box appears, as shown on the next page.
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2. Complete the fields in the Add Station
dialog box (see Station
3. |
4 IDescnptlon
Market
INot Applicable LI 4p New Market
[~ Local Station - Yoicetracked / Programmed Remotely
5. Table 3-3). ¥
. [~ Remote Station - Yoicetracked Locall
6. Click OK. * "
[~ Programmed Locally
7. To create additional
] hi Common Folders
stations, repeatt IS ¥ Spots
procedure.
v News
|v Records
X Cancel |
Table 3-3. Fields in the Add Station Dialog Box
Field Description Default
Station Enter the call sign for identifying this station. —
Description Enter a full description of the station. This description will identify this station —
in OpX One.
Market Use this field and the New Market button when using Remote Voicetracking Not Applicable

(see section 3.7). For a standard station profile, you can leave this field set
to “Not Applicable,” although you can configure a market name if desired.

Local Station — Voicetracked Check this check box when using Remote Voicetracking (see section 3.7). Not checked
[Programmed Remotely For a standard station profile, you can leave this check box unchecked.
Remote Station — Voicetracked Check this check box when using Remote Voicetracking (see section 3.7). Not checked
Locally For a standard station profile, you can leave this check box unchecked.
Programmed Locally Check this check box when logs are being built at the same offsite location Not checked
where voice tracks are being recorded. Leave this check box unchecked
when logs are merged back at the primary location.
Common Folders Check the folders you want this station to use. Al files in the Common Checked

folders can be made available to any other stations.
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3.4.2 Adding a New Folder to a Station

When you create a station in OpX One, a set of default folders is created for that station.
However, you can add more folders to organize your audio files or other file types to your
liking.

» To add a new folder to a station

Y
1. On the tool bar, click -y

An Add Folder dialog box similar to the image shown at right appears.

AddFolder - WBSI - The Best Of BSI

2. Complete the fields in Name
the dialog box (see | |
Table 3-4). ™ Use Common Folder
3. Click OK.
Contents
4. Restart the station's FTP | Ll

server, Audio server and

. Descripti
File Sync modules for | St it
the change to take
effect.
Table 3-4. Fields in the
X Cancel
Add Folder
Dialog Box
Field Description Default
Name Enter the name of the folder. This name should allow you to differentiate this —
folder from other folders.
Use Common Folder To share this folder with other stations in your OpX One system, check this Not checked
check box. You can then share this station with other stations using the
procedure in section 44. When checked, OpX One does not add the folder
to other stations automatically.
Contents Select the type of data you will store in the folder. —
Description Enter a description of the contents in the folder. —

3.4.3 Adding a Common Folder to a Station

After you add a new folder to a station using the procedure in section 3.4.2, you can make
that folder available on another station. This feature is useful if you want to share the same
content, such as spots, jingles, sound effects, between stations.
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> To add a common folder to a station

Y
1. On the tool bar, click i

The Add Folder dialog
box shown at right

appears. Name
I &

™ Use Common Folder

AddFolder - WBSI - The Best Of BSI

2. Complete the fields in the

dialog box (see Table i:°"‘°"‘$ -
3.5).
3. Click OK. Description

4. Restart the FTP server
followed by the Audio

Server and File Sync X Cancel |

modules for the change to

take effect.

Table 3-5. Fields in the Add Folder Dialog Box
Field Description Default
Name Use the drop-down list to select the folder you want to make available to this —
station.

Use Common Folder Check this check box to make this folder available to this station. Not checked
Contents Select the type of data you will store in the folder. —
Description Enter a description of the contents in the folder. —
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3.5 Enabling or Disabling the Virtual Audio Server

The File Server’s Virtual Audio Server must be enabled to allow studio clients to edit voice
tracks on other OpX One system locations. If the File Server’s Virtual Audio Server is not
running, the Remote Voicetrack station profile will not appear in the Station Selection
window of the studio client.

> To enable the Virtual Audio Server

1. Click Enable Remote Voicetrack Stations on the File menu.

OR
Click the & icon.

2. To confirm that the Virtual Audio Server is running, click the File menu and confirm that a
check mark appears next to Enable Remote Voicetrack Stations

File | Edit About
v Enable Remote Voicetrack Stations

Enable Remote Voicetrack Transfer

Exit

» To disable the Virtual Audio Server

1. Click Enable Remote Voicetrack Stations on the File menu.

OR
Click the & icon.

2. To confirm that the Virtual Audio Server is no longer running, click the File menu and
confirm that a check mark no longer appears next to Enable Remote Voicetrack
Stations .

Edit About

Enable Remote Voicetrack Stations

Enable Remote Voicetrack Transfer

Exit
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3.6 Enabling or Disabling the Voicetrack Transfer M odule

The File Server's Voicetrack Transfer module updates the latest voicetrack and log
information between the local OpX One File Server and remote OpX One systems.

» To enable the Voicetrack Transfer module

1. Click Enable Remote Voicetrack Transfer on the File menu.

OR
Clickthe ¥ icon.

2. To confirm that Voicetrack Transfer module is running, click the File menu and confirm
that a check mark appears next to Enable Remote Voicetrack Transfer

Edit About
Enable Remote Voicetrack Stations

v Enable Remote Voicetrack Transfer

Exit

» To disable the Voicetrack Transfer module

1. Click Enable Remote Voicetrack Transfer on the File menu.

OR
Click the % ' icon.

2. To confirm that the Voicetrack Transfer module is no longer running, click the File menu
and confirm that a check mark no longer appears next to Enable Remote Voicetrack
Transfer .

Edit About

Enable Remote Voicetrack Stations

Enable Remote Voicetrack Transfer

Exit

Page 47 of 390



File Server Module

3.7 Remote Voice Track Transfer Module

The Remote Voice Track Transfer module transfers voice tracks from a remote studio to the
primary OpX One network automatically, without requiring user intervention. Just run this
module on the local and remote file servers, and the files transfer between the serves
automatically.
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OPYONE

Topics:

A

Starting the Audio Server
Module (page 50)

Quick Tour (page 51)

Configuring the Audio
Server Module (page 60)

Loading the Program Log
(page 115)

Adding, Editing, and
Deleting Items in the
Program Log (page 116)

Playing Back a Program
Log Item (page 120)

4 Audio Server Module

This chapter describes the OpX One Audio Server
module.

The OpX One Audio Server module handles audio
playback and recording.

The OpX One Audio Server module reads your program
log, interfaces with general-purpose input/output (GPIO)
devices and your audio switcher, and handles
background recording of audio.
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4.1 Starting the Audio Server Module

You must start the File Server module before you start the Audio Server module.

> To start the Audio Server module
1. Start the File Server module (see section 3.1).

2. Double-click the Audio Server icon on your desktop m or click the Windows Start
button and click Programs > Broadcast Software > OpX One Audio Serve .

An Audio Server window similar to the following appears. The first time the window
appears, it will be empty.

& Audio Server - WBSI o] @
File Edit Action About

ﬁ El it 00:45:18
T
r1-" rb;\.
L e

| ltem | Description Mame Sched /Actual | Length
Log Position -

Dieck Count -

b i

Awiliany

Tirnz Shift

[Daulcas | Connections tstahm [Rn(:nrd [ Playback

Apdition

vi.0.0.729
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4.2 Quick Tour

The following sections provide a quick tour of the Audio Server module interface.

TMIN SPOT2CA.. TMINS...
TMIN SPOT CART TMINS...

pots
TMIN SPOT2CA...
TMIN SPOT CART

COMMERCIALBR...
SATSHOW STO...

TIMESHIFT ABC ...

01:00 Local Spots

TMIN SPOT2CA.. TMINS...
COMMERCIALEBR...

TIMESHIFT Dr La...

pots
1MIN SPOT CART
TMIN SPOT2CA...

TMIN SPOT CART
COMMERCIALBR...

COMMERCIALBR...
03:00 Local Spots

AMIN CONTACA 1IN C K nn_2

25
26
27
29
30
31
32
33
34
35
36
37
20

v0.0.0.319

Menu bar. See section 4.2.1.

Tool bar. See section 4.2.2.

Playback, Record, Status, Connections, and Devices tabs. See sections 4.2.3, 4.2.4, 4.2.5,
426,and 4.2.7.

Program log display. See section 4.2.8.
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4.2.1 Audio Server Module Menu Bar

The menu bar appears at the top of the Audio Server window. The following sections

describe the menus on the menu bar.

4.2.1.1 File Menu

File | Edit Action About
Load Log... Ctrl+L

Exit

4.2.1.2 Edit Menu

File Action About
Add...
Edit...
Delete

Settings...  Ctrl+S

4.2.1.3 Action Menu

File Edit About

P start Ctrl+T
Stop Ctrl+X

¢¢ Run Macro... Ctrl+M

Load Log = loads logs manually. See section
4.4.

Exit = exits the Audio Server module.

Add = inserts items manually into the currently
loaded program log. See section 4.5.1.

Edit = edits items in the program log. See
section 4.5.2.

Delete = deletes items from the program log.
See section 4.5.3.

Settings = configures the Audio Server
module settings. See section 4.3.

Start = starts playback of the highlighted item
in the program log. See section 4.5.

Stop = stops all audio playback, including the
Main, Auxiliary, Time Shift, and Audition
decks. It does not stop playback of Hot Keys
playing on a Studio Client module. See section
4.5.

Run Macro = allows you to run macros.
Common uses are to run maintenance macros
or one-time on-the-fly macros. See Appendix
A - Macros.
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4.2.1.4 About Menu

Opens a window that shows the version and
ed JEis sl build date of the Audio Server module you are
running. This window also shows the amount
of memory and virtual memory being used,
and the amount of time that the Audio Server
module has been running. See Figure 4-1for
an example. To close the window, click OK.

=

TRboR

w0.0.0.723 -

Build D ate: '
Jul 2 2014 075541

b emony Usage:
14,292K / 14.392K, ‘

Wi | zage:
10,956k / 10,976k,

Running Time; 0 Hours, 26 Minutes, 37 Seconds

Figure 4-1. Example of About Information
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4.2.2 Audio Server Tool Bar

The Audio Server module tool bar appears below the menu bar.

> B =

Moving the screen pointer over a tool displays the tool's function as a tooltip. For example:

ALIE
W e

The following table describes the tools on the tool bar.

Tool Description

Starts playback of the highlighted item in the program log. See section 4.6.

Stops all audio playback, including the Main, Auxiliary, Time Shift, and Audition decks. It does not stop playback
of Hot Keys playing on a Studio Client module. See section 4.6.
s

Allows you to run macros. Common uses are to run maintenance macros or one-time on-the-fly macros. See
Appendix A - Macros.
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4.2.3 Playback Tab =
) ) S LogPosition
The Playback tab on the left side of the Audio Server 'E- Deck Count -
window shows the current status of all the audio & Man
playback devices. The following table describes the 12213 |
fields on the tab. _00:56.0
Ailwiliany
- = - ;-
Field Description %
Log Position Line item in the program log that is currently playing. If
playback is stopped, Log Position is the item that will 1840-05
play next.
Deck Count Total number of audio files playing on the Main Deck.
For example: Time Shift
« If two tracks are segueing, the Deck Count
increments from 1 to 2.
« When a voice track occurs, the Deck Count can
increment up to 3 to show the total number of
elements playing at the same time.
Main Shows the most recently started audio event in the »
Playback Deck Stack. There are three playback decks Audition
in the Playback Deck stack that cycle through the audio
events in the program log. If a segue starts or multiple
audio files are playing, the display shows the segueing
in audio file, not the audio file segueing out.
The top half of the display shows the name of the audio
file that is currently playing. The bottom half shows the
time until the end of the file is reached. A blue bar on
the left side shows the intro point and a red bar is the
segue point embedded into the playing audio file.
The example below looks slightly different than the example to the right. The example below shows a song that is
02:43.6 long (2 minutes and 43.6 seconds) and has just started, while the example to the right shows a track that
is 03:50.4 in length and has played % of the way through, with 56.0 seconds remaining in the track.
[1759-12 |
|| 02434
The solid green bar in the example to the right shows the position of playback within the audio file and moves from
left to right as the audio file playback progresses.
Auxiliary Shows audio events playing in the Auxiliary deck. The Auxiliary deck is used by events from trigger sets,
scheduled events sets, and some macros that play audio events.
Time Shift Display The Time Shift display shows audio events for the Time Shift function (see Chapter 8). The Time Shift event list
and Time Shift box shows stacked-up events.

event list box

Audition display and
Audition event list
box

Show items being auditioned, including audio elements played while an OpX One Studio Client is in Cue mode
(see Chapter 5).
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4.2.4 Record Tab

The Record tab shows the status of all four Audio Server
record decks. If enough audio recording devices (audio
cards) are installed on your Audio Server, you can record
four separate audio streams at the same time.

While actively recording each deck display shows the
name of the audio file being recorded on the top half,
while the bottom half shows the current record position.
For example, in the figure to the right, Record Deck One
is recording a half-hour program and is 04:28.7 into the
file. The green bar shows the progress of the audio file,
with a specified length.

When performing a record with no specified length, no
progress bar will appear; however, a countdown timer
shows the maximum length possible, along with the
available hard drive space.

I Status

Mods

Tiggers  [(CID) | NEEEN

Tigger Set |

Time Events m
Step Through m
Sched Events -

schedset |

Satelte Shows. D %
' Name | Details
4 i
0
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4.2.5 Status Tab

The Status tab shows all real- time modifiable settings that affect the way OpX One plays
audio and interacts with outboard hardware. Exercise care when changing these settings.
The following table describes the fields on the tab.

Field Description
Tog Mode AUTO
ode Adjusts how items in the program log progress. To .
adjust the mode click the On (| [XH] |) or Off (@) Triggers -
icon. Three modes are available: Trigger Set _
« In Auto mode, playback of the program log follows 3
the specified cue types of each event. The system Time Events
obeys the Start Items Using Remote Channel
check box setting (see Table 4-2 on page 66). ¢ Step Through ON
- o - =
« In Assist mode, similar to Auto mode, but items must
be started manually. The system obeys the Start i Sched Events -
Items Using Remote Channel check box setting Sched Set _
(see Table 4-2 on page 66). : :
« In Manual mode, cue types are ignored and each .
event in the program log is treated as a manual cue. ,.59!‘3.“!‘_,8 S_hP o > x
The system ignores the Start Items Using Remote | Name | Details |
Channel check box.

Triggers Show On when the Audio Server is monitoring
incoming triggers or Off when incoming triggers are
disregarded. To toggle the Triggers indicator between
On and Off, click the On (| I |) or Off (| L |) icon.

Trigger Set Shows the name of the currently loaded Trigger set. If ; |
no set is loaded, this field is blank. You cannot change 4 | e _’I
this field from this tab. To change it, run the
LOADTRIGGER®&acro from a scheduled event, 0
trigger set, program log, Hot Key, or by clicking the Run
Macro button in the Audio Server tool bar. For more
information, see Appendix A - Macros.

Time Events Shows whether the Audio Server is monitoring events in the program log with time-based cues. When Time
Events are set to On, scheduled events are played at the specified times. If Time Events is set to Off, all time-
based functions of the Audio Server are ignored. To toggle the Time Events indicator between On and Off, click
the On ( ) or Off (LI |) icon.

Step Through This is an automatic system function.

Sched Events

Shows whether the Audio Server is monitoring the currently selected scheduled events set. When set to On,
events in the scheduled events set run at the times specified in the set. When set to Off, all events in the set are

ignored. To toggle the Sched Events indicator between On and Off, click the On (| I |) or Off () icon.

Sched Set

Shows currently loaded scheduled events. This field usually is used to run macros at specific times without being
subject to what is happening in the program log. For more information, see section 4.3.11. You cannot change this
field from this tab. To change it, run the LOADSCHEDULEhcro from a scheduled event, trigger set,
program log, Hot Key, or by clicking the Run Macro button in the Audio Server tool bar. For more information, see
Appendix A - Macros.
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Satellite Shows

Lists all Satellite Shows scheduled in the current hour’s Clock (created using the OpX One Clock Builder described
in Chapter 8). Satellite Shows in this field can be started manually by highlighting the Satellite Show in the list and
clicking the Start button at the top of the Satellite Shows list.

4.2.6 Connections Tab

The Connections tab shows the IP addresses of:
- Workstations connected to the Audio Server.

. The File Server to which the Audio Server is
connected.

The following table describes the fields on the tab.

Client Connections
(192.168.1.92
1192.168.1.91
192.168.1.93

File Server
192.168.1.90 - FILE_SERVER

Field Description
)
Client Connections Shows the IP address of any workstation running =
the OpX One Studio Client. If more than one Audio §
Server is running on your network, Client =
Connections lists only the Studio Clients that are s
connected to this Audio Server ©
File Server Shows the IP address of the File Server to which
the Audio Server is connected.
4.2.7 Devices Tab WOPXACSSE? |
The Devices tab shows the status of incoming triggers.
The following table describes the fields on the tab. e
Field Description
Closure Grid Shows the status of each closure input. This
display is useful when setting up or troubleshooting - T
closures to verify that your wiring connections are Device |_Status
correct. Each indicator turns green when a closure WOPX-4C582 ON
is received. If more than one device is configured,
tabs at the top appear for each.
For troubleshooting, closure numbers in the grid
are clickable. When you click a number a pseudo
closure is generated and any function using that Closures
closure is triggered. 11:52:11 - 4 (Closure #4) - LIVE _A_I
8 11:55:13 - 2 (Closure #2) - LIVE
Device list Shows the name and status of all hardware I/0 2 |11:57:46 - 6 (Closure #6) - LIVE
devices configured on your Audio Server. You $ [11:57:47 - 4 (Closure #4) - LIVE
cannot change the statuses from this tab. To 2 [11:53:47 - 5 (Closure #5) - LIVE
change it, run the DEVICE macro by clicking the 11:53:47 - 8 (Closure #8) - LIVE
Run Macro button in the Audio Server tool bar. For 11:53:57 - 1 (Closure #1) - LIVE
more information, see Appendix A - Macros. 12:04:57 - 6 (Closure #6) - LIVE
12:05:57 - 2 (Closure #2) - LIVE
Closures History List Shows the history of all closure activity since the 12:05:57 - 7 (Closure #7) - LIVE
Audio Server was last started. The most recently 12:16:14 - 3 (Closure #3) -LIVE _|
activated closure appears at the bottom of the list. 12:18:12 - 4 (Closure #4) - LIVE
This list is useful when troubleshooting missing, 12:20:57 - 2 Closure #2) - LIVE
incorrectly timed, or repeated closures to see which 12:21:39 - 7 Closure #7) - LIVE
closures have or have not been activated. 12:23:31 - 3 (Closure #3) -LIVE |
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4.2.8 Program Log Display

The program log display lists the audio files and
other automation (macro) events to be executed
throughout the day (audio and macro events
can also be executed from the scheduled
events and Hot Keys). Think of the program log
as the piano-roll and the Audio Server as the
player-piano.

Program logs in OpX One are expected to be
for a 24-hour period. Usually, program logs are
imported from Traffic Log- and Music Log-
generating applications. However, they can also
be generated manually using the OpX One
Import — Merge application (see Chapter 9).

T T T T T T T T T e

97

100
10
102
103
104
105
106
107
108
109
10
m
12
1n3
14
15
16
nz
18
1ns
120
2
12
123
124
125

27

1%

|_Description

KOOL 107.3Ro
Andy Kim - Roc
Asetha Frankin
Bany'White -C
KOOL 107.3Ro.
BEMNJAMIN FR
CMLS

ONE HOME SO
KOOL 107.3Ro
Blue Swede -H
Bread - Make It
KOOL 107.3Ro
QUICK BOOKS
RELPAX - BAR
BENJAMIN FR
KOOL 107.3Ro
Chicago - If You
Dave Clark Frve
DwnaRoss & T
KOOL 1073 Ro
ST MARYS -B
SUDAFED - BA
BENJAMIN FR
KOOL 1073Ro
Doobes Brothers
Dusty Springhel
Isley Brothers -
KOOL 107.3Ro
SAFEWAY - SF
BENJAMIN FR
FEATHERPET
KOOL 107.3Ro

| | lackenn. R

Name
KooLi
118
174205
173703
Koou
5513
6473
6432
KOOouI
176716
12212
KOOLsng
8750
B76
5513
KOOLyng
1213
182505
10310
KOOLng
6263
8824
5513
KOOLyng
n2o
118
174116
KOOLyng
6435
5513
6242
KOOLing

178Q.12

Sched /Actudl | Lengh ||

0200:00
020010
020335
0207.04
021030
0210:40
021041
0211:39
021237
021247
021535
021843
021844
021313
022012
022013
022014
022404
0226:22
02300
023002
0231:.02
0231:A
0231:32
173 Reed
023457
023720
023353
0240.00
024059
0241:.00
024159

M A>MN

00:10
0324
0323
0326
0010
00m
0058
0058
0010
0248
0308
00m
0023
0053
0001
oom
0350
0218
0243
000
01:.00
0023
0001
00
0324
012
s
0001
0053
0om
0053
000

(e k]

WA = W = WA = WN = WA = W = WA = W = WA = W =W -

Lo

B
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4.3 Configuring the Audio Server Module

The Audio Server module comes with default configuration settings. Using the Settings
option on the Edit menu, you can change these settings to suit your requirements. For
convenience, the settings are organized in tabs in the Settings window.

> To configure the Audio Server module settings
1. On the Edit menu, click Settings .
The Settings dialog box appears, with the General tab displayed.

‘Setings ==
Trigger Sets l b imers ] [rata ] Scheduled Events Sets] Modez / Lngs] Elusyres / Relayz ]
General I Flayback ] AutaFill £ Time Scaling ] Record ] Categaories ] Folders | Deviee 1/0 |

Station

]

* Changing the station requires a restart of
the Audio Server to take effect.

Program Log Mame Template
jﬁémm‘“/odd"/oyy ﬂ W Clear Program Log Status

¥ Thig |2 The Prmany Audio Server Far This Station
Sarmple Rate aide
[44.100 Hz =] [5teren ]

Start In Mode

b anual -

JBUEILISRY

I Sync Spstem Time 'With The File Server

| 10 ; 10

H e Metwarl Intsiface Port Offset
[101.1.10- Op x| [0 [

J (] x Cancel ‘ H &pply ‘
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2. Complete the fields in the dialog box tabs.

General Settings — see
section 4.3.1

Playback settings — see
section 4.3.2

Auto fill and time scaling
settings — see section 4.3.3

Record settings — see
section 4.3.4

Category settings — see
section 4.3.5

Folder settings — see section
4.3.6

Device I/O settings — see
section 4.3.7

Trigger sets — see section
4.3.8

Mixer settings — see section
4.3.9

Data settings — see section
4.3.10

Scheduled event sets — see
section 4.3.11

Modes and logs — see
section 4.3.12

Closures and relays — see
section 0

3. When you finish, click Apply and OK.
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4.3.1 General Configuration Settings

The General tab contains basic settings for setting up your Audio Server.

Settings ===

Trigger Sets ] tisers ] [rata ] Scheduled Events Sets] Modes / Logs] Closures / F!ela_l,ls]
General I Playback. ] Auta Fill £ Time Scaling ] Record ] Categories ] Foldersi Device 140 |

Statian

5

* Changing the station requires a restart of
the Audio Server to take effect.

Program Log Mame Template
]medeZyy ﬂ W Clear Program Log Status

v Thiz Iz The Prmary &udic Server For This Station

Sample Rate e

{44100 Hz =l [teren |
Start In Mode

t anual hd

[AUILIARY

I Syhc Systern Time With The File Server

| 1o i 10
Port Dffset

11I'||'I'ID|7,'} i W =

o Ok | X Cancel ‘ [= E J

Figure 4-2. General Tab
Table 4-1. Fields in the General Tab

Field

Description

Default

Station

Allows you to select the default station. All Stations configured on your OpX
One File Server will be listed.

Varies by setup
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Field

Description

Default

Program Log Name Template

Determines the file name that OpX One loads when the log automatically
loads at midnight. Your entry can include standard characters and meta-
variables, which are used to add a dynamic element to program log loading.
Rather than limiting the log to a static name, specific sequences of
characters can be used to represent dynamically changing information, such
as the date, day, year, and day of the week.

The following meta-variables can be entered into this field:

* ‘hyy
Year as a 2-digit number.
Examples: For 2009, replace %yy with “09”. For 2016, replace %yy with
“6"

« oyyyy
Year as a 4-digit number.

Example: For 2016, replace %yyyy with “2016”.

e %m
Month as a 1- or 2-digit number without a leading zero.
Examples: For June, replace %m with “6”. For November, replace %m
with “11”.
* %mm
Month as a 2-digit number with a leading zero.
Examples: For July, replace %mm with “07”. For October, replace %mm
with “10”.
e %mmm
Month as a 3-letter abbreviation.
Example: For November, replace %mmm with “Nov”.

e %mmmm
Month as a full name.
Example: For August, replace %mmmm with “August’”.

* %d
Day as a 1- or2-digit number without a leading zero.
Examples: For the 5, replace %d with “5.” For the 12, replace %d with
“12".

* %dd
Day as a 2-digit number with a leading zero
Examples: For the 7, replace %d with “07”. For the 24, replace %d with
94

> %ddd

Day as a 3-letter abbreviation.
Example: For Tuesday, replace %ddd with “Tue”.

* %dddd
Day as a full name.
Example: For Friday, replace %dddd with “Friday”.

If you generate new logs every day and your log-generation software
creates logs with titles such as:

 “020108t.log", “102607t.log", or “120708t.log", enter “%mm%dd%yyt.log”
into this field.

« Monday.txt", “Wednesday.txt", or “Saturday.txt”, enter “%dddd” into this
field.

» “Jan 2, 2008.log", “Nov 30, 2009.log”, or “Jul 4, 2008", enter “Y%ommm %d,
%yyyy” into this field.

Do not include extensions. The OpX One import process adds a .xml
extension automatically. For more information about importing and merging
logs, see Chapter 9.

%mm%dd%%yy
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Field

Description

Default

Clear Program Log Status

Automatically clears as- played information when a program log is loaded.
This is useful for re-using logs or to ensure that the information shown when
airing a log is not from a previous playback.

Checked

This Is The Primary Audio Server
For This Station

Check this check box to have your station’s main (“Primary”) Audio Server
write all hardware settings to the server, so the Clock Builder module and
any backup Audio Servers that are running are aware of the hardware
settings from your station’s Primary Audio Server, such as names you
assigned to audio switcher channels, triggers and relays.

On backup Audio Servers, uncheck this check box to prevent inadvertent
changes you make on the backup server from overwriting critical settings on
your on-air Primary Audio Server.

Checked

Sample Rate

Selects the output sample rate (very significant when used with a digital
audio card) and the rate of the audio files that OpX One will play. OpX One
plays audio files that have a singular rate, so be sure all your audio files
have the same sample rate.

44,100 MHz

Mode

Output stereo/mono mode. A mix of stereo and mono audio files is
acceptable to play with OpX One, but they must be the same sample rate. If
mono is selected, all stereo and mono audio files played will be summed
and output to both left and right channels. If Stereo is selected, stereo audio
files remain stereo and mono files are summed out both left and right
channels.

Stereo

Start in Mode

Determines the automation mode in which the application starts. Always use
Auto.

Manual

Banner

Not used with a standard Audio Server. This field is reserved for naming the
Auxiliary Audio Server. See Chapter 5.

AUXILIARY

Sync System Time With The File
Server

Do not use (for legacy systems only).

Unchecked

File Server Address

IP address of the File Server.

OpX One Network Interface

OpX One can communicate with Axia/Wheatstone hardware on a separate
NIC. If OpX One detects an Axia or Wheatstone audio driver installed, select
the NIC used for your Axia or Wheatstone audio network; otherwise, this
field is unavailable.

10.1.1.10 - OpX
One

Port Offset

The communication port for clients. This value must be unique for each
Audio Server.

Axia/Wheatstone Network
Interface for GPIO Devices

If OpX One detects an Axia or Wheatstone audio driver installed, enter the
local IP address of the NIC that will use the Axia or Wheatstone audio
network; otherwise, this field is unavailable.
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4.3.2 Playback Configuration Settings

The Playback tab contains configuration settings for audio playback devices are designated
for each playback deck in OpX One.
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Settings

Channel / Deck #1 F'Ia_l,ll:uau:k Device

Channel / Deck #2 Playback Device

Trlgger Sets | b imers ] Diata | Scheduled Events Sets | Modez / Logs ] Clozures / Relays ]
General  Plavback | Aut Fill/ Time Scaling | Record | Categories | Folders | Deviee 140 |

Detault Segue Time

250 1‘2 ] illizecondsz

W Fade In

| 1- 4516520 /02 WDM Dut [fudioS |

Channel / Deck #3 Playback Device
|1 - ASIEE20 /03 WD Out [Audial ﬂ

Auiliar Deck #4 Plavback Dewice
1 - 4516520 /04 WM Out [budios |
v Use Mest Awvailable Deviee |F Busy

Time Shift Deck #5 Plavback Device
1 - 4516520 /04 WOM Out [budios |

Auto Mode Through Breaks
[ InManual Mode

[ IrAssist Mode

100 |}_{] Millizeconds

I Masimum Fade Out
3000 *Z] b illiz

Befault Ducking Level
90| *;| Fercent

[ Fade Out Cut Before Yoicetrack
Wwhen Cut After Voicetrack Starts

Fade & Go Fade Cut

3000 *Z] Millizeconds

I Check Dates &nd Times
[ Start ltems Uzing Femate Channel

[T Reassign Device On Make Mext

=

0K

X Cancel ‘

B 2pply

Figure 4-3. Playback Tab
Table 4-2. Fields in the Playback Tab

Field Description Default
Channel/Deck #1 Playback Device | These fields determine which audio devices are used for each of the three 1 - AS16520/01
Channel/Deck #2 Playback Device | main playback decks. The main playback decks are rotated as playback WDM Out (AudioS)

Channel/Deck #3 Playback Device

occurs. The deck with which each item will play appears in the far-right
column of the Program Log Display in the Audio Server.

Because OpX One uses a software-based audio mixing engine, all three
Channel Playback fields can be set to the same device or, for more control,
to their own individual device. We recommend you set each deck to its own
device. Typically, deck 1 would be 1WDML, deck 2 would be 2WDML, and
so on. Setting each Channel Playback Device field to a different audio
device is useful for manual control over fades when each device is
connected to a separate channel strip on your console.

Note: Always use WDM drivers. Never select Wave, even if Wave drivers
are installed.

1- AS16520/02
WDM Out (AudioS)

1 - AS16520/03
WDM Out (AudioS)
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Field Description Default
Auxiliary Deck #4 Playback Device | Used to playback triggered events. You can select an independent device 1-AS16520/04
for flexibility or the same device as your main decks playback device. WDM Out (AudioS)
Because OpX One has internal mixing, multiple decks can use the same
playback device.
Use Next Available Device If Busy | Do not use for legacy systems. Checked

Time Shift Deck #5 Playback Used to play back satellite shows recorded using the Clock Builder Record 1 - AS16520/04
Device function. If you use Time Shift functionality, select a unique device for this WDM Out (AudioS)
deck and configure a Mixer that controls this deck, so the Satellite Show
settings can mute and unmute this channel independently of other
playback decks for spot-replacement functionality.
Auto Mode Through Breaks These options allow the Audio Server to enter Auto mode automatically Unchecked

when breaks are encountered in Manual or Assist mode. This means that
when a break starts, all the audio files segue automatically and continue to
play through as if in Auto mode.

Default Segue Time

OpX One segues between audio cuts at the points you set in each audio
file. To segue between cuts, even if the cuts do not have segue points set,
set this option to the length a default segue should take to overlap the cuts.
Even with this feature enabled, the set cue points are used if they are set
in the particular cuts. This setting applies only when one or both cuts have
no segue points set (see Chapter 10).

250 milliseconds

Fade In

Determines the fade-in time applied to the starting audio element when a
segue occurs.

Checked
100 milliseconds

Maximum Fade Out

Maximum fade out time of the audio element that is ending during a segue.

«» Unchecked = time of the full intro/segue (length of either the ending
element’s segue time or the starting element’s intro time, whichever is
shorter) is used as the fade out length.

« Checked = fade out time is either the full intro/segue time determined
on-the-fly or the length set here, whichever is shorter.

Unchecked
300 milliseconds

Default Ducking Level Ducking attenuates audio elements when a voicetrack is playing. This 90 percent
option ducks songs or other audio element types down under a voice track.
You can set the ducking level on a per-voicetrack basis, but this setting
determines the default level on new voicetracks.

Fade Out Cut Before Voicetrack Unchecked

When Cut After Voicetrack Starts

Fades down the volume of the cut before a voicetrack. Use only with cuts
produced in a manner that requires this feature.

3000 milliseconds

Fade & Go Fade Out

Length of the cut fade when using the "Fade-and-Go" feature on the studio
client.

3000 milliseconds

Check Dates And Times

To have OpX One check that all your audio elements are valid for the
dates set in the audio files, enable this option (see Chapter 10). If OpX
One finds an audio file that is outside its date range, playback of that audio
event causes an error and the event is skipped.

Unchecked

Start Items Using Remote Channel

When checked, the next playback deck changes to whichever pot the Start
Next button is on. If Deck 2 is next and you push start on remote start 1, for
example, the next cut plays out of deck 1.

Unchecked

Reassign Device on Make Next

When using the Make Next feature, this option always changes the device
on that item to deck 1.

Unchecked
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4.3.3 Auto Fill and Time Scaling Configuration Sett  ings

The Auto Fill / Time Scaling

scaling.

Settings

Trigger Setz | b iwers ] Data | Scheduled Events Sets | Modes / Lu:ugs] Clogumes / Flelays]
General | Playback  Auta Fill / Time Scaling ] Record | Categories | Folders | Device 140 |

I Enable ot Fill % Time Scaling

gt

| ‘/ (]S | x Cancel I = B I

Figure 4-4. Auto Fill / Time Scaling Tab

Table 4-3. Fields in the Auto Fill / Time Scaling T ab

tab contains configuration settings for auto-fill and time

Field Description Default

Enable Auto Fill and Time Scaling When checked, Auto Fill fills mandatory breaks automatically (created with Unchecked
OpX One’s Clock Builder module) that do not have enough content to
complete their set length. The Auto Fill function uses audio files you place
in your station’s Fill folder. Checking this check box enables the remaining
options in this tab.

Fill Breaks Randomly When checked, audio events are chosen at random from your Fill folder Disabled
until your break is filled.

Fill Breaks Largest To Smallest When checked, the longest audio file from your Fill folder that will fit your Disabled

remaining break period is added to your break. If there is time in your
break, that time continues to be filled with the largest file that fits that time
until your break is filled completely.
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Field Description Default

Native Time Scaling (Real-Time) Select Native Real Time. Other selections are provided for legacy or Disabled
special-case use.

Native Time Scaling (Background) | Select Native Real Time. Other selections are provided for legacy or Disabled
special-case use.

Maximum Time Scaling Determines the maximum time scaling percentage possible. For best Disabled

results, use a value from 5 to 15%,
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4.3.4 Record Configuration Settings

The Record tab has drop-down lists for selecting the record device for each record deck.
You can set record decks to their own specific device for flexibility, allowing you to record
four sources simultaneously. If the audio hardware installed on your system does not have
four record devices available, decks can share the same record device. When two or more
decks share the same record device, only one can access it at a time. The first deck to start
recording with a device locks out other decks that try to use that same device until the first
deck finishes recording.

Settings
Trigger Setz | Mizers | [rata | Scheduled Everits Sets | Modes / LDgs] Clozures / Flela_l,ls]
General ] Playback: ] Auto Fill # Time Scaling  Record I Categonies ] Folders | Device /0 |

First Record Deck Device

S

Second Record Deck Device

|1 - 4518520 /02'WDM In [budioSe v |

Third Record Deck Device
|1 -ASIER20 /07 WDM In [AudinSe ﬂ

Forth Record Deck Device
|1 - 4516520 /02 WDM In [Audinsc |

* Changes to the record device
settings requires restarting the
Audio Server to take effect.

| J Ok | x Cancel ‘ H ool ‘

Figure 4-5. Record Tab
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4.3.5 Category Configuration Settings

OpX One uses categories to organize your audio and add another dimension to the types of
searches you can do when adding audio files to your logs. You add, delete, or edit
categories using the Categories tab. You set an audio cut’s category using the Info Edit
module (see Chapter 10).

If you define a category field to import, you must specify it here.

Settings =
Trigger Setz I b imers ] Diata ] Scheduled Events Sets ] Modes / Logs ] Clozures / Relays ]
General ] Plavback ] Auto Fil ¢ Time Scaling | Record  Categories ] Falders | Device 1/0 |

b New ‘ S Edit ‘ 3 Del ]
Category | Type |
AUDD— AUDID _—Audo fl or car
COMMEMT COMMEMNT Program log comment
MACRO MACRO hacro command
TEXT TEXT Test for display
YTRALCK WTRALCK Woice track audia file
0K X Cancel ‘ H Lrpply |

Figure 4-6. Categories Tab

The following sections describe how to add, edit, or delete categories.

Page 71 of 390



Audio Server Module

4.3.5.1 Adding Categories

> To add a category to your Audio Server

1. Inthe Categories tab, click the New button o

The Category dialog box appears.

Categon

Type

|AUDID |

Dezcription

X Cancel |

Figure 4-7. Category Dialog Box

2. Complete the fields in the dialog box (see Table 4-4).

3. Click OK.
Table 4-4. Fields in the Category Dialog Box
Field Description Default
Category Enter a short name. —
Type Select the content type. Generally, Audio should be selected. AUDIO
Description Enter a description of the category. —
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4.3.5.2 Editing Categories

There might be times when you need to edit a category. For example, you might want to
change the category name, type, or description.

¢ Note: You cannot edit default categories.

> To edit a category
1. Inthe Categories tab, click the category you want to edit.
2. Click the Edit button _fEdt
The Category dialog box appears.
3. Edit the fields you want to change (see Table 4-4).
4. Click OK.

4.3.5.3 Deleting Categories

If you no longer need a category, you can delete it. You can delete any category, except
default categories.

« Note: A precautionary message does not appear before you delete a category.
Therefore, be sure you do not need a category before you delete it. You cannot
undo a category after it has been deleted.

> To delete a category
1. Inthe Categories tab, click the category you want to delete.

2. Click the Del button = X Del |
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4.3.6 Folder Configuration Settings

d Note: OpX One uses the folder structure settings configured in the File Server
module. This tab is disabled on OpX One systems, but remains for user
interface consistency with the OpX automation system.

—
ioos ]

Trigger Sets I Mixers | Data | Scheduled Events Selsl Modes / Logs | Closures / Relays
General | Playback | AutoFill / Time Scaling | Record | Categories  Folders I Device 1/0 |

Local Audio Folder

ID:\Audio\WBSI 3
Folder | Type |_Description -
D:\AudioWWRSNS pots SPOTS Spots
DA\Audio\wBSI\News AUDIO News
DAAudio\WwBSI\Records RECORDS Records
D:\Audio\WBSI\Music MUSIC Music
D: \Audio\WBSI\Imaging AUDIO Imaging
D:\Audio \WBSINFill FILL Fill Material A
D: \Audio\WBSI\Liners AUDIO Liners E
D:\Audio\WBSI\ingles AUDIO Jingles
D:\Audio\WBSI\Promos AUDIO Promos
D: \Audio\WBSI\Carts CARTS Carts
D: \Audio\WBSI\RunLogs RUNLOGS Run Logs
D: ‘VAudio\WBSI\Logsh\audio Ser... LOGS Program Logs
D: \Audio\WBSI\Woicetracks VOICETRACKS Voicetracks =
D: \Audio\WwWBSI\Config CONFIG Configuration .
r‘\' ‘\Audin \WRESIAT emnnranm TEFMPNRARY Tﬁmnanu -

1

* Adding folders to the File Server requires

a restart of the Audio Server to take effect.
Click OK below to write the settings locally,
then restart FileSync as well.

0K I X Cancel | = |

Figure 4-8. Folders Tab
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4.3.7 Device Configuration I/O Settings

Any device that sends closures to outboard devices, receives closures from other devices,
or switches audio is considered an 1/O device. The Device I/O tab allows you to configure
these devices.

=

.S'Ettings
Trigger Setz | hdimers ] [rata | Scheduled Events Setz | Modes ¢ Logz ] Closures / Relays ]
Geteral ] Flayback ] Ayt Fill £ Tirme Scaling ] Record ] Cateqgories ] Folders Device /0

J'E' 5 | % (=l I
Narie Device Port. Description Defaul |

Lﬂ_ Serial Device lﬂ Sernial Server ‘ @ IP Connection J
#R>ci fia GPIO Node ‘ %<0 fyia Diiver GPIO ‘ & Audia Server ‘
L wheatstone Console b wheatstorie Blads J B MCC PDISO8 ]

..-".-"5_‘: 545 Congole B3 Advantech |

0K X Cancel ‘ H Apply ‘
Figure 4-9. Device I/O Tab
('"" Note: As OpX One is an all-in-one version of OpX, the Serial Server device is

not supported on OpX One installations. This button is disabled on OpX One
systems, but remains for user interface consistency with the OpX automation
system.
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4.3.7.1 Adding a Serial Device

Serial devices supported by OpX One are the Broadcast Tools SS 8.2, ACS 8.2, SS 16.4,
GPI-32, and SRC 8-llI.

» To add a serial device

1. Be sure the device you are configuring for OpX One is connected and configured
properly.
2. Inthe Device I/O tab, click the Serial Device button = ##Serial Device I

The Serial Device dialog box appears.

(el Do =
Mame Description
I l
Port Device

:

| =

Baud Fate |~Broadcast Tools

. Specify the actual Linit (D
Unit 1D nat ALUTO when Lging

Data Bits ALTO vi miltiple devices on the

zame pork

1 [H

.

¥ lgnore Subsequent Closures For

M -
one ]25[# E Milliseconds

Stop Bits

i

.

¥ Append Temination Characters

Flow Control 1CH;LF LJ
MNone [ Connect At Start Up

i

x Cancel ‘

Figure 4-10. Serial Device Dialog Box
3. Complete the fields in the dialog box (see Table 4-5).
4. Click OK.

Page 76 of 390



Audio Server Module

Table 4-5. Fields in the Serial Device Dialog Box

Field

Description

Default

Name

Enter a short identification name for your serial device. This name should
allow you to differentiate this device from other devices.

Description

Enter a verbose description for your serial device.

Port

Enter the port number based on the requirements for your serial device.
Refer to the documentation for your serial device.

Baud Rate

Set the baud rate, in bits per second (bps), based on the requirements for
your serial device. Refer to the documentation for your serial device.

9600

Data Bits

Set the number of data bits based on the requirements for your serial
device. Refer to the documentation for your serial device.

Parity

Set the parity setting based on the requirements for your serial device.

None

Stop Bits

Set the number of stop bits based on the requirements for your serial
device. Refer to the documentation for your serial device.

Flow Control

Set the flow control based on the requirements for your serial device. Refer
to the documentation for your serial device.

None

Device

Available options are for Raw Serial Device (used for serial devices not
explicitly supported by OpX One), Broadcast Tools SS 8.2, ACS 8.2, SS
16.4, GPI-32, SRC 8-Ill, 8&2 D/ev, SRC-16, and GPI-16.

For Broadcast Tools devices:

« Select the ID address that your device is set to from the Unit ID# drop-
down list. The default device ID for Broadcast Tools switchers purchased
through BSI is “1”.

« To avoid invalid or “chattering” relays, set a period of time for OpX One to
ignore subsequent closures after an initial closure is received enable by
enabling the Ignore Subsequent Closures For... option and selecting a
time-out time (in milliseconds).

« To aid identification of what is connected to your Broadcast Tools device,
click the Closure Descriptions and/or Switcher Descriptions buttons.

Figure 4-11 shows an example Closure Descriptions list. As this example
shows, it is easier to remember the friendly closure name “Rosh Limberg
Commercial Break Start” after several months than it is to remember
“Closure #2”.

Figure 4-12 and Figure 4-13 show input and output description lists which
are editable by clicking on the Switcher Descriptions button.

Append Termination Characters

Select the terminating characters that will be appended to the end of each
command sent to the serial device. The default termination characters are a
carriage return and line feed.

Checked
CRILF

Connect At Start Up

To have your Audio Server connect to this serial device automatically at
startup, check this check box.

Unchecked
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Broadcast Tools 55 16.4 i X

SWITCHERZ
Switcher 2 - Broadoast Tools 55 16.4

Closure Pin [Description
1 (o] Rosh Limberg Start bi=i
2 C:3 Rosh Limberg Commercial Break Start
3 C:4 Fiosh Limberg Station D
4 E-B Closure #4
b C-7 Closure #5
B C:3 Closure #6
7 C-10°  [Dr. Laune Commercial Break Start
] C-12  |Dr. Laurie Station D
g C-13  |Closwe #3
10 C-15  |Closue #10
il C-16  |Joans Music TOH ID/Start e
12 C-18  |Joans Music Commercial Break Start
13 -1 Joans Music Magic Call
14 D-3 Closure #14
15 Li-4 Closure #15
18 D6 |Bil DRealy Starf ~|

o Ok I X Cancel |

Figure 4-11. Closure Description List for a Broadca st Tools Switcher/Trigger Device

Broadcast Tools S5 16.4 | x|

Sw/TEHER2
Switchier 2 - Broadoast Tools 55 16.4

it | Outputs |

Input | Desciiption

1 |4BG Mews Feed =
StarGuilde 11l #1
StarGuilde 1l #2
Uity 4000 #1
Uinity 4000 #2
StarGuilde 1| #1
StarGuilde || #2
Direct Console Dutput LI

' OK I X Cancel |

Figure 4-12. Input Description List for a Broadcast Tools Switcher Device

Broadcast Tools S5 16.4 | |

SWwITCHER2
Switcher 2 - Broadeast Tools 55 16.4°

o ~i| mf a1 =] ) e

Inputs Outpuis |

[ Dutput [ Description

1 Op= Pase-Through [Satelite-ta-4ir)
2 |0ps Record 1
3 |0p<PRecod 2
4 [0px Pecord 2

o Ok I X Cancel |

Figure 4-13. Output Description List for a Broadcas t Tools Switcher Device
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4.3.7.2 Adding an IP Connection

You can add a TCP or UDP IP connection to the Audio Server.

» To add an IP connection

1. In the Device 1/O tab, click the IP Connection button & IP Connection |

The IP Connection dialog box appears.

P

IP Connectian

I ame Dezcription

11001110 - Op¢ =]

Protocol 7 Type
& TCF * Clignt

" UDP 7 Server

[~ Connect/ Send / Disconnect

Address Pt
| o . 0o . 0 . 0 1000

|CRALF B

[ Connect At Start Up

[ Commands ‘

W &ppend Temination Characters [ Must Be CRALF To Send T o Another dudio Server |

K Cancel |

=

Figure 4-14. IP Connection Dialog Box
2. Complete the fields in the dialog box (see Table 4-6).

3. Click OK.
Table 4-6. Fields in the IP Connection Dialog Box

Field Description

Default

Name Enter a short identification name for your IP connection. This name should
allow you to differentiate this IP connection from other IP connections.

Description Enter a verbose description for your IP connection.
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Field Description Default

Network Interface Select the IP address of the OpX One network interface for this IP 10.1.1.20 - OpX
connection. One

Protocol Select the protocol used with this IP connection: TCP or UDP TCP

Type Select whether the device at the other end of the IP connection is a client or Client
server of the Audio Server.

Connect/Send/Disconnect To send requests to and disconnect from the IP connection, check this Unchecked
check box.

Address Enter the IP address of the device at the other end of the IP connection. 0.0.0.0

Port Enter the port number based on the requirements for your device. Refer to 1000
the documentation for your device.

Append Termination Characters Select the terminating characters that will be appended to the end of each Checked
command sent to the device at the other end of the IP connection. The CRILF
default termination characters are a carriage return and line feed.

Connect At Start Up To have your Audio Server connect to this IP connection automatically at Unchecked
startup, check this check box.

Commands Click this button to open the Watch Text dialog box (see Figure 4-15). Use —

this dialog box to add, edit, or delete watch text.

4.3.7.2.1 Adding Watch Text

This function sends the system a command via TCP/UDP and ties that command to a
macro. When the Audio Server sees that watch string, it executes the defined macro.

> To add watch text

1. Inthe IP Connection dialog box, click the Commands button

%4 Commands |

The Watch Text dialog box appears.
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‘Watch Text

twiatch Text ! Command [Macra) | Logic:

: g

X Cancel ‘

Figure 4-15. Watch Text Dialog Box

2. Click the New button

The Watch Text Item dialog box appears.

‘Watch Text Item
Wiatch Test
b acro Command

Logic

X Cancel ‘

Figure 4-16. Watch Text Item Dialog Box

3. Complete the fields in the dialog box (see Table 4-7).

4. Click OK.
Table 4-7. Fields in the Watch Text Time Dialog Box
Field Description Default
Watch Text Enter a short identification name for your device. This name should allow —

you to differentiate this device from other devices.
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Field Description Default
Macro Command Enter the macro command. For more information, see Appendix A - Macros. —
Logic Select whether the command is to be executed when the watch text is Execute Command
present or missing. If Watch Text Is
Present

4.3.7.2.2 Editing Watch Text

There might be times when you need to edit watch text. For example, you may want to
change the macro associated with the watch text.

> To edit watch text
4 Commands I

1. Inthe IP Connection dialog box, click the Commands button
The Watch Text dialog box appears (see Figure 4-15).

2. Click the watch text you want to edit, and then click the Ediit button ﬂ]
The Watch Text Item dialog box appears (see Figure 4-16).

w

Edit the fields you want to change (see Table 4-7).
4. Click OK.

4.3.7.2.3 Deleting Watch Text

If you no longer need watch text, you can delete it.

«" Note: A precautionary message does not appear before you delete watch text.
Therefore, be sure you do not need watch text before you delete it. You cannot

undo watch text after it has been deleted.

» To delete watch text
4 Commands I

1. Inthe IP Connection dialog box, click the Commands button
The Watch Text dialog box appears (see Figure 4-15).

2. Click the watch text you want to delete.

3. Click the Del button 3¢ Del |
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4.3.7.3 Adding an Axia GPIO Node

> To add an Axia I/0O GPIO node to your OpX One Audio  Server

1. Inthe Device I/O tab, click the AXIA GPIO Node button stk /id GFIO Nodo

The Axia GPIO dialog box appears.

Axia GPIO =]
I ame Dezcription
Awia GPIO Address
0 o B o @ o= B
[ Connect &b Start Up

9 Closure Descriptions

x Cancel I

Figure 4-17. Axia GPIO Dialog Box
2. Complete the fields in the dialog box (see Table 4-8).

3. Click OK.
Table 4-8. Fields in the Axia GPIO Dialog Box
Field Description Default
Name Enter a short identification name for your Axia GPIO node. This name —
should allow you to differentiate this device from other devices.
Description Enter a verbose description for your Axia GPIO node. —
Axia GPIO Address Enter the IP address of your Axia I/O device. 0.0.0.0
Connect At Start Up To have your Audio Server connect to this Axia GPIO node automatically at Unchecked
startup, check this check box.
Closure Descriptions To make identification of what is connected to your Axia I/O device’s —
closures, click this button and enter friendly names for each connected
closure. Figure 4-18 shows an example of a closure list.
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Axia GPIO - 10.1.1.90 i x|
GRIOZ
fuia GPID Mode 3

Clogtyre Fir escrphion
1 Part 1 Rosh Limberg Start -]
0 Part 1 Rosh Limberg Commercial Break Start
) Part 1 Fiosh Limberg Station 1D
4 Part 1 Closure #4
g Part 1 Closure #5
5 Part2  |Closure #E
7 Part 2 D Launie Commercial Break Start -
8 Port 2 |Dr. Laurie Station |0
a Port2  [Closure #9
10 Part2  |Closue #10
11 Fat3  Lloans Music TOH I0/Start
12 Port3  |Joans Music Commercial Break Start
13 Port 3 Lloans Music Magic Call
14 Part3  |Closure #14
15 Part 3 Clazure #15
16 Potd  |Bil O'Really Start ;I

" OK I X Cancel |

Figure 4-18. Example of a Closure List
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4.3.7.4 Adding an Axia Driver GPIO

> To add an Axia I/O Driver GPIO to your OpX One Audi o Server

1. Inthe Device /O tab, click the AXIA Driver GPIO button —==

@R :><ra Axia Driver GPIO I

The Axia GPIO dialog box appears.

Axia GPIO
Mame Diescription
Axia GPI0 Addrezs
| 127 0 0 1

[ Connectat Start Up

X Cancel I

-3

Figure 4-19. Axia GPIO Dialog Box

2. Complete the fields in the dialog box (see Table 4-9).

3. Click OK.
Table 4-9. Fields in the Axia GPIO Dialog Box
Field Description Default
Name Enter a short identification name for your Axia Driver GPIO device. This —
name should allow you to differentiate this device from other devices.
Description Enter a verbose description for your Axia driver GPIO device. —
Axia GPIO Address Enter the IP address of your Axia driver GPIO device. 0.0.0.0
Connect At Start Up To have your Audio Server connect to this Axia driver GPIO device Unchecked

automatically at startup, check this check box.
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4.3.7.5 Adding an Audio Server

> To add an audio server to your OpX One Audio Server 'er

1. Inthe Device I/O tab, click the Audio Server button

&) Audio Server

The Audio Server dialog box appears.

Audio Server

I ame Dezcription

Station

Addrezs
| o . 0 . 0 . 0

[ Connect &t Start Up

x Cancel ‘

Figure 4-20. Audio Server Dialog Box

2. Complete the fields in the dialog box (see Table 4-10).

3. Click OK.
Table 4-10. Fields in the Audio Server Dialog Box
Field Description Default

Name Enter a short identification name for your audio server. This name should —

allow you to differentiate this device from other devices.
Description Enter a verbose description for your audio server. —
Station Select a station that will be used with this audio server. Only stations with

currently running Serial Device Servers are shown in the drop-down list.
Address Enter the IP address of the audio server. 0.0.0.0
Connect At Start Up To have your Audio Server connect to this audio server automatically at Unchecked

startup, check this check box.
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4.3.7.6 Adding a Wheatstone Console

> To add a Wheatstone console to your OpX One Audio S  erver

1. In the Device I/O tab, click the Wheatstone Console button & Wheatstone Console l
The Wheatstone Console dialog box appears.
ﬁWhéa'tsi‘.uné Consale’ --
I ame Dezcription
Conzale Address
0 0 i ] : 0

Deck #1 = Conzole Channel: |1 E

Deck #2 = Cansale Channel: |2 Y& Eﬁﬁ‘“@ Milisecands
{
Dieck #3 = Conzale Channek |3 z

[ Connect &k Start Up

¥ I|ghore Subsequent Deck Starts

x Cancel ‘

Figure 4-21. Wheatstone Console Dialog Box

2. Complete the fields in the dialog box (see Table 4-11).

3. Click OK.
Table 4-11. Fields in the Wheatstone Console Dialog  Box
Field Description Default
Name Enter a short identification name for your Wheatstone console. This name —
should allow you to differentiate this device from other devices.
Description Enter a verbose description for your Wheatstone console. —
Console Address Enter the IP address of your Wheatstone console. 0.0.0.0
Deck #1 — Console Channel Select a remote device.
Deck #2 — Console Channel
Deck #3 — Console Channel
To have your Audio Server connect to this Wheatstone console Unchecked

Ignore Subsequent Deck Starts

automatically at startup, check this check box and either accept the default
value or change it.

250 milliseconds
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Field

Description

Default

Connect At Start Up

automatically at startup, check this check box.

To have your Audio Server connect to this Wheatstone console

Unchecked

Closure Descriptions

closure.

To make identification of what is connected to your Wheatstone console’s
closures, click this button and enter friendly names for each connected

4.3.7.7 Adding a Wheatstone Blade

> To add a Wheatstone blade to your OpX One Audio Ser  ver

1. Inthe Device I/O tab, click the Wheatstone Blade button

The Wheatstone Blade dialog box appears.

= | Wheatstone Blade

W |grnore Subzequent Deck Starts

250 *E;.} g
[ Connect At Start Up

|44 Closure Diescriptions |

4 Switcher Descriptions |

\Wheatstone Blade
Mame [rezcription

Blade Address

[/ i s B o W = @

x Cancel |

Figure 4-22. Wheatstone Blade Dialog Box

2. Complete the fields in the dialog box (see Table 4-12).

3. Click OK.
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Table 4-12. Fields in the Wheatstone Blade Dialog B ox

Field Description Default
Name Enter a short identification name for your Wheatstone blade. This name —
should allow you to differentiate this device from other devices.
Description Enter a verbose description for your Wheatstone blade. —
Blade Address Enter the IP address of your Wheatstone blade. 0.0.0.0
Ignore Subsequent Deck Starts To have your Audio Server connect to this Wheatstone blade automatically Unchecked

at startup, check this check box and either accept the default value or
change it.

250 milliseconds

Connect At Start Up

To have your Audio Server connect to this Wheatstone blade automatically
at startup, check this check box and either accept the default value or
change it.

Unchecked
250 milliseconds

Closure Descriptions

To make identification of what is connected to your Wheatstone blade’s
closures, click this button and enter friendly names for each connected
closure.

Switcher Descriptions

To make identification of the inputs and outputs connected to your switcher,
click this button and enter friendly names for each input and output.

4.3.7.8 Adding an MCC PDISO8

> To add an MCC PDISOS8 to your OpX One Audio Server

1. Install and configure the device (refer to the documentation for your device).

2. In the Device /O tab, click the MCC PDIS08 button

3 MCC PDIS0S |

The Measurement Computing Device dialog box appears.
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e

Name

Measurement Computing Device

Description

Device

250

I™ lgnore Subsequent Closures For
Milliseconds

[~ Connect At Start Up

4 Closure Descriptions

X Cancel l

Figure 4-23. Measurement Computing Device Dialog Bo  x

3. Complete the fields in the dialog box (see Table 4-13).

4. Click OK.

Table 4-13. Fields in the Measurement Computing Dev  ice Dialog Box

Field Description Default
Name Enter a short identification name for your device. This name should allow —

you to differentiate this device from other devices.

Description Enter a verbose description for your serial server device. —
Device Select a remote device. —
Ignore Subsequent Closures For | To minimize accidental double-clicks, check this check box to set a period of Unchecked

time that each console button will be ignored after it is clicked.

250 milliseconds

Connect At Start Up

To have your Audio Server connect to this device automatically at startup,
check this check box.

Unchecked

Closure Descriptions

To make identification of what is connected to your Wheatstone blade’s
closures, click this button and enter friendly names for each connected
closure.

4.3.7.9 Adding a SAS Console

> To add a SAS console to your OpX One Audio Server er

1. Inthe Device I/O tab, click the SAS Console button

SAS Console

The SAS Console dialog box appears.
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.ﬂ] SAS Console

[
Mame Dezcnption
|
Conzole Address Part Conzale (D[ 1 - 256 ]
[ o . o . o . o | ‘o[l 1%l

Deck #1 Source Channel # {1 - 93993 )
1%

Deck #2 Source Channel #
2 g

Deck #3 Source Channel #

3%l
[~ Connect &b Stat Up

x Cahcel ‘

Figure 4-24. SAS Console Dialog Box

2. Complete the fields in the dialog box (see Table 4-14).

3. Click OK.
Table 4-14. Fields in the SAS Console Dialog Box
Field Description Default

Name Enter a short identification name for your SAS console. This name should —

allow you to differentiate this device from other devices.
Description Enter a verbose description for your SAS console. —
Console Address Enter the IP address of the SAS console. 0.0.0.0
Port Enter the port number based on the requirements for your SAS console. 1024

Refer to the documentation for your SAS console.
Console ID Enter a unique ID to identify this SAS console. 1
Deck #1 Source Channel # Determine which audio devices are used for each of the three main 1
Deck #2 Source Channel # playback decks. The main playback decks are rotated as playback occurs. 2
Deck #3 Source Channel # The deck with which each item will play appears in the far-right column of 3

the Program Log Display in the Audio Server.

Because OpX One uses a software-based audio mixing engine, all three

Channel Playback fields can be set to the same device or, for more control,

to their own individual device. Setting each Channel Playback Device field to

a different audio device is useful for manual control over fades when each

device is connected to a separate channel strip on your console.
Connect At Start Up To have your Audio Server connect to this device automatically at startup, Unchecked

check this check box.

4.3.7.10 Adding an Advantech Device
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> To add an Advantech Device to your OpX One Audiudio Server

1. Inthe Device I/O tab, click the Advantech button

83 Advantech I

The I/O Card Device dialog box appears.

r

@) VO Card Device BN i =
Mame Drescrption

I 1

140 Card Type

J -]

Device

J -]

I Connect &tStart Up

P

x Cancel ‘

Figure 4-25. 1/0O Card Device Dialog Box

2. Complete the fields in the dialog box (see Table 4-15).

3. Click OK.
Table 4-15. Fields in the 1/O Card Device Dialog Bo x
Field Description Default
Name Enter a short identification name for your 1/O card device. This name should —
allow you to differentiate this device from other devices.
Description Enter a verbose description for your I/O card device. —
I/0 Card Type Select the type of I/O card. —
Device Select the device. —
Connect At Start Up To have your Audio Server connect to this I/O card automatically at startup, Unchecked
check this check box.
Closure Descriptions To make identification of what is connected to your Axia I/O device’s
closures, click this button and enter friendly names for each connected
closure. Figure 4-18 on page 84 shows an example of a closure list.
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4.3.8 Trigger Set Configuration Settings

You can use triggers to execute (play) audio events, carts, or macros when a closure is
received by your I/O device hardware. Common uses for this function are to use Start and/or
Stop buttons on your console, or “button boxes” for sound effects or other audio events.

A “trigger set” is a list of audio or macro events that are executed when a closure is
received. OpX One allows you to define multiple trigger sets and load them at will. They can
be loaded using the LOADTRIGGER®nacro (see Appendix A - Macros).

4.3.8.1 Creating Trigger Sets

> To create a new trigger set

1. From the Settings dialog box, click the Trigger Sets tab.
The Trigger Sets tab appears.
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General | Playback | Auto Fil £ Time Sealing | Fiesord | Categories | Folders | Device /0 ||
Trigger Sets | Misers | Data | Scheduled Everts Sete | Modes / Logs | Closuies / Rislays

-qg;_rqaﬂ B“Ed|t| % Cel |

Nanie | Desciiption |

Q{DK I x Cancel | E Apply |

Figure 4-26. Trigger Sets Tab

2. Click the New button .'.N...,’
The Trigger Set dialog box appears.
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Trigger Set
Mame [escription
Device

e Fe

# | Closure | Marne Category | Description

i

M Cancel ‘

Figure 4-27. Trigger Set Dialog Box

3. Complete the fields in the dialog box (see Table 4-16).

4. Click OK.
Table 4-16. Fields in the Trigger Set Dialog Box
Field Description Default
Name Enter a short identification name for your trigger set. This name should allow —
you to differentiate this trigger from other trigger sets.
Description Enter a verbose description for the trigger set. —
Device Select the device from which triggers will be received for this trigger set. —

4.3.8.1.1 Editing Trigger Sets

There might be times when you need to edit a trigger set. For example, you may want to
change the macro associated with the trigger set.
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> To edit a trigger set

1. From the Settings dialog box, click the Trigger Sets tab.
The Trigger Sets tab appears (see Figure 4-26).

2. Click the trigger set you want to edit, and then click the Edit button ~_*Edt
The Trigger Set Item dialog box appears (see Figure 4-27).

3. Edit the fields you want to change (see Table 4-16).

4. Click OK.

4.3.8.1.2 Deleting Trigger Sets

If you no longer need a trigger set, you can delete it.

« Note: A precautionary message does not appear before you delete a trigger set.
Therefore, be sure you do not need a trigger set before you delete it. You cannot
undo a trigger set after it has been deleted.

> To delete a trigger set

1. From the Settings dialog box, click the Trigger Sets tab.
The Trigger Sets tab appears (see Figure 4-26).

2. Click the trigger set you want to delete.

3. Click the Del button = X Del |
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4.3.9 Mixer Configuration Settings

The Mixers tab allows OpX One to control the volume levels of the audio devices installed
on your Audio Server machine. The main use for this function is control of audio feeds from
satellite. The Audio Server allows you to configure 10 mixer profiles, each of which is
controllable using macros or the Clock Builder.

4.3.9.1 Creating and Editing Mixers
» To create and edit mixers

1. From the Settings dialog box, click the Mixers tab.

A tab similar to the following appeatrs.
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“Settings Es
"General 1 Playback | duta Fil £ Time Scaling ] Record | Categaries | Folder&i Device /0 1
Trigger Sets Misers ] Data j Scheduled Events Sets ] todes / Logs | Closuies / Relays 1

|8 Edit

# | Mame | Desoription

1 MI<ER] : il
2 MIXERZ MIER2
3 MIXER3 MI=ER3
4 MIXER4 MI=ER4
5  MIXERS MIERS
E  MIXERE MIERE
7 MIXER? MIXERT
8 MIXERS MI=ERS
3 MIXERS MI=ERS
10 MIXERT0 MIXER10

" Ok | X Cancel J H 2pe ‘

Figure 4-28. Mixers Tab

2. Click a mixer profile, and then click the Edit button

A Mixer dialog box similar to the following appears. The left pane shows the installed
audio devices and each controllable function of that audio card.
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&) MIXERI / MIXERL (5]
MHarme Descrption
MIXEET [MIXER1
4k | % ‘ :i-: = | AY Faders

El-4@= MasterVolume  » | #] Card | Control | Description
S5 1 - ASIER20 /02w DM |
[-43= Master Valume

S5 1 - ASIER20 /02w DM |
[--#@= Master Yolume :
BB 1 - ASIE520 /04 WD |
[--#@= Master Yolume
g 1 - ASIERZ0 Mimer
|£I-B{§= Record 1

|£|-B=§=' Record 2

4= Line Dut 1
[#--4@= Line Out 2

S Speakers [2 High Defir|
[ 4@= Master Yalume |

m

al m J b Pl T b

W OK X Cancel

Figure 4-29. Mixer Dialog Box

Browse through the list in the left pane, and then click the volume control of your desired
device’s input or output channel.

. To add a device to the mixer’s configuration, click the Add button < |

. To remove a control from the mixer’s configuration, click the control in the list on the right
(see Figure 4-30), and then click the Delete button % |

. When you finish, click OK.
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y MIXER] / MIXER]

Name Description

[UNERNTT  [GneinT toLneOu 1 onASIEON2T

Figure 4-30. Mixer Editor with an AudioScience 6012  Model's
Line In 1 Pass-through Volume Control Selected
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4.3.10 Data Configuration Settings

PAD data is an industry-standard format of data output used by HD radio transmitters and
RDS encoders to communicate artist, title, description, and other information. PAD data can
either be transmitted from the OpX One system as a .xml file or sent directly to a device in
the network using that device’s IP address.

To set up PAD data output, use the Data tab.

> To configure data settings

1. From the Settings dialog box, click the Data tab.

A tab similar to the following appears.
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Seftings
General | Plaphack ] Auta Fill £ Time Scaling ] Hecord { Categories | Falders | Device 140 ]
Trigget Sets | Mizers  ['ata ] Scheduled Events Setz | Modes # Logs | Closures / Relaps 1

TE

" Filz Mams
| =

™ |P Address Port
/0 . 0 . 0 . 0

[10.1.1.10- 0gi® -]

Fieldz Euclude Categonies | Folders |
[CJcUTID A [[1 5pats -
I TITLE | [ Mews (=]
O &RTIST [ Music
[CILEMGTH = 1 Imaging =
L Wl ol B | s LI FA
FEER T ) FEER Tl )

Mest Events Minirmum Length

il Z . | 0% ] 30|*;3| Seconds

[~ Remove Text Between Specified Character in Title & Artist Fields |

Default Drefault
Title * Artizt *

* Defaultz Are Uged For Excluded [bems

| J 0k | x Cancel ‘ E Apply ‘

Figure 4-31. Data Tab

2. Complete the fields in the dialog box (see Table 4-17).

3. Click OK.
Table 4-17. Fields in the Data Tab
Field Description Default
Enable PAD Output To enable output of PAD data, check this check box. Checking this check Unchecked
box enables the remaining options in this tab. To stop PAD data output,
uncheck this check box.
File Name To output PAD data to an .xml-formatted file, check this option, and then —
either enter the path in the field or click the == icon, go to the desired
location in the Browse dialog box, and click Open. Each time the PAD data
is updated, the specified filename are overwritten with a new copy of the
xml file with the current data
IP Address To have OpX One output PAD data directly to an IP address, check this 0.0.0.0
Port option and enter the IP address and port number. —
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Field Description Default

Network Interface Select the IP address of the OpX One network interface for this IP 10.1.1.20 - OpX
connection. One

Fields Check the types of data you want the Audio Server to output as PAD data. Unchecked

Exclude Categories (Folders) Each audio event category you defined appears in this list. Enabling one of Unchecked
the categories in this list causes the Audio Server to NOT output the data of
that event to the PAD data.

Previous Events Allows you to transmit a desired number of data about the previously played 0
audio events.

Next Events Allows you to set a desired number of upcoming audio events for which to 0
send data.

Minimum Length Allows you to exclude events from transmitting PAD data. This option allows 30 seconds

you to set a limit by the minimum length audio events that must send PAD
data (in seconds).

Remove Text Between Specified
Characters in Title & Artist Fields

Data from the artist or title fields to be removed when sending pad data. This
is determined using a special character. If you have an artist that looked like
"grateful dead 1972 Europe," for example, and you want the pad to display
only "grateful dead," you can change it to "grateful dead *1972 Europe*" and
set the asterisk to be our delimiting character.

Default Title Default information to show if the title field is missing or if the data is being —
skipped.
Default Artist Default information to show if the artist field is missing or if the data is being —

skipped.
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4.3.11 Scheduled Event Set Configuration Settings

Scheduled events are events — audio files or macros — that you want executed
automatically, regardless of other activities being performed in the program log or any other
area of the OpX One system. They are ideal for starting records, sending serial strings,
controlling switchers, or any other event you want to occur in the background.

Scheduled events are added to a Scheduled Events Set. OpX One works with only one
Scheduled events set at a time. It is possible to switch which Scheduled Events Set is
loaded using the LOADSCHEDULEDacro. You can also run the LOADSCHEDULE®Dacro from
within a Scheduled Events Set to load another Scheduled Events Set.

4.3.11.1 Adding Scheduled Events

> To configure a new scheduled event

1. From the Settings dialog box, click the Scheduled Events Sets tab.

A tab similar to the following appears.
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General | Playback | Auto Fill / Time Scaling | Record | Categories | Folders | Device 140 |
Trigger Sets | Mixers | Data ~ Scheduled Events Sets IModes/LogsI Closures / Relays |

eu-New| @Y Edi | ¥ Del |
Name | Description |

< 0K Xconcel | B Aeey |

Figure 4-32. Scheduled Events Sets Tab

2. Click the New button —£ter

The Scheduled Event Sets dialog box appears.
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Scheduled Events Set
Mame [rescription
dprien]| @z | ve]
# | Schedule | Categary | Mame Description / Command |
X Cancel ‘

Figure 4-33. Scheduled Event Sets Dialog Box
3. Complete the fields in the dialog box (see Table 4-18).

4. Click OK.
Table 4-18. Fields in the Scheduled Event Sets Dial og Box
Field Description Default
Name Enter a short identification name for your scheduled event. This name —
should allow you to differentiate this trigger from other scheduled events.
Description Enter a verbose description for the Scheduled Event Set. —
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4.3.11.2 Editing Scheduled Events

There might be times when you need to edit scheduled events. For example, you may want
to change the name or description associated with the scheduled event.

> To edit a scheduled event

1. From the Settings dialog box, click the Scheduled Event Sets tab.
The Scheduled Event Sets tab appears (see Figure 4-32).

2. Click the Scheduled Event Sets you want to edit, and then click the Edit button SEd
The Scheduled Event Sets Item dialog box appears (see Figure 4-33).

3. Edit the fields you want to change (see Table 4-18).

4. Click OK.

4.3.11.3 Deleting Scheduled Events

If you no longer need a scheduled event, you can delete it.

« Note: A precautionary message does not appear before you delete a scheduled
event. Therefore, be sure you do not need a scheduled event before you delete
it. You cannot undo a scheduled event after it has been deleted.

> To delete scheduled events

1. From the Settings dialog box, click the Scheduled Event Sets tab.
The Scheduled Event Sets tab appears (see Figure 4-32).

2. Click the scheduled event you want to delete.

3. Click the Del button = ¥ Del |
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4.3.12 Mode and Log Configuration Settings

The Modes tab allows you to configure OpX One modes, program log options, and macro
options.

To configure modes and logs

1. Inthe Device I/O tab, click the Modes / Logs tab.

The following tab appears.

" Genersl ! Flayback ! Auto Fill # Time Scaling ] Fiecord | Categories ] FDIdersi Dievice 140 !
Trigger Set&i b imers ! [rata I Scheduled Events Sets  Modes / Logs | Clozures / Flela_l,lsi

‘Allowed Modes

V¥ File Server Updates Ta Log ltems | IF Unchecked Depend O FilsSyne Only |
v Update Al Pragram Logs [ 1f Unchecked Depend On FileSpne Only |

[T Chesk File Serwer Progiam Loag And Meérge ChangesIntg OnedirLog
‘Macio Options

bt acro Separator Character

-

J Ok | X Cancel I =] .-’-'«pply_l

Figure 4-34. Modes / Logs Tab

2. Complete the fields in the tab (see Table 4-19).
3. Click OK.
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Table 4-19. Fields in the Modes / Logs Tab

Field Description Default

Allowed Modes Designates how each OpX One Audio Server advances through a program Checked
log. There are three modes for each Audio Server: manual, assist, and auto.

» Manual mode = the Audio Server steps through the log manually, relying
on outside input before advancing.

« Assist mode = intended for use by live talent. Audio events load from the
program log into the Playback Deck Stack, but segues do not execute
automatically as they are in auto mode. Events are played by clicking the
Start/Start Next button, an individual deck’s play button, a timed event, or
by a closure (if configured)

« Auto mode = the Audio Server advances through the log automatically,
unless it encounters a command in a log directing it to do otherwise.

Program Log Options Allows you to configure the following options: Checked

« File Server Updates = when checked, the Audio Server transfers new
program logs. Not necessary with FileSync.

« Update All Program Logs = updates anything in the Logs folder, not just
logs that match the program log template. For example, TESTLOG
transfers, even though the template is %mm%dd%yy.

» Check File Server Program Log = moves updates in real-time into the
program log.

Macro Options Allows you to define the character that separates macros. ;
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4.3.13 Closure and Relay Configuration Settings

The Closure/Relay tab allows you to configure the following settings:
Start deck closures — see section 4.3.13.1.
Stop deck closures — see section 4.3.13.2.

« Channel on relays — see section 4.3.13.3.

« Channel off relays — see section 4.3.13.4.

« Voicetrack relays — see section 4.3.13.5.
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4.3.13.1 Configuring Start Deck Closures

The Start Deck Closures tab allows you to
configure incoming closures to trigger Deck #1,
Deck #2, and Deck #3 to start playing their
currently loaded events. This feature is most
commonly used with Start buttons on your
station’s console. The Ignore Start Closure

For option allows you to set an ignore period
for the incoming closure so that an accidental
double-press of the button will not cause the
deck to play 2 items.

4.3.13.2 Configuring Stop Deck Closures

The Stop Deck Closures tab allows you to
configure incoming closures to trigger Deck #1,
Deck #2, and Deck #3 to stop playing their
currently playing event

Settings @
General | Playback ] Ao Fill # Time Sealing ] FRecord | Categories | Folders | Device 140 |
Trigger Sets | Misers | Data | Scheduled Events Sets | Modes /Logs: Closures / Relays

Dievice

£

Channel Off Rielayz | Woicetrack Relapz !
Stop Deck Closures

Channel On Relaps |
Start Deck Closures

Dieck #1 [ Start Mext For Assist & Auta Mades |

| Mat Applicable j
Deck #2
| Mat Applicable j
Deck #3
| Mat Applicable _:J

[¥ Ignare Start Closure For | 1000 %3] Miliseconds After & Deck Starts

| J 0K | x Cancel ‘

fepy |

Figure 4-35. Start Deck Closures Tab

Settings @
General | Playback ] Ao Fill # Time Sealing ] FRecord | Categories | Folders | Device 140 |
Trigger Sets | Misers | Data | Scheduled Events Sets | Modes /Logs: Closures / Relays

Dievice

=

Chanrel Off Relays | “oicetrack Felays |
Stop Deck Closures H

Channel On Relays ]
Start Deck Closures

Dreck #1
| Mat Applicable LJ
Dreck #2
| Mat Applicabls j
Deck #3
| Mat Applicable _:J

| o 0K | x Cancel ‘

H 4o |

Figure 4-36. Stop Deck
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4.3.13.3 Configuring Channel On Relays

The Channel On Relays tab allows you to
configure outgoing relay closures to pulse or
latch on when Deck #1, Deck #2, or Deck #3
are playing on the Audio Server.

If using Pulse At Beginning Of Playback
For, specify the duration of the pulse from
the Milliseconds selector (for a secondary
closure when each deck stops, see section
4.3.13.4). Otherwise, to keep the relay
latched, select On For Duration Of
Playback

4.3.13.4 Configuring Channel Off Relays

The Channel Off Relay tab settings are
used to configure a momentary outgoing
relay closure to for Playback Deck #1,
Deck#2, or Deck #3 when and will pulse the
selected relay when playback is stopped.

The relay options on this tab are used only
when the Pulse At Beginning Of Playback
option on the Channel On Relays tab is
enabled (see section 4.3.13.3). The pulse
length setting for the Channel Off Relays are
the same as those configured in the
Millisecond field on the Channel On

Relays tab.

Settings
General | Plapbiack. ] Auto Fill / Time Scaling ] Fiecord | Categaries ] Folders | Device 1/0 |
Trigger Sets | Misers | Data | Scheduled Events Sets | Modes / Logs  Closures / Relays

Drevice

-1

Stop Deck Closures |
Channel Off Relays | Woicetrack Relaps ]

Start Deck Closures
Chanrel On Relays |

{* Pulse At Beginning Of Playback For | 500 'Z& Millizeconds

{7 OnFor Duration OF Playback

Dieck #1

|Not Applicable LJ

Deck H2

|Not Applicable _ﬂ

Deck #3

|Nut Applicable LJ
‘ J ar x Cancel I H app I
Figure 4-37. Channel On

Relays Tab
Settings

General | Plapbiack. ] Auto Fill / Time Scaling ] Fiecord | Categaries ] Folders | Device 1/0 |
Trigger Sets | Misers | Data | Scheduled Events Sets | Modes / Logs  Closues / Relays

Drevice

Start Deck Closures
Channel On Relaps

top Deck Closures |
] Woicetrack Relaps ]

Dieck #1

|Not Applicable LJ
Dieck #2
|Not Applicable ﬂ
Dieck #3
|Not Applicable :J

* Channel Off Relays are only
applicable if the Channel On
Relays are zet to pulse.

‘ o 0K x Cancel I H 4ppl I
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Figure 4-38. Channel Off Relays Tab

4.3.13.5 Configuring Voicetrack Relays

The voicetrack relay function works with BSI Skimmer Plus to enhance your skimming
functionality and the validity of what is played on the air.

When a voicetrack is played over the air, the relay chosen in the Playing Voicetrack Relay
field will be latched closed.

Voicetrack Inhibit Relay is used to have Skimmer Plus ignore its “mic open” closure while
the OpX One Studio Client is in the Voicetrack Editor. This prevents Skimmer Plus from
recording the creation of your voicetrack before it is completed so that the voicetrack is not
recorded as if it was played over the air.
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Settings
General | Playback ] Auta Fill £ Time Sealing | Record | Categaries | Falders | Device 140 |
Trigger Sets | Mikers 1 Data | Scheduled Everts Setz | Modes ALogs  Closures / Relaps

Drevice
Start Deck Closures ] Stop Deck Clozures |_
Channel On Felays | Charirel Off Betays Woicetrack Helays
Flaving “Yoicetrack Relay
| Mat Applicable L]
| Mol dpplicable _]

| q/ Ok | x EancL?i E Apply ‘

Figure 4-39. Voicetrack Relays Tab

4.4 Loading the Program Log

Clicking Load Log on the File menu allows you to load a log ad-hoc manually. This is useful

when you want to play content that is not part of your scheduled programming, or need to
reload or restart a log.

> To load the program log
1. On the File menu, click Load Log .

The Load Program Log dialog box appears.
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=

[ Load Program Log

Today Tomorrow esterday ‘

test

[ Load From Server W OF X Cancel |

Figure 4-40. Load Program Log Dialog Box
2. Complete the fields in the dialog box (see Table 4-20).

3. Click OK.
Table 4-20. Fields in the Load Program Log Dialog B ox
Field Description Default
Today Automatically loads the log specified for each day based on the “Program —
Tomorrow Log Name Template” setting in the General tab of the Settings window (see
Yesterday section 4.3.1). Clicking one of the Today, Tomorrow, or Yesterday buttons
loads the specified log instantly and closes the dialog box.
To select a specific log instead of using the Today, Tomorrow, and
Yesterday buttons, click the name of the log in the log list and click OK. If
you do not want to load a log, click the Cancel button.
Load From Server By default, logs are loaded from the Audio Server’s local hard drive. Unchecked
Checking this check box shows the logs stored on your File Server.

4.5 Adding, Editing, and Deleting Items in the Prog  ram Log

The Edit menu has Add, Edit, and Delete options for adding, editing, and deleting items in
the program log.

4.5.1 Adding Items to the Program Log

Use the Add button on the File menu to insert files manually into the currently loaded
program log ad-hoc.
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> To add an item
1. Inthe program log, click the item above where you want to insert the item.
2. On the Edit menu, click Add.

The Add dialog box appears.

[ Add ==

Cue

Auto Skart [ + ]

Scheduled Time [ HH:Mi:55]
Q00000 ==

Categaory

Mame [ Cut Id / File ]

Description # kacro Command

o OF X Cancel |

Figure 4-41. Add Dialog Box
3. Complete the fields in the dialog box (see Figure 4-41).
4. Click OK.
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Table 4-21. Fields in the Add/Edit Dialog Box

Field

Description

Default

Cue

Allows you to set the cue type for the item being inserted. For more
information, see Appendix B - Cue Types.

Auto Start (+)

Scheduled Time

Set the time the event is scheduled to play. This setting is not required for
events with a cue type of Auto Start or Stop because it has no effect on
playback, although it is useful to track when your events should play.

With Time Immediate and Time Next events, however, the Scheduled Time
is required because it determines when OpX One plays the event. Enter the
time in HH:MM:SS format (2 digits for the hour, 2 digits for the minutes, and
2 digits for the seconds, each separated by a colon).

00:00:00

Category

Three types of events can be added:

« Audio = all Audio files belong to the type ‘Audio’ (even if they were given
a custom category)

» Macro

» Comment = remarks that can help you track of your log, but do not
perform a function. The cue type of a comment does affect the flow of
playback; a Stop cue on a comment stops playback, as it would on an
audio file.

Name

Enter the name of the audio file you want to insert. This field is used only by
the add function when entering items with “Audio” selected from the
Category drop-down list.

Description / Macro Command

All categories use this field.
« Audio events = enter the description of what you are entering.
» Comments = enter the text of the comment.

» Macro = enter the command to be performed (see Appendix A - Macros
for information about the available macros and their command structure).

4.5.2 Editing Items in the Program Log

There might be times when you need to edit items in the program log.

» To edit an item

1. Inthe program log, click the item you want to edit.

2. On the Edit menu, click Edit.

An Edit dialog box similar to the following appears.
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Scheduled Time [ HH:M:55]
o000 =
Cateqory
|4UDID ~|
Marme [ Cutld £ File ]
|348b-09
Dezeription # Macro Command
![Fh:u:k] Superztar[Clean Edit] - Cyprezs Hi
W OF X Cancel ‘

Figure 4-42. Edit Dialog Box

3. Edit the fields you want to change (see
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4. Table 4-21).
5. Click OK.

4.5.3 Deleting Items from the Program Log

If you no longer need an item in the program log, you can delete the item.

« Note: A precautionary message does not appear before you delete an item.
Therefore, be sure you do not need the item before you delete it. You cannot
undo an item after it has been deleted.

> To delete an item
1. Inthe program log, click the item you want to edit.

2. On the Edit menu, click Delete.

4.6 Playing Back a Program Log ltem

The following procedure describes how to play back an item in the program log.

If the program log is playing when you click the Start option or button, playback of the
current item continues and the selected item will play back at the highlighted point. To move
playback to a new point in the program log from the Audio Server, use the Stop option or
button to stop playback, then select the item in the program log at the point where you want
to restart playback and click the Start option or button.

> To play back an item in the program log
1. Inthe program log, click the item you want to play back.
2. Perform one of the following steps:

— On the Action menu, click Start.

»

3. To stop playback, perform one of the following steps:

— On the tool bar, click

— Onthe Action menu, click Stop.

[a
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— On the tool bar, click
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Topics:

A

Starting the Auxiliary
Audio Server Module
(page 123)

5 Auxiliary Audio Server Module

This chapter describes the OpX One Auxiliary Audio
Server module.

The OpX One Auxiliary Audio Server is an OpX One
Audio Server that you can run to perform tasks such as
performing background recordings. Performing
recordings and other utility tasks in the background
removes these tasks from having to be performed by the
main Audio Server. The Auxiliary Audio Server has the
same functions as the main Audio Server, except that it
is not accessible from an OpX One Studio Client.
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5.1 Starting the Auxiliary Audio Server Module

You must start the File Server module before you start the Auxiliary Audio Server.

> To start the Auxiliary Audio Server module
1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software >
AUXILIARYOpX One AudioServer

The Auxiliary Audio Server module appears.

Eile Edit Ackion Abouk
]
> B 3 AUXILIARY
£ | em | Description | Wame | Sched/&ctual | Length| =]
g Mada @ 52 SATSHOWSTART AL, 130000/ 183307
2 [ @ 53 SATSHOW STOP, 4B, 130515 / 16:33.07
& | e (| C B4 SATSHOW/START, L. 130500/ 163307
£ [Trigger Set I - SATSHOW STOP, LA, 13:53.00/ 163307
g @ 55 SATSHOWSTART,A. 14:0000 / 163307
E Time Events (] I @ &7 SATSHOW STOP, AB.. 14:05:00 / 16:33:07
: @ 58 SATSHOWSTERT.H. 14,0500 / 16:33:07
E' step Though [0 I | & 4 SATSHOW STOP, FE .. 145950 / 163307
2 Jreme @ 60 SATSHOWSTART,A. 150000 / 18.33:0F
£58 @ B SATSHOM STOR, 4B 15:05:15 /16:33:07
g SchedSet DEFAULT @ B2 SATSHOW START, L. 15:0800 / 16,32:07
z @ &3 SATSHOW STOP, LA, 155900/ 163307
g b |@ 8 SATSHOwSTaRT AL 16:00.00 / 163307
£l @ E5 SATSHOW STOP, 8., 16:05:00 / 16:33:07
S [Mame | Detais @ B SATSHOW START, H... 16:05.00 / 16,33:07
— @ B7 SATSHOW 5TOP, HE... 16:55:50
¢ @ B8 SATSHOW START, 6. 17.00:00
- @ B3 SATSHOW STOP, 4B, 17.0515
2 @ 70 SATSHOW START. L. 17-06:00
=i @ 71 SATSHOW STOF, LA, 17:55.00
@ 72 SATSHOW START, A 18:00.00
@ 73 SATSHOW STOP, AR 18:05:00
( | wle SATSHOW START. H... 18:06:00 -
' @ 75 SATSHOW STOP, HE... 185550
] @ 75 SATSHOW START, A 15:00.00
@ 77 SATSHOW STOP, AB.. 19:0515
@ 73 SATSHOW START, L. 19:06:00
@ 73 SATSHOW STOP, LA, 19:55.00 5
= on CATCUDN S CTADT A 0O0L 00
Al | ]
[ | [ ¥0.0.0.343 4

Figure 5-1. Auxiliary Audio Server Module

3. Refer to the equivalent sections in Chapter 4, as the module setup and usage are
the same as the Audio Server module.
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6 Studio Client Module

Topics: This chapter describes the OpX One Studio Client

. . . module.
4 Starting the Studio Client

Module (page 125) The OpX One Studio Client module is the module used
in the on-air  studio and production studio. The Studio
Client module includes the Voicetrack Editor, which
4 Configuring the Studio allows you to edit voicetracks for the program log

Client Module (page 134) currently on the air.

4 Quick Tour (page 126)

4 Operating Modes (page
144)

4 Verifying a Program Log
(page 146)

4 Loading a Program Log
(page 148)

4+ Playing Back a Log
(page 150)

4+ Editing a Program Log
(page 151)

4 Using Hot Keys (page
153)
4 Saving the Hot Key

Page to theFile Server
(page 160)

4 Using the Voicetrack
Editor (page 161)
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6.1 Starting the Studio Client Module

You must start the File Server module and Audio Server module before you start the Studio
Client module.

> To start the Studio Client module
1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > OpX One
Studio Client .

OpX One searches for stations, and then shows the stations found.
3. Click a station, and then click Done.

A Studio Client window similar to the following appears.

@KUFFH - OpX - Broadcast Software International

05 ’i, J" ZANN

Hot Traffic Sweeper
Bed Whisper TNH
933

1,34 322

ZANN
Sweeper
Whisper

10.0

@ TODAY'S HIT MUSIC

Log: 041316 Air Date: 04/713/2016 ZAl
" QUicE — = = i Empire State | Hot Traffic s L Al

, Bed Bed b

Request

TALK BREAK 15 19:39:04

ROUS WOMAN Jo ol
IANDE 142926 19:39:04 : & Sweeper | Freek-A-Leek
= | Commercial Bed
Free

NO o .
MEGHAN TRAINOR 19:42:28

TALK BREAK ‘ 19:45:52 ZANN
19:45:631 - L 2 Sgrebe:ner Sweeper Frontin' Bed
- 2 Hashtag

ZANN

Dictionary

START EDIT
DELETE MOVE NEXT INSERT SEGUE OPTIONS
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6.2 Quick Tour

The following sections provide a quick tour of the Studio Client module interface.

A KUIF-FM OpX - Broadcast Software International i _ :!!g
ol 1
stop | 1 € ZANN
ZANN
Hot Traffic Sweeper Sweeper
0 Bed Whlsg;; TNH Whisper

2:05 134

@ TODAY’S HIT MUSIC

Log: 041316 Air Date: 04/13/2016 5 ZANN
- - Empire State | Hot Traffic Sweeper All

Bed Bed Request

1001 TALK BREAK 15 19:39:04 0.0

o DAN C e 142926 ’ 100 19 ZANN
eSS 2 el T 7 Sweeper  Freek-A-Leek
ICK 0.0 /7 %] Commercial Bed
5>

1003 Free

“haviek 194228 0,

NO .o )
1004  MEGHAN TRAINOF 142921 19:42:28 U[‘l 0.1 ‘ 7
<3:25.0>

1005 TALK BREAK 15 19:45:52 0.0

ZANN ZANN

1006 Mgi?m“ ty PFLAGS 19:45:53 L L] Swesper Sweeper Frontin' Bed
<36.5> Urban Hashtag

" Dictionary

‘;
€

MAKE START EDIT

NEXT NEXT WHEH! SEGUE OPIINS

e AUTO DELETE MOVE COPY

Number Description

Date/time panel. See section 6.2.1.

Station panel. See section 6.2.2.

Hot Key panel. See section 6.2.7.

Navigation bar. See section 6.2.5.

Menu bar. See section 6.2.6.

Program log. See section 6.2.4.

Playback decks. See section 6.2.3.
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6.2.1 Date/Time Panel

The date/time panel shows the current system date and time.

f KLIF-FM - OpX - Broadcast Software International -8 5]

Clicking the Time section allows you to toggle between 12-hour and 24-hour display
formats.

Clicking the weather information opens a pop-up window that shows current weather and
forecast details.

6.2.2 Station Panel

The station panel shows the logo of the station (Audio Server) to which
the Studio Client is connected. You can click the station panel to

change stations. TODAY’S HIT MUSIC

Q Tip: To add a station logo to this panel, save a picture in .jpg format in the
Shared Config folder on your file server. Name the file after the station name. In
the example above, for instance, the station profile is named “WOPX” and the
logo file is named WOPX.jpg.

6.2.3 Playback Decks

The playback deck stack shows the
currently playing audio files along with
those that are upcoming. As your
program log runs, it populates the decks
with the audio files to be played.

The three decks in the stack are shown in

the example above, with the top-most deck currently playing an audio file. The currently
playing audio file always moves to the top of the stack, with the next-to-play audio file
second, and third-to-play deck last. This is referred to as a stack because the decks are not
in order numerically; instead they are in order by which file is currently playing, then the next
to play, and then third to play. When the currently playing deck finishes with its event, it
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rotates out of the stack, the next items move up, and a new third-to-play item is added to the
bottom of the stack.

When an audio file is playing, you can use the Stop Button to stop playback of the deck.
The progress meter shows the length remaining of the audio file in text. In the example
above, 2 minutes, 39.7 seconds remain) and creates a bar-graph representation in the
background.

The color of the text and progress bar depends on the portion of the audio file that is playing:
« Blue = appears during intro.

- Green = appears during the main section.

« Red appears during the segue.

The deck from which the audio file is playing appears at the far right, with a @, 2), or @
icon.

6.2.4 Program Log

Log: 041316 Air Date: 04/13/2016

The program log shows the schedule of
events that will be played, including audio

files, carts, and macros. S o i ki
[)FA“N ‘{:S WOMAN "* 142926 19:39:04

The name of the currently loaded log HOT QUICK g T

appears after the Log: tag at the top of the Nusen rrancs 194228

log. If the intended air date of the log is set, TALK BREAK 19:45:52

it appears after the Air Date: tag. _ e 194553

Except for the first and last columns, the
header of the list contains titles for the data
type of each column of the program log.
Table 6-1 describes each column in the

program log.
Table 6-1. Columns in the Program Log
Column Description
Cue Uses an icon to show the cue type of each program log item:

« [No Icon] Auto Start = Auto Start cued events have no icon in the Studio Client’s program
log display. This is equivalent to the + cue the Audio Server shows for Auto Start events.

. G Time Immediate = event with a cue type of Time Immediate. This icon is equivalent
to the @ cue on the Audio Server.

(=
. \) Time Next = items with a cue type of Time Next. This icon appears for events
designated with the # cue on the Audio Server.

. @ Stop Cue = audio playback will stop. This icon appears for items with no cue type
on the Audio Server.
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Column

Description

Shows the event number of each event in the program log. The first event at the top of the
program log is event 1 and each event after that is incremented. This makes it easy to track
your location in your log should you exit and re-open OpX One or edit in a production room.
The currently playing event displays Play rather than its event number.

Description

Shows the Artist and Title data from your audio files and carts. For Macro events or
Comments, the specified entry is shown. For quick identification, an icon appears to the
right of the description text for common category types:

. ﬁ = commercials

. EE = music
. = cart
. L_ = voice track

o W =macro

Name

Shows the physical file name (the name the audio file on the hard drive) of audio events.

Time

Shows the time your audio file is scheduled to play. The time can be configured to show the
estimated time, scheduled time, or both using the Log Time drop-down list in the General
tab of the Studio Client module (see Table 6-5 on page 136). If no time is specified by your
traffic or music log-generating software, OpX One estimates when the subsequent files will
play based on the currently playing item and the system clock setting. This field changes to
a Play button (or a Stop button on the currently playing event) on the highlighted event in
the program log.

Length

Shows (from left to right) the intro length, total length, and segue length of audio events.
Macros and comments do not have an associated length and do not show a length.

Deck Number

Uses an icon to show which deck number will be used to play each item. This is useful if
you configure your audio server to use separate line outputs to your console for performing
manual fades, etc. If you force a re-load of the decks or change the next-to-play item, the
playback order in this column is reset and the order can change.
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6.2.5 Navigation Bar

The navigation bar runs along the right side of the program log. It contains the icons in Table
6-2 that simplify navigation in the program log.
Table 6-2. Icons in the Program Log Navigation Bar

Icon Icon Name Description

Page Up Click to move the program log up one page at a time.

Event Up Click to move up one item at a time.

Current Event | Automatically scrolls the program log to the currently playing event.

Go To Time Click to go to a specific time in your program log. A grid appears with a button for each hour
of the day. Click the desired hour to go to that portion of your program log.

CHE SR HE

Detach If you have two monitors, click to place the Hot Keys to detach the Hot Key Panel from the
Hotkey Panel | main user interface and make the panel a separate user-sizable window.

Event Down Click to move down one item at a time.

Page Down Click to move the program log down one page at a time.

= & 0
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MAKE START EDIT

626 Menu Bar AUTO DELETE  MOVE COPY CUE e NEXTT [FISERTH OPTIONS

The menu bar contains the main function buttons of the user interface. The buttons that
appear on the menu bar vary with the operating mode selected using the Mode button (the
far left button in the figure below, shown set to Auto mode). Table 6-3 describes the buttons
in the menu bar.

For more information about operating modes of the Studio Client module, see section 6.4.
Table 6-3. Menu Bar Buttons

Button Description

Use to switch operating modes of the Studio Client module.

g Highlight an item in the program log and click this button to delete the event.

e Highlight an event in the program log, click this button, and then click another location to move the event.

Highlight an event in the program log, click this button, and then click another location to copy the event.

Sets the program log to cue mode to preview intros and segues of each audio event.

To reload the Playback Deck Stack with the currently highlighted event in the Program Log as the next-to-
play item, click this button.

Starts playback or forces a segue to the next event.

Opens the Event Insert window to add items to the program log or Hot Keys.

Edits the cross-over length and type for an individual segue, click this button to open the Segue Editor.

Provides access to various Studio Client options, including voicetracking and loading and saving of logs.

HEEEERRERE
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6.2.7 Hot Key Panel

Hot Keys are “instant-fire” audio files, carts, or macro
commands available at the touch of a button. You
create Hot Key Sets to organize the Hot Keys
available.

The Hot Key Panel has a Hot Key Set loaded with
audio files and carts. Clicking any Hot Key plays the
specified audio event.

Adding or replacing items is as easy as dragging-and-
dropping from the Insert Item window (shown in Figure
6.4) onto the desired Hot Key.

To edit the color, options, or clear a Hot Key right-click
a Hot Key and click the corresponding option from the
pop-up menu.

To switch between Hot Key Sets, click the Next - or
Previolus . button.

The
TWILGH

To save Hot Key Sets to your local machine, click the
Save To Server button. To load a previously saved
Hot Key Set from the server, click the Load From
Ser\verg button. To refresh the currently loaded Hot
Key Set, click the Refresh button. To adjust the number of rows and columns displayed
on the Hot Key Panel, click the Hot Buttons Settings button.
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6.2.8 Insert Panel

The Insert Panel inserts audio events into the program |* FLTeR FULL

OFF TEXT

log display and adds audio events to the Hot Keys.

To access the insert panel, click the Insert button in
the menu bar at the bottom of the Studio Client user
interface. The insert panel can be displayed in two

locations: 38.6/48 Fi Dec 15,05

636 Items

« Superimposed over the top of the Hotkeys Panel.

Fii. Dec 15, 06 ¥

- Over top of the left side of the program log display.

Fii, Dec 15, 05,

To switch orientations, click the Insert button on the
menu bar to toggle between views. The panel
switches between the orientations with each click. This
allows you to drag audio events into the program log
(when the panel is over the Hot Keys) or to the Hot
Keys (when the panel overlaps the program log).

Chariots Of Fire

The Quick field shows the file name of the event you Yandolie
highlighted in the event list. If you know the name of
the event you want to insert, enter the file name using
your keyboard. After you select and highlight your
event, the insert method you use depends on where you place your event:

INSERT REFRESH

- Toinsert an event into the program log, click the Insert m button. The button will
switch its label to Insert Where2? i at which point you can click on the location in
your program log where you want your event placed. The event you click shifts down,
along with all subsequent events, and the new event is inserted.

- To add your event to a Hot Key, use your mouse cursor to drag the event from the event
list and drop it onto your desired Hot Key.
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6.3 Configuring the Studio Client Module

The Studio Client module comes with default configuration settings. Using the Config option
on the Options menu, you can change these settings to suit your requirements. For
convenience, the settings are organized in tabs in the Settings window.

> To configure the Studio Client module settings
1. On the Options menu, click Config .

The Configuration dialog box appears, with the General tab displayed.

Configuration

General ]

ple Rate
Mode
STEREQ I

Hot Buttons Folder

IE- \F'mgTa}n Files [#BE]\Broadcast Software Inlematinrﬁ

Vaicetrack Folder

| C:\Program Files [«86)\Broadcast Software Intematior @J
low Height

Auto Position To Exect / Nexd Time Out

m onds

Log Time
Configuration Password

|Esl\maled Time

2. Complete the fields in the dialog box tabs.

General Settings — see section 6.3.1 Voicetracking settings — see section 6.3.4

Mode settings — see section 6.3.2 Audition/cue settings — see section 6.3.5

Playback settings — see section 6.3.3

3. When you finish, click Done.
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6.3.1 General Configuration Settings

The General tab contains basic settings for setting up your Studio Client module.
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Configuration

General

Sample Fate I Ao Of Macro Commands
: Yes / No Prompt
Mode v rt On Log ltem Play
STERED oard Functions
] Folder In INSERT List

Hot Buttons Folder

| C:4Frogram Files [+86\Broadeast Software Internatior 62| top Button On Playing fem
irack Folder I

e g ot TV A B TR £t oLk T A gl s e e e g gt i
| C:\Program Files [#26)\Broadcast Software Internatior i..:ﬂ

Splitter
[l Enzble Hot Buttons Settings
Enable Hot Button Undock
Mui Buttons
ot Time Ot 2 Show Log Info Abe rogram Log
Drag Drop From Hetk
h Minus 5

By Year
Hot Button Update Interval i =i
., Sha -heduled Time On Stops & Time Events

Log Time

Configuration Password |Estimaled Time

Jptions

Figure 6-4. General Tab
Table 6-5. Fields in the General Tab

Field Description Default

Sample Rate Output sample rate for all audio files played by the Studio Client (for 44,100 HZ
example, monitoring voice tracks, intros, segues, and Hot Keys).

Mode Determines whether audio will be stereo or mono (summed) for all audio Stereo
files played by the Studio Client (for example, monitoring voice tracks, intros,
segues, and Hot Keys).

Hot Buttons Folder Path where audio files used in Hot Key sets will be cached. See the tab

Voicetrack Folder Path where voicetrack files, and associated intro and segue audio file See the tab
portions used to create and edit your voicetracks, will be cached.

Row Height Amount of space each line of the program log display is allowed to use. A 38
higher number allows more data to be displayed per event. A lower number
allows more events to be displayed at the expense of the amount of data per
event that can be shown.
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Field

Description

Default

Auto Position To Executing/Next
Time Out

Number of seconds before the position line reappears on the voicetrack and
segue editors.

45

Hot Button Pages

Maximum number of Hot Key sets that the Hot Key panel will show. A lower
number is non-destructive, so setting the maximum page lower than an
existing Hot Key set does not delete or destroy the Hot Key sets above the
maximum number set.

10

Hot Button Update interval

Amount of time before the studio client checks for new version of the file
associated with the hot button.

30

Configuration Password

Security password that allows only intended users can access the
Configuration window. After a case-sensitive password is entered in this
field, a prompt appears when a user tries to go to the Configuration window.

Allow Delete Of Macro
Commands

Allows you to delete macro commands from the Studio Client program log
display.

Checked

Delete Yes/No Prompt

« Checked = a confirmation prompt appears before items are deleted.

« Unchecked = a confirmation prompt does not appear before items are
deleted.

Unchecked

Fade Current On Log Item Play

« Checked = currently playing audio event fades out when the log loads
and the first event in the newly loaded program log starts to play.

« Unchecked = when a new log is loaded, the currently playing event stops
playing before the first item in the next log starts.

Checked

Disable Keyboard Functions

» Checked = disable Studio Client Control + [Key] shortcuts. Normal
keyboard usage, such as typing in a name to search, is still possible. This
setting is helpful if you accidentally press or bump keys on your keyboard
that unintentionally affect playback.

« Unchecked = enable Studio Client Control + [Key] shortcuts.

Unchecked

Show Voicetracks Folder in
INSERT List

» Checked = insert previously created voicetrack files into the program log
or Hot Keys.

« Unchecked = hides the voicetrack folder in the Insert window’s Folder
drop-down list.

Unchecked

Rotation On Hotkeys

» Checked = adding an audio event to a Hot Key that has an audio event
already associated with it displays a prompt to replace the existing audio
event or add it as a rotation. Each time you click the Hot Key, it plays one
of the audio events in the rotation.

» Unchecked = the added audio event always replaces the one associated
with the Hot Key without displaying a prompt.

Checked

Stop Button On Playing ltem

« Checked = currently playing event displays a stop button in the program
log display rather than a play button. This setting does not affect the Stop
button in the decks on the Playback Deck Stack.

« Unchecked = currently playing event displays a play button in the
program log display.

Checked

Call Letters

» Checked = call letters appear to the left of the date/weather information in
the Studio Client interface. A field is provided for entering the call letters.

« Unchecked = call letters do not appear in the Studio Client user interface.

Checked

Slogan

» Checked = slogan appears to the left of the date/weather information in
the Studio Client interface. A field is provided for entering the slogan.

« Unchecked = slogan does not appear in the Studio Client user interface.

Checked
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Field Description Default
Enable Splitter « Checked = program log and Hot Key Panel widths can be moved by Unchecked
dragging the splitter bar between them.
«» Unchecked = program log and Hot Key Panel widths are locked to their
current position.
Enable Hot Buttons Settings » Checked = number of Hot Key rows and columns can be changed. Unchecked
« Unchecked = number of Hot Key rows and columns is locked.
Enable Hot Button Unlock « Checked = Hot Key panel can be unlocked. Unchecked
« Unchecked = Hot Key panel cannot be unlocked.
Multi-Color Buttons » Checked = color layout of the Studio Client can be changed. Unchecked
« Unchecked = color layout of the Studio Client cannot be changed.
Show Log Info Above Program « Checked = shows program log info information, including the name of the Checked
Log program log, at the top of the program log display.
« Unchecked = hides program log info information.
Drag Drop From Hotkeys » Checked = items from the currently showing Hot Key Set can be dragged Unchecked
and dropped into the program log.
« Unchecked = events cannot be dragged from your Hot Keys to the
program log.
Length Minus Segue In Log & Track length as calculated at the segue marker, not as calculated from the Unchecked
INSERT List end of the track.
Sync System Time With The File | Do not use this check box. Unchecked
Server
Alternate Last/Next Play Date » Checked = last and next play dates are alternated. Unchecked
« Unchecked = last and next play dates are not alternated.
Add Sort By Year Allows you to sort songs by the year they were produced. For example, this Unchecked
feature is useful with classic rock stations.
Show Scheduled Time On Stops | Time that items are scheduled to run, instead of the estimated time they will Unchecked
& Time Events play. Timed events can be programmed, so they will hit the scheduled time
exactly by using the @ cue type.
Max Voicetrack Length Maximum allowed length of the voicetracks. 5
Log Time « Estimated Time = time when the system thinks the item will play. Estimated Time
« Scheduled Time = scheduled time derived from an external scheduling
software application.
« Both Estimated & Scheduled Times = estimated and scheduled times.
Skin Options Allows you to customize the appearance of the Studio Client user interface. —

For more information, see section 6.12.9.
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6.3.2 Mode Configuration Settings

The Modes tab allows you to configure the initial and available modes for the Studio Client

module.

Configuration

Modes

GEenerall "

HAr
W Edit
W Voicetrack

Available Modes

H s
B Edt

Figure 6-6. Modes Tab
Table 6-7. Fields in the Modes Tab

Field Description Default
Initial Mode Allows you to set the default mode for the Studio Client when you open the Air
Studio Client Module.
Available Modes Uncheck options to disable modes from the Studio Client on your machine. Air
This is useful for production machines that you do not want to potentially Edit
allow to control the on-air playback Voicetrack
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6.3.3 Playback Configuration Settings

Hot Keys are one of two types of audio events not played by the Audio Server module
(voicetrack editing is the other). The Playback tab allows you to select which playback
devices the Hot Keys will use. The Studio Client can use three playback devices for Hot Key
playback. You can either choose an independent device for each of the three selections, or
use the same device for all three.

By default, the left-most column of Hot Keys use Hotkey Playback Device #1, the middle
column uses Device #2, and the right column uses Device #3.

Configuration

Playback

Hatkey Playbac

| Defautt Ee vice

Hotkey Playback Device #2

|Nune

Hotkey Playback Device #3

None

B Play first hot button on device #1, second on #2 and third on #3

Figure 6-8. Playback Tab
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6.3.4 Voicetracking Configuration Settings

The Voicetracking tab allows you to configure voicetrack settings.

Configuration

Generalli [HEHEsI [IPIEVEEERIN Voicetracking IRGAHONYICHEN

Voicetrack Playback Device

Speakers (Parallels Audio Contr 57

Voicetrack Record Device

Microphene (Parallels Audio Con v

Auto Position Playback Cursor
Seconds Before Cut1 Seque

Load Voicetrack Cuts With NEXT Button
Compress Voicetracks

DONE CANCEL

Figure 6-9. Voicetracking Tab
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Table 6-10. Fields in the Voicetracking Tab

Field Description Default
Voicetrack Playback Device Playback device the Voicetrack Editor will use. See the tab
Voicetrack Record Device Record device the Voicetrack Editor will use. See the tab
Auto Position Playback Cursor Allows you to choose the default position of playback start. Checked
3
Cursor Restore Timeout Number of milliseconds before the cursor reappears after adjusting the start 1000
point of the voicetrack or Cut 2.
Fine Positioning Interval Number of milliseconds by which each track will be shifted when clicking the 100
advance or recede buttons.
Fine Position Button Repeat Allows you to enable a repeat function when holding the advance and pull- Checked
Mode back buttons and adjust the amount of time between each repeat. 100
Record Volume The Voicetrack Editor records at the full volume coming into the audio Unchecked
device being used. Use this field to set a specific record volume other than 100
100%.
Load Voicetrack Cuts With NEXT | Used with the voicetrack marker configured in the Import-Merge module’s Unchecked
Button Import Format settings. Importing voicetrack markers into your program log
simplifies voicetracking by allowing your talent to click the NEXT button in
the Voicetrack Editor to automatically move the Voicetrack Editor to the
position in the program log for which they need to record the next voicetrack.
Compress Voicetracks Check to have the system compress the audio. (Instead of using WAV, the Unchecked

system uses the method defined in the file server.)
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6.3.5 Audition/Cue Configuration Settings

If you use the audition/cue function, you can check the Audition check box and configure the
following settings.

Audition / Cue

Play Out Assigned Audio Server Channel

Table 6-11. Audition/Cue Tab
Table 6-12. Fields in the Audition/Cue Tab

Field Description Default

Countdown Segue « Checked = when auditioning the segue, the timer counts down to zero at Unchecked
the segue point, and then restarts the timer and count down through the
segue length.

» Unchecked = countdown clock counts down the length to the end of the

track.
Seconds After Intro / Prior To Starting point of the segue audition. With the default of 10 seconds, the 10
Segue segue audition starts its playback 10 seconds prior to the segue point. For

example, a segue point of 13 seconds before the end of a song plays the
last 23 seconds of your audio file.

Play Out Assigned Audio Server Plays the audition channel out of the audition device on the audio server Checked
Channel instead of the audition channel on the studio client.
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The Studio Client module has several operating modes that affect the playback of the
program log. You select an operating mode by clicking the left button in the tool bar, and
then clicking a button from the Pop-up menu.

ASSIST

DONE | DELETE | MOVE i‘ COPY |

Figure 6-1. Pop-up Menu for Selecting Operating Mod  es

Table 6-13. Operating Modes

Button

Mode

Description

Auto

Auto mode is the most widely used operating mode. In Auto mode, all cue types are
adhered to and full automation is possible.

ASSIST

Live Assist

Live Assist mode is used by live talent. Audio events load from the program log into
the Playback Deck Stack, but segues do not automatically execute, as they are in
Auto Mode. Events are played by clicking the Start/Start Next button, an individual
deck’s play button, a timed event, or they can be started by a closure (if configured).

OpX One can respect cues for breaks, so that your entire break can be played as if in
Auto mode. This allows your break to play in its entirety without stopping between
each break element/commercial/PSA if you configured Audio Server preferences to
do so.

MANUAL

Manual

In Manual mode, no items are automatically placed into the Playback Deck Stack.
Instead you click the individual Play button on the desired event in the program log.
While in Manual mode, no timed events or Auto Start cued events execute
automatically.

OpX One can respect cues for breaks, so that your entire break can be played as if in
Auto mode. This allows your break to play in its entirety without stopping between
each break element/commercial/PSA if you configured Audio Server preferences to
do so.
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Button

Mode

Description

VERIFY

Verify

After importing or creating a Program Log, verify your program log to be sure all the
events are valid to be played — that the audio files exist, and that the start and end
dates allow the events to be played:

1. Click the Mode button, and then click Verify from the Mode menu.

2. When the verification process ends, a window similar to the one in Figure 6-2
appears, with a list of all faults shown in your program log.

3. Go to the position of the errored item by clicking its listing in the error log.
4. When you finish with the report, click Done.

EDIT

Edit

Edit mode is the most common mode to enter when working in your production room
or on-air studio to add voicetracks and edit logs. It is the only mode you can enter in
the Studio Client that allows you to work with OpX One without directly affecting the
on-air playback of the Audio Server module for the station to which you are
connected.

Edit mode allows you to edit a program log other than the one currently being aired or
edit the on-air log without affecting the on-the-air playback. When you enter Edit
mode, a pop-up window prompts you to select the log you want to edit. Click the log
and commence your edits. When you finish, click the Options menu and click Save
Log.

Missing: 322

10:00:00
10:00:06
10:02:41
10:02:45
10:04:47
10:04:51
10:07:32
10:07:36
10:13:62
10:13:66
10:17:12
10:17:16
10:19:63

Inflatable T... OUT OF DATE Sun. Jul 8. ... |

606-12
2025
16162
2025
19749
202b
16018
202b
156947
2026
16798
2026

Out Of Date: 2

MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING

DONE

Figure 6-2. Example of Faults in the Program Log
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6.5 Verifying a Program Log

After you import or create a program log, verify your program log to be sure all the events
are valid to be played — that the audio files exist, and that the start and end dates allow the

events to be played.

> To verify a program log
1. Click the Mode button on the menu bar, and then click Verify .

At the end of the verification process, a window similar to the one in Figure 6-4 lists all
faults in your program log.
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AUTO

ASSIST

MANUAL

LS

Figure 6-3. Clicking Verify from the Mode Button

Missing: 322 Qut Of Date: 2

10:00:00 Inflatable T... OQUT OF DATE Sun. Jul 8. __.
10:00:06 606-12 MISSING
10:02:41 2025 MISSING
10:02:4b 16162 MISSING
10:04:47 2025 MISSING
10:04:51 19749 MISSING
10:07:32 2026 MISSING
10:07:36 15018 MISSING
10:13:62 2025 MISSING
10:13:66 16947 MISSING
10:17:12 2025 MISSING
10:17:16 16798 MISSING
10:19:63 2026 MISSING

!DONE|

Figure 6-4. Example of Errors in Program Log
2. Go to the position of the error by clicking its listing in the error log.

3. Click Done when you finish with the report.
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6.6 Loading a Program Log

> To load an existing log from the Studio Client modu le

1. Click the Options menu button on the menu bar, and then click Load Log (see Figure
6-5).

The Program Log window appears (see Figure 6-6).
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CONFIG

o

SAVE LOG

Figure 6-5. Clicking Load Log from the Options Menu
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Program Logs

TODAY TOMORROW

CALENDAR LIST

<March Wednesday April 13th

3 4 5
10 11 12
17 18 19 20 21 23

24 25 26 27 28 29 30

DONE CANCEL

Figure 6-6. Example of Errors in Program Log

2. Toload the log specified for today, tomorrow, or yesterday, as determined by the Audio
Server's Program Log Name Template setting, click the Today, Tomorrow , or
Yesterday button.

3. Toload a specific log by file name, click the desired program log in the Logs list.

4. When you finish, click the Done button.

6.7 Playing Back a Log

In Auto mode, loading a log executes the first event in the log automatically.

In Assist or Manual mode, perform the following procedure to play back a log. You can
also use this procedure to start playback at a specific point while in any mode.

> To play back a log
1. Click the event you want to play.
2. Click the Make Next button, and then click the Start or Start Next button.
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6.8 Editing a Program Log

You can use the Studio Client to edit the currently playing program log while in Auto, Live
Assist, or Manual mode. You can also use it to edit a log in Edit mode while the on air
program log is playing. The procedure for editing the program log (add events, remove
events, move events, or copy events) in any mode is the same.

6.8.1 Adding Events

> To add an event

1. Click the Insert button in the tool bar
The Insert Panel appears.

2. Find the event you want to add to your program log, and then click the Insert button on
the Insert panel. Do not click the Insert button on the tool bar.

The Insert button changes to Insert Where?
3. Click the location in the program log where you want to place your event.

The event is placed in the location you clicked and the item you clicked in the program
log and all items below it shift down.
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6.8.2 Removing an Event

« Note: A precautionary message does not appear before you remove an event.
Therefore, be sure you do not need an event before you remove it. You cannot
undo an event after it has been removed from the program list.

> To remove an existing event from your program log
1. Click the item to highlight it, and then click the Delete button in the tool bar

The item is removed from the program log.

6.8.3 Moving an Event

The following procedure describes how to move an existing event from one location to
another location in your program log (for example, how to move a song from before a break
to after a break, or switch the order of commercials in a break).

> To move an existing event from one location to anot her location in your program log
1. Click the item you want to move in the program log.

2. Click the Move button in the tool bar m
The Move button changes to Move Where? -
3. Click the location in your program log to where you want to move the event.

The event moves to the new location and the events between the old and new locations
shift to accommodate the move.

i Note: If you decide not to move an event after clicking the Move button, click
| g
the Move Where? button to cancel the move process
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6.8.4 Copying an Event

You can copy an event in your program log to another location. This procedure creates a
duplicate event at a different point in your program log.

> To copy an event
1. Click the event.
2. Click the Copy button
The Copy button changes to “Copy Where?™” -
3. Click the location in your program log where you want to place the copy of the event.

The duplicate event is added to the location where you clicked in the program log and
the event that was at that location, and all subsequent events, shift down.

<« Note: If you decide not to copy an event after clicking the Copy button, click the
Copy Where? button to cancel the copy process -

6.9 Using Hot Keys
Hot Keys are used for instant playback of events. The most common uses of the Hot Keys
are for sound effects, jingles, or weather beds for live shows.

Playing a Hot Key is as simple as clicking the Hot Key event button or touching the
desired event button if you use a touch screen.

Initially, there will be no events in your Hot Keys.

Figure 6-7. Clicking a Hot Key to Play an Event

6.9.1 Adding an Event to a Hot Key

> To add an event to a Hot Key

INSERT

1. Click the Insert button in the tool bar two times
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The Insert Panel opens.

Figure 6-8. Insert Panel
2. In the list of events, find the event you want to add to your Hot Key.
3. Click-and-drag the event from the Insert Panel event list and to the desired Hot Key.

The event is added to the Hot Key.

(Rock) Superstar[Clean Edit-no intro.]
Cypress Hill

347b-09

<4:15.3> /0.2 Wed, Jan 27, 10, 14:4%:32
(Rock) Superstar[Clean Edit]

Cypress Hill

348b-09

<414.0> /103 Wed. Jan 27. 10, 14:43:34 ¥

Tue.dan 26, 10, 13:22:38

INSERT REFRESH DONE

Figure 6-9. Example of Dragging an Eventto a Hot K ey
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6.9.2 Creating Rotating Hot Keys

If you add an event to a Hot Key that has an event associated with it, you are prompted by
one of the following windows, depending on how the Rotation On Hotkeys is configured
in the Studio Client’s configuration settings.

6.9.2.1 Rotation On Hotkeys is Enabled

> If Rotation On Hotkeys is enabled

1. You are prompted by a window similar to the following:

Page: 1 - Button: 14 - "Weather Bed”

L2

Add To Rotation

Replace All

Cancel

2. Perform one of the following steps:

— To add the event to the existing list of rotation events, click the Add To Rotation
button.

— To delete the existing list of rotation events and replace it with the newly added
event, click the Replace All button.

— To cancel the procedure, click the Cancel button.

6.9.2.2 Rotation On Hotkeys is Not Enabled

> If Rotation On Hotkeys is not enabled

1. You are prompted by a window similar to the following:
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Page: 1 - Button: 14 - "Weather Bed"

@

Overwrite?

2. Perform one of the following steps:
— To replace the existing event with the new one, click the Yes button.

— To keep the old event or cancel the procedure, click the No button.

6.9.3 Working with Hot Keys

When a Hot Key is set up as a Rotating Hot Key, the Hot Key button adds a caption to the
top-right corner that shows which event file will play next and the total number of events in
the rotation (see Figure 6-10).

2of3 Event list item

number caption
Random 1:00

Spot

L1700 .
Figure 6-10. Example of a Rotating Hot Key

> To view the list of events in the rotation
1. Right click the Hot Key, and then click List... .

An Event Rotation List window similar to the one in Figure 6-11 appears.
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Page: 1 - Button: 13 - "Random 1:00 Spot™ _in

| Mext To Play: #2

1 GC1745 |TASCA

GC1755 Certifie...

3 Guaranty - 1700 ..,

DONE CANCEL
|

Figure 6-11. Sample Event Rotation List Window

2. To select which event will be the next event to play, highlight the
event, or clicking the Up .or Dowm .button

3. To remove an event from the list, highlight it and click the Delete .
button

6.9.4 Setting Hot Key Properties

You can select the color of Hot Key buttons, the button’s caption, and which playback
device each Hot Key will use.

You can also configure a Hot Key to act as an “Insert” button rather than a playback
button. This feature allows you to insert a commonly used event into your program log
directly from the Hot Key panel.

> To configure Hot Key properties
1. Right-click the Hot Key whose properties you want to set.
2. From the pop-up menu, click Properties (see Figure 6-12).

The Properties dialog box appears (see Figure 6-13).
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___Laser Fire _ Lefter

Figure 6-12. Clicking Properties from the Pop-up Wi ndow

Random 1:00 Spot 1

Caption
Fandam 1:00°5pat

Color

Font
| T Avrial

Device

[l Insert Into Program Log

B Start Voicetrack Record

=

CANCEL |

Figure 6-13. Properties Dialog Box

3. Complete fields in the dialog box (see Table 6-14).

4. Click OK.
Table 6-14. Fields in the Properties Dialog Box
Field Description Default
Caption By default, your Hot Key shows the file name of the audio event you've File name of the
added. To change the caption, change the text in this field. audio event

Color Changes the background color of the Hot Key. Green
Font Changes the font style, size, and color. Arial
Picture Replaces the Hot Key caption text with a picture. Click the Browse button to —

select your picture. To remove a picture and return to showing the caption
text, click the Clear button.
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Field

Description

Default

Device

Hot Keys use the audio playback device associated with each column of Hot
Key buttons, as configured in the Studio Client's configuration settings. If
you want a Hot Key to use a different column’s playback device, select it
from this drop-down list.

Insert Into Program Log

Changes the operation of the Hot Key without affecting other Hot Keys in
your Hot Key Set. Enabling this option changes the behavior of the Hot Key
to act as an Insert key. This means that rather than playing an event, as a
normal Hot Key does, the Hot Key will allow you to insert the associated
event into your program log. When you click an Insert Hot Key, its caption
changes to Insert Where? You can then click a location in your program log
to insert the Hot Key's event. Use this as a quick shortcut for inserting a
commonly used event without having to use the Insert Panel. Insert Hot
Keys can be easily identified by the Insert tag added to the top corner of the
specific Hot Key (see the Weather Bed Hotkey in Figure 6.2)

Start Voicetrack Record

Enabling this option make a Hot Key to initiate voicetrack recording, enable
this option.
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6.10 Using Hot Key Pages

The previous sections described how to use individual Hot Keys. The following sections
describe how to use a Hot Key page.

6.10.1 Navigating Hot Key Pages

> To switching between Hot Key pages

1. Click the Next . or Previows . button.

The counter above the Refresr button indicates which Hot Key page is loaded

6.11 Saving the Hot Key Page to the File Server

The Hot Key page is saved to your local machine.
However, you can save a copy of it to the File Server.

> To save a Hot Key page to the fifile serve

1. Click the Save Page To Server button.

6.11.1 Loading a Hot Key Page fromthe File Server

> To load a previously saved Hot Key 2y page fn the fi  le

1. Click the Load Page From Serveer button.

6.11.2 Refreshing a Hot Key Page

> To refresh the cuurrently Ided Hot Key page
1. Click the Refresh button.
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6.12 Using the Voicetrack Editor

Voicetracking is the act of pre-recording voiceovers specific to the content of your program
log to give your listening audience the impression that your station has live talent on the air.
Users produce their voicetracks ahead of the scheduled air time of their program log. It is
common to find stations that appear to be staffed 24 hours a day because of content-specific
voiceovers that are, in reality, voice tracked by only a couple staff members. Each on-air
talent need only spend a couple hours a day recording their voicetracks for 4, 8, or more
hour shifts. Some talent can even record full shifts for multiple different stations using
voicetracking.

The following sections assume you created a program log and configured the Studio Client
settings with appropriate recording and playback audio devices for the Voicetrack Editor. If
you produce voicetracks on your on-air workstation, be sure the audio playback device you
configured for voicetracking does not go on.

6.12.1 Voicetrack Editor User Interface

The following figure shows the Voicetrack Editor user interface. The following sections
describe the Voicetrack Editor user interface. Table 6-15 describes the key user interface
components shown in Figure 6-14.

f WFMS - OpX - Broadcast Software International - o x

Log: WFMS041416 Air Date: 04/14/2016

VOICETR. 41157
"* 37619 41157
11409 41538
= 37601 4:15:38
F1031 4:19.00
"* 34394 4:19:00
VOICETR. 42238
" 37615 4:22:38
t 11491 4:26:04

" 32026 4:26:03

’ 12.4-VT160413213621_602_3

mv%f( - :L,_‘,‘j' m INSERT M
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Figure 6-14. Voicetrack Editor

Table 6-15. Key Components in the Voicetrack Editor

User Interface

Component

Component Name

Description

Start Point Shift Earlier
Button

Clicking Cut 2's Shift Earlier button shifts the start
time of the second audio file earlier as compared to
the end of Cut 1. Clicking voicetrack’s Shift Earlier
button shifts the start time of the voicetrack and the
Cut 2 audio file earlier.

Go To Cut 1 Button

If you venture elsewhere in the program log while
creating voicetracks, clicking this button scrolls the
program log display to the Cut 1 audio file loaded in
the Voicetrack Editor.

Cut1

The dark green bar represents the first cut of the
segue between which you are inserting your
voicetrack. The light green section shows the Artist
and Title data from the audio file. The dark green
section represents the segue portion of the cut and
displays that length.

12.4-VvT160413213621_602_3

Voicetrack

The middle yellow bar represents the voicetrack that
has been recorded. This bar does not appear until
you record your voicetrack, and its width depends on
the length of the file recorded. The bar shows the
length and filename automatically given to the file.
The voicetrack start position can be shifted by
clicking on the left or right side of the yellow bar
(great for touchscreen users).

Cut2

The lower green bar represents the second cut of the
segue that you are inserting your voicetrack
between. The light green section shows the Artist
and Title data from the audio file. The dark green
section represents the intro portion of the cut and
displays that length. Cut 2's start position can be
shifted by clicking on the left or right side of the
green bar (great for touchscreen users).

ON

Channel Mute Buttons

To temporarily mute audio cuts, click the
corresponding Channel Mute buttons. The button’s
text shows ON when a channel is unmuted or OFF
when it is muted.

ON

Start Point Shift Later
Buttons

Clicking Cut 2's Shift Later button shifts the start time
of the second audio file later as compared to the end
of Cut 1. Clicking Voicetrack’s Shift Later button
shifts the start time of the voicetrack and the Cut 2
audio file later.
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Component

Component Name

Description

Ducking Level Adjust
Buttons & Ducking
Level Display

Each track, Cut 1, voicetrack, and Cut 2, have
adjustment buttons for their ducking levels. Each cut
automatically ducks its volume to the percentage
chosen while the voicetrack is actively playing.

 PLAY
AL

Play All Button

Click this button to preview the full voicetrack,
including the ducking levels set, the segue of Cut 1,
and the intro of Cut 2 as currently set.

Stop Button

This button is active only while playback or recording
is taking place. Click this button to stop playback
after clicking the Play All button or to stop recording
when creating a Voicetrack.

Voice Track Button

This button is used when creating your voicetrack.
During the creation process this button is used
multiple times and acquires different functions as the
voice frack is recorded:

1. Click to start playback of Cut 1. The button caption
changes to RECORD.

2. When Cut 1 is playing, clicking the button a
second time starts recording from your microphone
and the button caption changes to PLAY CUT2.

3. Clicking once more sets the start point of Cut 2.

4. Click the STOP button to stop recording from your
microphone.

Load Button Click this button to load the audio event you've
highlighted in the Program Log Display into the Cut 1
and the subsequent event into Cut 2.

Align Button To quickly reset the start position of the recorded

voicetrack and Cut 2 to the segue point of Cut 1,
click this button.

INSERT

Insert Button

After you finish creating and editing your voicetrack,
click this button to insert the voicetrack into your
program log.

Time Scale Display

The length of time selected here determines the
length of time represented by the full width of the
Voicetrack Editor graphic display.

Done Button

When you finish creating or editing voicetracks, click
this button to exit the Voicetrack Editor.
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6.12.2 Creating Voicetracks

You can perform voicetracking in any mode (Auto, Live Assist, and Manual); more often than
not, however, you will perform voicetracking in Edit mode. The Studio Client is set up so that
you can edit the voicetracks for the program log loaded on your screen. This means you can
edit voicetracks in the currently playing program log while you are in Auto, Live Assist, or
Manual mode, or you can edit a completely separate program log from the on-air content
using the Studio Client’s Edit mode.

> To access the Voicetrack Editor
1. Click the Options button in the menu bar.
2. Click the Voice Track button in the pop- up menu.

The Studio Client displays the Voicetrack Editor at the bottom of the user interface (see
Figure 6-14 on page 162).

6.12.3 Loading Audio Events into the Voicetrack Edi  tor

You can load any audio events into the Voicetrack Editor, whether they are music, talk, or
other audio content.

> To load events into the Voicetrack Editor

1. Highlight the first of the two adjacent tracks in the program log event list between which
you want to insert your voicetrack (see Figure 6-15).

Eyws Adored You

Vel Fronka

apy Wy Girl

= Ny Guy

i Wy Sweel Lord

i My World Ix Emply Without =2 WG-AT 1Z3E 0N e g =

Figure 6-15. Highlighting a Track After which a Voi  cetrack will be Placed

2. Click the Load button in the lower left corner of the Voicetrack Editor (see Figure 6-16).

Page 164 of 390



Studio Client Module

Your two audio events are loaded as Cut 1 and Cut 2 in the Voicetrack Editor, as in
Figure 6-14 on page 162.

Figure 6-16. Clicking the Load Button

6.12.4 Recording a Voicetrack

After you load your audio events into the Voicetrack Editor using the previous procedure,
you can record your voicetrack. Recording the voicetrack involves multiple presses of a

single button to simplify recording your voicetrack.

» To record a voicetrack

1. Click the Voice Track button (see Figure 6-17).

Playback of Cut 1 begins and the button toggles to Record . As playback progresses, a
vertical line moves from left to right to show the progress through the playback of your

audio event (see Figure 6-14 on page 162).

Figure 6-17. Clicking the Voice Track Button

g. As Cut 1 plays, click the Record button at the point you want to start recording from
your microphone (see Figure 6-18).
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Figure 6-18. Clicking the Record Button

h. As the voicetrack is being recorded, a yellow bar appears on the track display. The
yellow bar, as shown in Figure 6-19 represents the playback position and length of
your recorded voicetrack.

My Eyes Adored Yo

u
Walli, Frankie :

Figure 6-19. Yellow Bar Representing Recorded Audio

2. To set the start point of Cut 2, click the Play Cut 2 button (see Figure 6-20).

o |
oo | 0 [P R o [ D

cur2z k ALL

Figure 6-20. Clicking the Play Cut 2 Button

3. To end the recording progress, click the Stop button (see Figure 6-21).
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‘ 130-VTi00713130112 lJ

glliannanaRnan
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Figure 6-21. Clicking the STOP Button

You have now recorded a voicetrack. To preview it, go to section 6.12.5.

6.12.5 Previewing Your Voicetrack

After you use the procedure in the previous section to record your voicetrack, you can
preview your voicetrack.

> To hear a preview of your voicetrack

1. Click the Play All button (see Figure 6-22).

‘ 13.0-VT100713130112

Figure 6-22. Clicking the Play All Button

2. To stop playback, click the Stop button.

6.12.6 Adjusting Segue/Start Points

After you preview your voicetrack, you can adjust the start points of the voicetrack audio or
Cut 2 if they are not to your liking.

> To adjust segue/start points

1. Click the segue or start point, and then drag it to the desired location.
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¢ Note: You can also use the Align button to adjust segues and start points
automatically or use the arrow buttons to adjust segues and start points manually.

6.12.7 Adjusting Ducking Levels

The term “ducking” means: to turn down a portion of overlapping audio to de-emphasize one
part (the ducked audio track) and emphasize another (the non-ducked audio track).

You can perform ducking with the Voicetrack Editor independently for each portion of the
voicetrack. The ducking effect for all tracks occurs while the voicetrack audio portion is
playing. This means that if you set a ducking level on Cut 1, it will not be turned down — or
ducked — until the voicetrack audio starts. When ducking is set on Cut 2, it will not return to
its normal, non- ducking level until the end of the voicetrack audio is reached.

The voicetrack itself has a ducking level. Since all ducking occurs while the voicetrack audio
is playing, this setting is useful for adjusting the overall volume of the voicetrack.

¢ Note: Normally, you should not have to adjust ducking levels. Instead, use the
voice track level setting in the Studio Client to set the level at which the voice track
is played back and use the ducking level setting in the Audio Server songs to set
the level at which songs are ducked.

> To adjust the ducking level of Cut 1, the voicetrac  k, or Cut 2

1. Click the Ducking Level Adjustment buttons next to the Ducking Level Display (see Figure
3-1) to adjust in 5% volume increments.

The Ducking Level Adjust Up  button increases the volume of the corresponding track,
up to a maximum of 100% of the audio file’s actual recorded volume. The Ducking
Level Adjust Down button decreases the volume of the corresponding track while the
voicetrack is playing. You can adjust this a minimum of 5% of its original volume.
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Figure 6-23. Ducking Level Adjustment Buttons with Current Ducking level Set to 90%

6.12.8 Inserting Your Completed Voicetrack into the Program Log

After you create and edit your voicetrack, you can insert tor completed voicetrack into the
program log.

> To insert the ccompleted vicetrack into the program log

1. Click the Insert button.

The voicetrack audio fife are saved to the OpX One Audio Server and inserted into the
program log directly below the currently highlighted item in the program log.

¢ Note: If you inadvertently highlight an item other than the audio event that
loaded into the Voicetrack Editor's Cut 1 position, confirm that the Voicetrack
Editor's Cut 1 event is the same event highlighted in the program log before you
click the Voicetrack Editor Insert button so that you are inserting your
voicetrack into the proper location.
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My Eyes Adored You dd 5 —
Salll, Frankie 12:23:54

12:27:11

12:29:54

12:832:41

12:38:11
2:28.2

12:40:40 120138 ﬁ
Knight, Gil: 4182

‘
{ " pLar | 5

Flgure 6-24. Cllcklng Insert

6.12.9 Customizing the Studio Client Appearance

Since most users of OpX One will spend hours a day using the Studio Client, OpX One
allows you to create custom themes (or “skins”) to enhance your experience using the
Studio Client.

> To change the skin options
1. Click the Options button on the main menu bar, and then click Config .
The Studio Client’s Configuration window appears.

2. Click the Skin Options button in the lower right corner of the General tab on the
Configuration window (see Figure 6-25).

The Skin Options window appears (see Figure 6-26). The top section of the Skin Options
window has buttons for each skin option you can customize.
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5“"‘ CpXSkinCptions
DOptions Ry

CANCEL |

Figure 6-25. Clicking the Skin Options Button

Music ltem

Audio ltem Error Item Comment tem

Cart em

Restore " Save Current
Defaults. | | | | Az

CANCEL

Figure 6-26. Skin Options Window

3. Click a button in the top section.

The Skin Item Option dialog box appears (see Figure 6-27).
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Skin Itern Option - Top Deck

Starting Color

Ending Color

.

Figure 6-27. Skin Item Option Dialog Box

4. Use this window to edit the skin option as desired (see Table 6-16).

Table 6-16. Fields in the Skin Item Option Dialog B ox (Top Section)

Field Description Default
Gradient Most skin items are displayed with a gradient (fading between two colors). Top To Bottom
This drop-down list allows you to choose the format of the gradient.
Starting Color Click the color block to select the top color for your gradient. —
Ending Color Click this color block to select the ending color for the gradient —
Font Click the Caption button to display the Font Selection dialog box (see Figure —

6-28). Select the font, style, size, and color for your skin option.
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EEE——— 20|
Fortt: Font style:
Microsoft Sans Seri Bald
a| |Regular

Modem ttalic
(} Monotype Carsiva
() M5 Outlook 25 Bold Italic
(} M5 Reference Sans 5
() MS Reference Speciat

MS Sare Serf hd
~Eects ——————— [ Sample
I” Strikeout
™ Undedine
Color;
C_JWhite +| | Scopt:

IWestem _'r_l

Figure 6-28. Font Selection Dialog Box

5. Use the buttons in the middle section of the Skin Item Option dialog box as appropriate
(see Table 6-17).

Table 6-17. Buttons in the Skin Item Option Dialog Box (Middle Section)

Field Click This Button to...
Restore Defaults Restore all default colors and fonts for your skin.
Load Load a previously saved Skin ltem Option Profile.
Save Current As Save your current skin options as a new skin options profile.

6. When you finish, click the appropriate button at the bottom of the Skin Item Option dialog
box (see Table 6-18).

Table 6-18. Buttons in the Skin Item Option Dialog Box (Bottom Section)

Field Click This Button to...
Done Apply any changes you made and close the Skin Item Option dialog box.
Apply Save the changes you made and leave the Skin Item Option dialog box open for you to make

further refinements to your skin’s settings.

Cancel Close the Skin Item Option dialog box and discard all changes you made since you opened the
Skin Item Option dialog box or clicked the Apply button.
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7 File Manager Module

Topics: This chapter describes the OpX One File Manager

_ _ module.
4 Starting the File Manager

Module (page 175) The File Manager module shows the files each

station has available. It also allows you to transfer

your audio files from your production machines

4 Configuring the File Manager into the OpX One File Server, generate reports,
Module (page 181) and create carts. When you create audio files to

put on the air, you use the File Manager module to

transfer those audio files into the File Server.

4 Quick Tour (page 176)

4 Transferring Files (page 183)
4 Working with carts (page 187)

4« Editing Local Audio File
Tagging Info (page 193)

4« Editing Audio Tagging Info
on the File Server (page 196)

4 Generating and Viewing
Automation Reports (page
197)

« Note: Although you can put audio files directly into the File Server using disks,
flash drives, and mapped network drives, we recommend you use the File
Manager to perform these tasks. This is because the File Manager
communicates directly with the File Server module to notify it of newly added
files. Not using the File Manager to copy files delays the recognition of audio files
that you add.

Q Tip: Because the File Manager module does not use mapped drives to
communicate with the File Server module, mapped drives are not necessary with
the OpX One system. Without mapped drives on the PC running OpX One, you'll
have greatly enhanced network security.
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7.1 Starting the File Manager Module

You must start the File Server module before you start the File Manager module.

> To start the File Manager module

1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > OpX One

File Manager .

An OpX One File Manager window similar to the following appears.

# OpX File Manager N =10 x|
File Edit About
My Computer - ALEX™ Server - “OPX-FILESERVER"
2] 2l x| = o a| vl 2l X # = 3 &l Bl
© Oldies =] @ OPXFILESERVER
P - WBSI - BSI SAT Station

Name | iees V) T‘b it il él g WBSIRECORD - WBSI Aux Audio Server (BACKGROUND RECORDS)
[J 6424-05.... Tue,May5, ... I've GotA Flrush On... Stewart, Rod Due =@ WOPX - The Best Rock!

[J 615-20.w... Tue,May5, ... ThenHeKissedMe  Crystals _I & Spots

[ 619-09.w... Tue, May5, ... Worlds Apart Cole, Jude &= News

[J 625-06.w... Tue, May5, ... Helter Skelter Beatles ﬂ = Records

[J 80517.w... Tue,May5, ... This| Promise You[R... ‘N Sync = Music

O 912-04.w... Tue, May5, ... | Wish It Would Rain ... Coliins, Phil ) Program Logs

O 914-02w... Tue, May5, ... The LastWorthless ... Henley, Don = RunLogs

[0 916-07.w... Tue, May5, ... Time After Time Lauper, Cyndi él = Carts

[ 907-13.w... Tue,May5, ... The Flame Cheap Trick ) Voicetracks

O 901-02.w... Tue,May5, ... At This Moment Vera, Billy & The . {= Configuration

[ 90317.w... Tue, May5, ... TruelEdit] Spandau Ballet D Temporary

[J 907-02.w... Tue, May5, ... The Heart Of The M... Henley, Don © Irpaglng .

O 61301.w... Tue,May5,... Revolution Beatles 2 Fil Maleria

[ 585-02.w... Tue, May5, ... Money Beatles ’{? Lllners

[0 58514.w... Tue, May5, ... Mercy Mercy Me (Th... Gaye, Marvin “; dingles

O] 587-14.w... Tue, May5, ... Ciy Like A Baby Box Tops = ;"’:“ o

[J 582-17.w... Tue, May5, ... Eleanor Rigby Beatles 11; O::Iiesevh:u::ce'

[J 580-10.w... Tue, May5, ... San Francisco (Be S... McKenzie, Scott :g Sound Effects

[ 580-12.w... Tue, May5, ... Tum! Tum! Tum! Byrds @ wiue

[0 582-16.w... Tue,May5, ... TheWreck Of The E... Lightfoot, Gordon ‘ WJDH

[ 592-04.w... Tue,May5, ... South City Midnight L... Doobie Brothers

[J 603-07.w... Tue,May5, ... In The Midnight Hour  Pickett, Wilson

[ 603-20.w... Tue, May5, ... Working My Way Ba... Four Seasons_l_VJI

< | »
501 Items [ I

[
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7.2 Quick Tour

The following sections provide a quick tour of the File Manager module interface.

—loix
o —ee@ Ele_Edt fbout
My Computer - ALEX™ Server - “OPX-FILESERVER”
228l X = o | ¥l 2l x| 5 = 3 & Bl
3 Oldies ~ @ OPXFILESERVER
- - @@ WBSI - BSI SAT Station
Name e v [ = ] ] gWBSIRECDRD-WBSIAuxAudloSewer (BACKGROUND RECORDS)
0 6424.05... Tue,May5,... I'veGotACrushOn... Stewart, Rod Due = @ WOPK.- The Best Rock!
O 615-20.w... Tue,May5, .. ThenHeKissedMe  Ciystals J & Spots
0 613:09.w... Tue MayS5. ... Worlds Apart Cole, Jude &= News
) 62506.w... Tue, May5, .. Heker Skeker Bealles ﬂ &= Records
0 80517.w... Tue.May5. .. This|Promise YoulR... 'N Sync Music
(O 912-04.w... Tue, May5, ... | Wish It Would Rain ... Colins, Phil Program Logs
o (0 914.02w... Tue,May5, ... The LastWorthless .. Henley, Don Run Logs
O 916-07.w... Tue,May5, ... Time After Time Lauper, Cyndi @ Carts
0 907-13w... Tue,May5, ... The Flame Cheap Trick Voicetracks
(O 901-02.w... Tue,MayS5. ... At This Moment Vera, Billy & The . ® Configuation
O 90317.w... Tue,May5, ... TruelEdit] Spandau Balet Temporary
0 907-02w... Tue,May5,... The Heart Of The M... Henley, Don Imaging
O 61301.w... Tue, May5, ... Revolution Bealles FllMalosol
O3 58502 Tue, May5, .. Money Beatles i
) 585-14.w... Tue, Map5, ... Mercy Mercy Me (Th... Gaye, Marvin P"‘“”
O 587-14w... Tue,May5,... CryLike A Baby Box Tops S N
5 My New Folder
(0 582-17.w... Tue,May$5,... Eleanor Rigby Beatles Oldies Music
) 580-10.w... Tue,May5, .. SanFrancisco (Be S... McKenzie, Scolt = Sound Effects
0 580-12w... Tue,May5, ... Tum! Tum! Tum! Byrds = @ WJUB
0] 582-16.w... Tue, May5.... The Wheck Of The E... Lightfoot, Gordon @@ WJIDH
(0 532-04.w... Tue,May5, ... South City Midnight L... Doobie Brothers
0 603-07.w... Tue,May5, .. In The Midnight Hour ~ Pickett, Wilson
0 603-20.w... Tue,MayS5, ... Working My Way Ba... Four Seasons le
< | »
501 Items | 1

[ /

Number Description

Menu bar. See section 7.2.1.

Local file list See section 7.2.2.

Transfer buttons. See section 7.2.4.

Server file list. See section 7.2.3.

Page 176 of 390



File Manager Module

7.2.1 File Manager Module Menu Bar

The menu bar appears at the top of the File Manager window. The following sections
describe the menus on the menu bar.

7.2.1.1 File Menu

Exit = exits the File Manager Module.

Edit About

Exit Ctrl+Q

7.2.1.2 Edit Menu

Settings = inserts items manually into the
File About currently loaded program log. See section 7.3.

Setti .
sngs Define Reports = allows you to create report

Define Reports... templates. See section 7.8.1.

7.2.1.3 About Menu

Opens a window that shows the version and
File Edit [About| build date of the File Manager module you are
running. This window also shows the amount
of memory and virtual memory being used,
and the amount of time that the File Manager
module has been running. See Figure 7-1 for
an example. To close the window, click OK.
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" About - OpX File Manager

v0.0.0.135

Build Crate:
Aug 152014 08:47:.09

b emom Usage:
23932k, / 23932k

Wi zage:
16,01 2K A 16.048K

Figure 7-1. Example of About Information

7.2.2 Local File List

The local file list allows you to browse through the drives and folders on your local computer.
Use this list to browse the audio files you want to transfer to your OpX One File Server.

The local file list has several icons at the top of the list. Table 7-1 describes these icons.

The local file list also contains a location drop-down list. Clicking this drop-down list shows a
list of your drives and the folder you are currently viewing. In Figure 7-2, the Spots folder
appears at the top of the drop-down list because it is the folder currently displayed.

Table 7-1. Local File List Icons

Icon Icon Name Description
Parent Folder To display the contents of the folder one level above (that is, the parent folder), click this
button.
Refresh To get the most up-to-date list offiles on the local hard drive, click this button to refresh the
list offiles.
Delete To delete the files selected in thelocal file list, click this button. Files are deleted

permanently, so exercise care when deleting files.

Info Tags Click this button to open a pop-up window forediting common audio file tags. This feature
can be thought of as a trimmed down (or “light”) version of the Info Editmodule.

Record When you need to record a file ASAP while using the File Manager module, click this
button to open a pop-up window with a simple record deck.

© 1 | Bl | 1=
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) Spots El
My Documents -
3 My Computer
& 34 Floppy (&)
& System [C) =
<@ Local Disk (D)

()
3 DVDRL3Drive [E2)
Control Panel v

Figure 7-2. Example of Location Drop-Down List

7.2.3 Server File List

To browse the folders for each configured station on your File Server, use the server file list.
The server file list has two display modes:

- Directory Tree mode. You use this mode while browsing the available stations and their
subfolders. When you double-click a station’s folder, the server file list switches to File
List mode, so you can see the files in the station’s folders. Figure 7-3 shows an example
of Directory Tree mode, with the station’s directory tree expanded to show its subfolders.

- File List mode. You use this mode when you are inside a folder.
Server - “OPX-FILESERVER"

8] 2l 2l ) o o) 3 i

U OPXFILESERVER
+ P WBSI - BSI SAT Station
+ @ WBSIRECORD - WBS! Aux Audio Server (BACKGROUND RECORDS)
= @ WOPX - The Best Rock!
Spots
News
Recoeds
Musc

Figure 7-3. Example of Directory Tree Mode

The server file list contains icons across the top of the list of files. Table 7-2 describes these
icons.
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Table 7-2. Server File List Icons

Icon Icon Name Description
E I Station View Returns the file list to the ‘top level’, showingall the stations available.
- Filter To filter the types of files shown in the server file list, click this button.
1]
= Refresh To get the most up-to-date list offiles on the File Server, click this button to refresh the list
L) I offiles.
Delete To delete the files selected in the server file list, click this button. Files are deleted
XI permanently, so exercise care when deleting files.
2 Info Tags Click this button to open a pop-up window forediting common audio file tags. This feature
J‘ I can be thought of as a trimmed down (or “light”) version of the Info Editmodule.
"I Find To search for a file by name, click this button,
) Find Next After using the Find button to find an item, clickthis button to find the next file using the
4 same searchcriteria.
X Check For To have OpX One search for files with the same name in other folders for the station you
ml Duplicates are managing, click this button.
m New Cart To create a new cart, click this button. When prompted, enter a name for your cart and
- click the OK button. When the Cart Editor window appears, drag items from the Server's
file list on the right side of the File Manager window into the Cart's Event List in the cart
editor. The new cart will be saved into the Carts folder of the current station’s profile.

7.2.4 Transfer Buttons

After you find the audio file you want to transfer and the location to where you
want to transfer it, click the appropriate transfer button to copy your file.

The button with the arrow pointing to the right ﬁl transfers the file
selected in the Local File List to the location selected in the server file
list.

The button with the arrow pointing to the left §| copies the file selected in

L.
L

the Server File List to the location selected in the local file list.

To copy a file from your local drive to your File Server and add it to a cart at
the same time, click the Transfer File To Canrt @] button. You are prompted

to enter the name of the cart to which you want to add the file.

@

<« Note: The arrows will be gray if the All folder is selected. Choose an actual

station within a folder.
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7.3 Configuring the File Manager Module

The File Manager module comes with default configuration settings that should suit most
users. Using the Settings option on the Edit menu, you can change these settings to suit
your requirements.

> To configure the File Manager module settings
1. On the Edit menu, click Settings .
The Settings dialog box appears.

Settings X
Network Interface
[10.1.1.10- 0pX ~|
1 10
Default Folder
IC: \Users\build-pc\Documents 2"'[
Default Station
I =
Playback Device
IDefauIt Device _ﬂ
Record Device
IDefauIt Device LI
Sample Rate
44,100 Hz ~|
Local Save Options
ISave Tags To Local File Only Z|
Sort Column Sort Direction
IModified E_l IDescending E]
¢ OK | X Cancel I

2. Complete the fields in the dialog box (see Table 7-3).
3. Click OK.
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Table 7-3. Fields in the Settings Dialog Box

Field

Description

Default

Network interface

A read-only field that shows the IP address to which the OpX One File
Server module is connected.

See the dialog box

File Server Address

« Checked = enter an IP address of the File Server module to which the
File Manager will connect.

« Unchecked = shows the IP address of the server to which the File
Manager is connected.

Checked

Use Alternate FTP Port

Leave at its default setting.

Checked

Default Folder

Allows you to set a specific ‘home’ folder that the File Manager displays
automatically in the local file list when the File Manager opens initially.

See the dialog box

Default Station

Allows you to select the station that appears when you open the File Server.
You can still switch to other stations at will. However, if you spend most of
your time working on one of your stations, selecting that station here can
save you time.

Playback Device

Select an audio device that the File Manager uses to preview audio files.
The default setting means that the File Manager will use the same audio
device Microsoft Windows selected when previewing audio.

Default Device

Record Device

Select the device the File Manager uses to record audio with its record deck.
The default setting means that the File Manager will use the same audio
device Microsoft Windows selected as the recording device.

Default Device

Sample Rate

Select the audio sample rate for recording and playback of audio using the
File Manager.

44.100 MHz

Local Save Options

Select how the Edit Tags function saves changes to the tags of audio files.

Save Tags To Local
File Only

Sort Column

Select how files are ordered in the local file list and the server file list.
Choices are:

« Name

« Modified (date)
- Title

« Artist

« Length

« Start Date

« End Date

Modified

Sort Direction

Select whether files listed in the local file list and the server file list are
ordered in ascending order (0-9, A-Z) or descending order (9-0, Z-A).

Descending
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7.4 Transferring Files

You can use the File Manager to transfer files to and from your File Server.

7.4.1 Copying Files to Your File Server

> To copy files to your file server

1. Using the Local File List on the left side of the File Manager, browse to the desired
audio file on your local hard drive.

) Spots v
"} My Documents A

g My Computer
5 3% Floppy (&)

<@ System [C:)
& Local Disk [D:)

=)
@ DVD-Rl3Drive [E:)

Control Panel v

2. Check each audio file you want to transfer.

L] 6432.wavy Thu, May 19, ...
OJ 6309.wav Thu, May 19, ... TSUNAM

6263.wav Thu, May 19, ...
5513 wavy  Thu, May 19, ... AUDITIO
O 5513e.wav Thu, May19,... 33

3. Click the plus [*l button to expand the list of folders for the station to which you
want to copy your audio files.
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—_— -

FIEET

% @ WKKD K100

g WLOR - 1470 The Ticket
- WRON - 935 Rock & Rol Oldi

o W (WART, N o T ]

(ﬁ Note: You can choose a valid file (44.1khz 16 bit Windows PCM wave) only. If
there is no check box to select the cut, double-check the format and sample rate.

4. Click the subfolder of the station to display its contents.

—t | —aa | - | ~i J J

@ OPXFS-01
=@ WKKO -K-100

1| g

5. Click the right-pointing File Transfer button to start copying.

~| (= WKKO - Spots
}utisl l | Name I Moc
;AFEWAY & é O Inflatable ... Thu
yUDAFED < [ B718 Mor
CATUCD DCTD F . LM n=2ra L4

6. If the File Manager finds files with the same name on the server, a message asks
whether you want to keep or overwrite the file. Click Yes (or Yes to All in the case of
multiple files) to overwrite or No to not overwrite.
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coniem Y
9 ) Overwrite File?
-

| | [ 6332 TIOM, Tar 3

7.4.2 Copying Files from Your File Server

> To copy files from your file server

1. Using the Server File List on the right side of the File Manager, browse to the desired
audio file.

U OPXFS-0

=@ WKKO -K-100

,_| 3 Spots
{Clagiews

- ]

2. Check each audio file you want to transfer.
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LJ QL1743 ... ™Mon, Mar 31, ...
[J 5513e Mon, Mar 31, ... 33
5513d Mon, Mar 31, ... 2

Mon, Mar 31, ...
M gA2R hdawn hd ar 21 N2

3. Using the Location drop down on the Local File List , click the drive to which you
want like to copy the files.

< Local Disk (D:) v
Q Desktop
') My Documents
“d My Computer
a 3% Floppy (&) =
& System (C:)
@

£) DVD-RW D(iv&E:]
Control Panel v

|»

4. Browse to the folder to where you want to transfer the server’s file.

Upx

way spots
%falk Shows

SkimmerPlus

Cucaulus Eoioona

5. Click the left-pointing File Transfer button to start copying.

p— | P SN

= I Name | Modified
atible Arm Flailing Tube é [0 EMERAL... Mon, Ma
AE JINGLE SERVICE) [0 GC1743 ... Mon, Ma

O 5513e Mon, Ma
JE JINGLE SERVICE) @ 5513d Mon, Ma

[J FORRES... Mon, Ma

AC_LAMCILE crnviacre) | PPV

6. If the File Manager finds files with the same name on the server, a message asks
whether you want to keep or overwrite the file. Click Yes (or Yes to All in the case of
multiple files) to overwrite or No not to overwrite.

Page 186 of 390



File Manager Module

X
\t)) Overwrite File?
-

..........................

Yes | No | Yes to all |

.........................

7. When the transfer completes, click the Done button.

7.5 Working with carts

7.5.1 Creating a New Cart

> To create a new cart
1. Atthe top of the File Server List, click the New Cart button

The Cart Name dialog box appears.

2. Enter a new name for your cart, and then click the OK button.
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X

Cart Name
IMy New Cart

¢ 0K X Cancel |

The Cart Editor dialog box appears.

WOPX - Carts - "My New Cart" L

Artist / Advertiser

Title # Description

Length: (HH:MM:SS)
|no;00;00 jl

Name | Atist | Title il

x|

< I i3 il
[ save | X concel | I

. Complete the fields in the dialog box (see Table 7-4).

. To add items to the cart editor’s event list, find items in your station’s audio folders in the
File Manager’s server file list and drag and drop them into the cart editor’s event list.

. After you have events in your cart’s event list, you can edit an event’s tag info by clicking
the Edit Tags ﬁl button.

. To remove events from the cart’'s event list, click the ﬁl Delete button.

. To set the next-to-play item in the cart, highlight the desired event in the cart’s event list
and click the Make Next il button.

. When you finish creating your cart, click Save.
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Table 7-4. Fields in the Cart Editor Dialog Box

Field Description Default
Artist/Advertiser Enter an artist or advertiser that describes the contents of your cart. —
Title/Description Enter a title or description about the contents of your cart. —
Length Enter an average length of the items that will be in your cart. 00:00:00

7.5.2 Using the Cart Editor to Edit a Cart

Using the Cart Editor, you can edit the contents of an existing cart, including adding new

files, removing events from the event list, or modifying the Artist/Advertiser and

Title/Description tags.
> To edit a cart
1. Browse to your desired cart file in the server file list.

2. Right-click the cart file, and then click Edit Tags .

0 My l;art Edit Tags
O Oldies Songs

Name | Modified ¥ | Title
é My New Cart fidd To Cart Cart Descriptig

Cancel - Esc

a_l

The Cart Editor window appears.
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WOPX - Carts - "My New Cart"

Artist / Advertiser
IAdveltiser Name
Title / Description
|Calt Description
Length: (HH:MM:SS)
|00;01 00 =

Name | Adtist | Title al
= 5513 BEN-ONE HO.. INTRODUCT | —
5513c BENJAMIN FRA... #2 L[5
5513b BEN -ONE HO.. INTRODUCT _; —
e ocprssiirnt ;l_' =

X Cancel

3. Edit the files as desired

4. When you finish, click Save.

7.5.3 Adding Local Files Directly to Carts

> To add local files directly to carts

1. Inthe local file list (the left list in the File Manager), highlight the audio file you want to
add to a cart on the file server.

A check mark appears next to the item.

ey e I g

) Spots LI
Name A | Modifed | Title | Artist 4|
[J EMERAL... Mon,Jun 8, 09... Better Than Fair Emrald Pool & Pati

FORRES... Mon,Jun 8, 09... County Fair Forrest Paint
O GS...A Mon, Jun 8, 03... BARTER (PREML... RELPAX
50... Mon,Jun 8, 09... BARTER (PREMI... QUICK BOOKS

2. On the server file list (the right list in the File Manager), browse to the folder where you
want to store the actual audio file (not the location of the cart).

Page 190 of 390



File Manager Module

T WLJT T U ST Jaaan

@ WBSIRECORD - WBSI Aux Audio Server (BACKGROUNL
= WOPX - The Best Rock!

i Spots

i Newg
i Reco

= Music

3. Click the Add To Cart button.

| [J FORREST PA...
.. [0 EMERALD P...
‘dl... QUICK BOOKS O e718
il... SUDAFED 0O 6473
hl... SUDAFED O e7s0
ALPINE BANK P..
ALPINE BANK P [l I - 6624
The Cart Names dialog box appears.
X
WBSI - BSI SAT Station |
WBSIRECORD - WBS! Aux .. |
WOPX - The Best Rock! {My Cart Name

KJUB - All Justin's music, allt.. |
KJDH - AllJohnny's music, all.. |

§§CooyToAl| [ Vo | X concel |

4. Enter the name of the carts to which you want to add audio files.

If you selected a shared folder, the Cart Name dialog in Figure 7-4 appears. Otherwise,
the Cart Name dialog box in Figure 7-5 appears.
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Cart Names L x|

WBS| - BS| 54T Station |

WRSIRECORD - WBS| Aux . |

\WOP - The Best Bock! |M_I,J Cart Name

KIUB - Al dustin's musie, all . |

KIDH - Al Jahing's music, &ll . |

= Copy ToAl | ok | XF—HHG%T'|

Figure 7-4. Cart Name When Selecting a Shared Folde r

x

Cart Name
IMy New Cart

v ok N X cancel |

\M

Figure 7-5. Cart Name When Selecting a Non-shared F  older
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7.6 Editing Local Audio File Tagging Info

> To edit local audio file tagging info

1. Right-click an audio file in the local file list (left side in the File Manager), and then click
Edit Tags from the pop-up menu.

117-11.w..

fBreaker Warwick, Dic
our Eyes Only Easton, Shee
Dnce Jones, Quinc,

A Tag Editor dialog box similar to the following appears.

On The Street Where You Live - Robert Goulet 8

From start Length From end
Ej Copy Info | Paste Info 2585

Title / Description
|0n The Street Where You Live

Adist / Advertiser
[Robert Goulet

Name
IRobert Goulet - On the Street Where You Live - My Fair Lac

OutCue
IMy Fair Lady [Original Soundtr

1SCI Code
I Q Play QL @Ot Right @ [15sec
Intro Segue

Start Date & Time (24 hr.)

77 |l o £ pdA
End Date & Time (24 hr) Play - F2, Stop - F3, Pause - F4,

Set Intro- F7, Set Segue - F8,
77 B 5| Zoom Left - F10, Zoom Out - F11. Zoom Right - F12

Command To Run At Start

™ No Fade At Segue TRIM I
I Protect Intro Of Next kem ‘ |C°"““a“d i S

Command To Run At End

 Save | X Cancel |

2. Complete the fields in the dialog box (see Table 7-5).
3. When you finish, click Save.
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Table 7-5. Fields in the Tag Editor Dialog Box

Field

Description

Copy Info button

Click this button to copy the current tags to the Windows' Clipboard.

Paste Info button

Click this button to paste the current tags from the Windows’ Clipboard.

Title/Description Enter a title or description about the contents of your cart.

Artist/Advertiser Enter an artist or advertiser that describes the contents of your cart.

Name Name of the file in the system. Edit the name if desired.

OutCue Enter the words at the end of a vocal or commercial so they know when it is time to talk.
ISCI Code Enter Industry Standard Coding Identification (ISCI) code if applicable.

Start Date & Time Date and time when a commercial is to start running.

End Date & Time

Date and time when a commercial is to stop running.

No Fade at Segue

As a file plays, the system applies a fade when the file hits a segue point. If a song has a fade at
the end, check this check box unchecked to avoid applying a second fade.

Protect Intro Of Next Item

Controls overlap between items. For example, if an item has a long segue and is followed by
another item that has a short intro, checking this check box protects the intro of the second item. In
this example, if you uncheck the check box, the segue point of the first item would trail over the
vocals of the next item. Typically, you would check this box for items that end with long segues.

TRIM button Click this button to remove silence from the beginning and end of the item.

RESAMPLE button If an item has a sample rate that is different from the other items in your audio library, click this
button to resample the audio for consistency with your other items.

From start Read-only field that shows the amount of time from the start of the item.

Length Read-only field that shows the duration of the item.

From end Read-only field that shows the amount of time to the end of the item.

Waveform Shows the waveform of the currently playing item. You can click in the waveform, and then use the
lightning bolt icon to set intro and segue points in the waveform.

Play button Click this button to play the file. You can also play the file by pressing the F2 key on your
keyboard.

Stop button Click this button to stop the file. You can also stop the file by pressing the F3 key on your

keyboard.

Pause button

Click this button to pause playing. You can also pause playing by pressing the F4 key on your
keyboard.

Left button Click this button to zoom into the left of the waveform. You can also zoom to the left by pressing
the F10 key on your keyboard.

Out button Click this button to zoom out to the normal waveform view. You can also zoom out by pressing the
F11 key on your keyboard.

Right button Click this button to zoom into the right of the waveform. You can also zoom in to the right by

pressing the F12 key on your keyboard.

Zoom Dropdown

Sets the zoom view time period.

Intro

Length of the item’s intro.

Segue

Length of the item’s segue.
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Field Description
Command To Run At Start Allows you to run a macro command as soon as the audio starts playing.
Command To Run At Segue Allows you to run a macro command when the audio start segue point is reached. For example,

you might want to run a macro that triggers an external Emergency Alert System (EAS) device
after running an EAS message.

Command To Run At End Allows you to run a macro command when the audio end point is reached.
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7.7 Editing Audio Tagging Info on the File Server

> To edit audio tagging info on the file server

1. Right-click an audio file in the file server list (right side in the File Manager), and then click
Edit Tags from the pop-up menu.

Il Be[Radio Edit] McCain, E
od Must Have ... ‘N Sync
Colors[Radio... Collins, Phil
>Kiss[Radio V... Hill, Faith
nestly Love ... Newton-Joh
ntimental G, Kenny
=tits Both Ways Estefan, Glv

980-01

An Tag Editor dialog box similar to the following appears.

WBSI - Music - "CCR - Bad Moon Riosing-Front Channels" (3]

Title / Description

Artist / Advertiser

Name
Il:ﬁl: R - Bad Moon Riosing-Front Channels

OutCue

Start Date & Time (24 hr.)

el - e

End Date & Time (24 hr.)

I 'y EII : 2, I'_g, I~ No Fade 4t Segue

™ Protect Intro Of Next Item
 Save | X Cancel I

2. Complete the fields in the dialog box (see Table 7-5 on page 194).
3. When you finish, click Save.
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7.8 Generating and Viewing Automation Reports

Automation system reports are an important and indispensable feature used by general
managers and traffic managers. They are most commonly used to verify aired spots and
promos to ensure your customer spots are getting aired in accordance with your promise
to your customers. In addition, many traffic and billing software packages use automation
reports to create affidavits and automatically verify spots and insert “make goods” for your
station(s) later program logs.

OpX One’s report generating facilities allow you to create report templates to include or
ignore data types of your choosing. The following sections describe how to create a report
template and run areport.

7.8.1 Creating a Report Template

Report templates in OpX One define the information that will be added to a report when a
report is run. Defining a template involves selecting the types of data you want the report to
show and selecting a format for your report. Table 7-6 describes the data types you can
include in your report.

Table 7-6. Report Data Types

Data Type Description

Spots Events playing from a folder, with its Contents type set to “Spots” and all events inserted into the
program log by importing a trafficlog.

Skipped Spots Spot events skipped over because of timed events or time syncs, but not errored.

Music Events playing from a folder, with its Contents type set to “Music” and all events inserted into the
program log by importing a music log.

Skipped Music Music events skipped because of timed events or time syncs, but not errored.

Carts Any cart played will record this data type.

Other Audio Anything event stored in a folder, with its contents type set to “Audio” will record this data type
when played.

Errors Events attempted to be played that cannot play because the item does not exist, is in an incorrect
format, or a playback device is not available will record this data type.

Warnings Started a new sat show while one was already running.

Infos Internal system tasks, such as getting files from the server or updating program logs, or uploading
run logs, and so on.

Closures Any time a trigger device receives a closure, it will record that event with this data type.

Inserts When an item is inserted into the program log, a record of this occurrence is recorded with this
data type.

Deletes If a user deletes an item from the program log, this data type keeps record of that occurring.

Stops Clicking the Stop button of a deck will report this datatype.
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Data Type Description
Macros Executing a macro by a playback deck will record this datatype.
Time Events Any event that has a set time — including music, spots, or macros — that have a cue type of Time
Immediate or Time Next. Includes any event added to the Scheduled Events.

OpX One automation reports can be generated in ASCII text formats, with either a position-
dependent or delimited format. Column order and position are user configurable.

> To create an automation report template

1. On the Edit menu, click Define Reports .

& OpX File Manager

File | Edit About

Settings

Define Reports...

My Co

The Reports dialog box appears.

x
q’}Newl HUEdi l ¥ Del |
Name | Description
MYREPORT My Report
AS-RUN As-Run Daily Report

2. From this dialog box, you can:
— Define a new report: Click the New button.
— Edit a report: Highlight the report from the list, and then click the Edit button.
— Delete a report: Highlight the report from the list, and then click the Delete button.
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If you clicked New or Edit, the Report Settings dialog box appears.

x

Nome | Cortert | Fommat | Posion |

|\4'|NEV.'RE PORT

Descrpton
[u, New Report Template

[V ] X coce|

3. For a new report, enter a short name in the Name field and enter a description in the
Description field. Click the Content tab.

4. On the Content tab, select the types of data want to include in your report. The example
in the figure below includes events that did not play, which is useful for determining your
“make-goods.” To limit your report to show only data pertaining to a single file name, or
several particular file names, use the Single Name or Multiple Names section to
configure file name filters.

eeporseinss x
Name Content |Fotmd| Position |

Include In Report 5

Csoos W E

[_] Skipped Spots I'_ Will match any part of the

[J Music name field.

[[] Skipped Musi 3

0 Calr?spe — [~ Prompt For Name Each Time The Report Is Run

[[] Other Audio

(] Erors

) Wamings 1 Multiple Names

[ Infos

b E:g:::':s il Will match any

[ Deletes | paoll e

£ Stops 3¢ | field.

] Macros

[] Time Events

[] Records

ok | X cancel |

5. Check the types of content to include.

6. After you select all the data types you want to include, click the Format tab.
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. The Format tab allows you to select the output format of your report. Two formats are
available:

— Position Dependent — select this format to read your report directly or if the
application you want to import the report into asks for this data type.

— Delimited — select this format if the application you want to import specifies this
format or allows you to make your own choice. Setup for this format is easier than
position dependent.

, x

Name | Content Format IPosilion]

(+ Position Dependent

¢ Delimited
Delimiting Character [1

0K I X Cancel |

— If you selected Position Dependent, click the Position tab. The following dialog box
appears, except that a new report template has zeros for all the Start and Length
settings. The Start and Length settings depend on what you are importing the data
into. If you are going to view the report directly without importing your data into
another application, the settings in the following figure will work for most cases.
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Report Settings ] x|

Name | Content | Fomat Position l

Start Length
Status i
AcualTime [3 8
SchedTime [12  [8
Duaton [22  [8
w2
Description IF IF
Twe  foe 8
Foder  [34 [0

& OK | XCancell

— If you selected Delimited, enter the delimiting character into the Delimiting
Character field on the Format tab (most applications use the | symbol). Click the
Position tab. A tab similar to the one below appears, except that a new report
template has zeros for all the Position settings. The Position settings determine the
order each field will be added to the report.

Report Settings ] x|

Name | Content | Fomat Position |

Position

For the delimited format enter the position
Status I1 number for each of the field or 0 to not include
A Tre Iz—' the field.
. For example, a Start Time position of 4 will
Sched Tine [3 place the time in the forth position.
{ Id
WL The positions should be either 0, or a number
Name |5 from 1 to 6.
Description IS
Type I?
Folder IB

VoK | X cancel |

8. After completing the Report Settings dialog box, click OK.
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7.8.2 Running a Report

The following procedure describes how to run a report. This procedure assumes you created

a report template (see section 7.8.1).

> To run a report using an automation report template

1. Browse through the station folder tree on the right side of the File Manager module to find

you created

the Run Logs folder for your desired station, and then click it.

The right-side of the window switches to Report Viewer mode.

|
Lo
-

H| 7] &2l X T = 3] W 9]
@ OPX-FILESERVER
@ WBSI - BSI SAT Station
W WBSIRECORD - WBSI Aux Audio Server (BACKGROUND RECOF
=@ WOPX - The Best Rock!
= Spots
T News
= Records
= Music
= Program Logs

= RunL

=y Carts

=) Voicetra
= Configuratio

2. Select the month and date that the report will cover.

|

1 i s e T |

(= WOFX - Run Logs

[

May 10, 2010

& &

Mon I Tue I Wed | Thu | Fri Sat Sun

Report
| MYREPORT My Report

Run Report Unt May 10, 2010

3. Using the Report Template drop-down list, select a report template.
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4. Click the Run Report On button.

The report is generated and automatically opens in your default .txt viewing application
(typically Windows Notepad).
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A

Starting the Clock Builder
Module (page 205)

Quick Tour (page 207)

Configuring the Clock
Builder Module (page
215)

Creating a New Clock
(page 216)

Sample Clocks (page
240)

8 Clock Builder Module

This chapter describes the OpX One Clock Builder
module. This module creates clock templates.

Many stations require the ability to rebroadcast satellite
originated shows. These shows include signals
(closures) to tell automation systems such as OpX One
when the show starts, stops, and when to play ID’s,
liners, and breaks.

Unlike other automation systems, OpX One uses a Clock
Builder to determine how to work with your satellite
broadcasts. Not only does the Clock Builder offer a
visually familiar method of configuration, it offers an
intuitive and quick method to add or modify shows,
schedule satellite breaks, and more in a visual, easy-to-
understand way.

With the multitude of station formats, some stations will
have all their content originate from files stored on their
local hard drive (such as with “music—from—hard—
drive” stations), while other stations will have a
combination of local from-hard-drive content and satellite
rebroadcasts. The extreme case is a station that gets all
of its content from satellite, as in Figure 8-1 on page 206.
The OpX One Clock Builder module allows easy
handling of these situations without requiring you to
memorize or look up special commands to enter. The
result is simplified setup and modification of your
station’s format.
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8.1 Starting the Clock Builder Module

Before you set up clocks or schedule breaks:

- Configure the OpX One Audio Server because clock setup depends on the configuration
of your Audio Server. See Chapter 4 for information about setting up your OpX One
Audio Server.

«  Confirm that the following parts of OpX One are configured:
— Your switcher device, so OpX One can switch between sources automatically
— Your closure device, so OpX One can respond to network triggers

— A mixer in your OpX One Audio Server, so OpX One can control the volume of your
source

- Connect and configure your hardware, including your trigger device, any switcher, and
your OpX One Mixers. See Chapter 4.

After you perform these tasks, start the Clock Builder module.

» To start the Clock Builder module

1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > Clock
Builder .

You are prompted to select a station.

Select a Station

Stations

3. Using the Stations drop-down list, click a station.

4. Click OK.
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The OpX One Clock Builder module is populated with the information from the selected
station.

Fle Edi About

L 3| | I | [wNAM - 1280 AM - Ameiica's Best ¥

9 pm

11 pm

PH { AUTO [1 Selected |

Figure 8-1. Example of Clock Builder Module
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8.2 Quick Tour

The following sections provide a quick tour of the Clock Builder module interface.

& Clock Builder - WBSI - BSI SAT Station

@ L) [ |.9 55:-'| WBSI - BSI SAT Station

Menu bar. See section 8.2.1.

Tool bar and station selector. See section 8.2.2.

Grid display. See section 8.2.3.

Status bar. See section 8.2.4.




8.2.1 Menu Bar

Clock Builder Module

The menu bar appears at the top of the Clock Builder window. The following sections

describe the menu options.

8.2.1.1 File Menu

File Edit About
Exit Ctrl+Q

1

8.2.1.2 Edit Menu

File | Edit About
& Edit Ctrl+E

(% List Satellite Shows...
B Show Alternates

Settings...

8.2.1.3 About Menu

File Edit |About|

Exit = exits the Clock Builder module.

Edit = opens the Clock Editor for the
highlighted clock on the grid display.

Cut = removes the highlighted clock from the
grid display and copies it to the Windows’
Clipboard.

Copy = copies to the Windows’ Clipboard the
highlighted clock on the grid display.

Paste = pastes a cut or copied clock from the
Windows’ Clipboard over the currently
highlighted clock on the grid display.

List Satellite Shows = shows all Satellite
Show Start events in a list or tree view
window.

Show Alternates = switches the current
grid display view to show alternate clocks
instead of Monday-Sunday clocks.

Settings = configures Clock Builder module
settings. See section 8.3.

Opens a window that shows the version and
build date of the Clock Builder module you are
running. This window also shows the amount
of memory and virtual memory being used,
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and the amount of time that the Clock Builder
module has been running See Figure 8-2 for
an example. To close the window, click OK.

v0.0.0.123

Build Date:
Oct 23 2013 07:53:09

Memory Usage:
18,848K / 18,848K

VM Usage:
11,888K /12,116K

Figure 8-2. Example of About Information
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8.2.2 Tool Bar and Station Selector

The tool bar and station selector appear below the menu bar. Table 8-1describes the tools
on the tool bar.

& (O X|C2

| WOPX - The Best Rock! ~]

Figure 8-3. Log Name and Station Selector

Table 8-1. Clock Builder Tool Bar and Station Selec  tor
Tool Tool Description Tool Tool Name Description
Name
Edit Clock | Opens the Clock List Satellite Shows Shows all satellite show
f Editor for the start events in a list or tree
‘ﬁ highlighted hour C}? viewwindow.
on the grid
dsplay.
Copy Copies the Show Alternates Switches the grid display
1 highlighted hour current view to show
L‘j ' in the grid display @’ alternate clocks instead of
to the Windows’ ~— the Monday-Sunday clocks.
Clipboard.

Paste Pastes a copied Station Selector Switches between stations
= ' clock from the drop-down list on your OpX One system
J Clipboard to the to view and edit the clock

highlighted hour sets foreach.
in the grid display
and replaces any
existing clock
settings.
Delete Removes all clock

x settings from the

currently l _ LI
' highlghted clock WOPX - The Best Rock!

on the grid
display.
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8.2.3 Grid Display

The grid display is a spread-sheet style diagram of the clocks you create for each hour of
each day of the week.

« The x-axis (horizontal) has columns for each day of the week or, while in the Show
Alternates view, the columns are for each alternate day.

« The y- axis (vertical) has rows for each hour of the day.

To edit a clock, double-click the clock block in the grid display to open that time period’s
clock in the Clock Editor.

v

Sat

Mon Tue Wed

PEEREE

BBEE

Figure 8-4. Sample Grid Display

8.2.4 Status Bar

The status bar shows the title of the currently highlighted clock. If you have multiple items
selected (by shift-clicking or ctrl-clicking), the status bar also shows the number of items
selected.

PH { AT 1 Selected

Figure 8-5. Status Bar

Page 211 of 390



8.2.5 Navigating the Clock Editor Window
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The Clock Editor has its own tool bar and description bar for creating and modifying clocks.

© Monday 1 am

Q—=«a$H |4

© ——————ougion [Lane

57585901 2 5

- i x|
" (2L \
] L_] /‘(
Color: | Yellow 'I
| | Time | Type | Category| Detais \
5@ 0000 StatSat. MACRO SATSHOW START,ABCNEWS ®+
» 0500 Commerc.. MACRO MANDATORY NOFADES0NOPLAYIFEMPTY
0500 StopSat. MACRO SATSHOW STOP,ABCNEWS +
0600 StatSat. MACRD SATSHOW START,LAURA
1900  Commerc.. MACRO MANDATORY.NOFADE 50NOPLAYIFEMPTY [ — 0
3200 Commerc.. MACRO MANDATORY.NOFADE 50 NOPLAYIFEMPTY
47.00  Commerc.. MACRO MANDATORY.NOFADE 50NOPLAYIFEMPTY
5750  Commerc.. MACRO MANDATORY.NOFADE.50NOPLAYIFEMPTY
5353  StopSat. MACRO SATSHOW STOP, LAURA
Sk | Kcace | B awy |
2

Number

Description

Tool bar. See section 8.2.5.1.

Description bar. See section 8.2.5.2.

Clock display. See section 8.2.5.3.

Event List. See section 8.2.5.4.

8.2.5.1 Clock Editor Window Tool Bar

The Clock Editor tool bar contains icons for performing the tasks described in
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Table 8-2.

Figure 8-6. Clock Editor Toolbar
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Table 8-2. Clock Editor Tool Bar

Tool Tool Name Description Tool Tool Name Description
New Satellite Opens the Satellite Edit Event Edits an event that has
p Show Show editor to create a r been added to your
Q new satellite show start \ﬁ clock.
event. —
Start Existing Creates a new satellite Copy Copies the highlighted
Satellite Show show start event from a 1 event to the Windows’
@D previously created L‘j Clipboard.
satellite show item. ——
Stop Satellite Returns the automation Paste Pastes a copied event
Show system to local audio = from the Clipboard to
Q playback or stops the _] the highlighted event in
satellite audio. your event list.
New Commercial Adds commercial breaks Delete Removes an event that
Break to your clock. you added to your
$ x clock.
New Event Creates new non-stopset
events such as audio
& events, macros, or
— comments.

8.2.5.2 Clock Editor Window Description Bar

The Description Bar contains the Description field and the Color drop-down list. The text
you type into the Description field and the color you select from the Color drop-down list
allow you to name and color your clock’s block on the grid display for easy identification in
the Clock Builder. Figure 8-1 on page 206 shows an example of a grid display that has
descriptions and colors selected for each clock.

Dezcription: |0 Laurie

Calor; I C1Yelow j

Figure 8-7. Description Bar

8.2.5.3 Clock Display

The clock display provides a visual representation of the events
you add to the event list.

- Green “pie wedges” represent breaks.

- Thin black radius lines represent satellite show start, satellite
show stop, and custom events.
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Tme Type Category  Detals
@ 0000 SwntSa MACRO SATSHOW START, ABGNEWS +
i @ 0500 Commerc.. MACRO MANDATORY NOFADE SONOPL
8.2.5.4 Event List Sy B e e rsowesat oo T BE
. 0@ 1600 Event COMM . Time Sync
The event list shows all the events your clock $ 1900  Commec. MACRO  MANDATORY.NOFADE SONOPL
. . 0@ 000 Even COMM . Teme Sync
will perform. To shuffle an event up or down in $ 00 Conmec. MACRO  MANDATORY.NOFADE SONOFL
. . . . . @ &S Eve COMM Teve Syrc
the list, highlight the desired event and click the $ 200 Commwc. MACRO MANOATORYNOFADESONOPL
Up or Down icon in the top-right corner of the BT B Ol IR NCERONTHONCEINOL
event list.
8.3 Configuring the Clock Builder Module
The Clock Builder module
comgs W|th defaqlt Settings @
configuration settings that
should suit most users. Using | E
. . . 10.1.1.10 - 0pX
the Settings option on the Edit =
menu, you can change these
settings to suit your
9 Y 1 10

requirements.

v

To configure the Clock
Builder module settings

Clock Builder Module

[~ Force Default Mixer In Live Satellite Shows

v 0K X Cancel I
1. On the Edit menu, click
Settings .
The Settings dialog box appears.
2. Complete the fields in the dialog box (see Table 8-3).
3. Click OK.
Table 8-3. Fields in the Settings Dialog Box
Field Description Default
Network Interface Read-only field that shows the IP address to which the OpX One network 10.1.1.10 - OpX
interface is connected One
File Server Address « Checked = use the FTP server IP address. Enter the IP address in the Unchecked
dotted-decimal field.
« Unchecked = do not use the FTP server IP address.
Force Default Mixer In Live Check this check box to have the system pick the first mixer configured on Unchecked
Satellite Shows the New Satellite Show dialog box.
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8.4 Creating a New Clock

To set up your satellite clocks, open the OpX One Clock Builder module. You will be
prompted to select which station you would like to work on (see Figure 9.3). Figure 9.2
shows the initial screen you will see when opening the Clock Builder. It is a grid
representation with columns for each day and rows for each hour of the day. The grid will be
empty until clocks are added. Figure 9.1 shows what a Clock Builder grid looks like when
fully populated with clocks

8 am
» To create a new clock

. . 9 am
1. Inthe Clock Editor, double-click the hour block for
the hour/day on which you want to create the clock. 10 am
The Clock Editor appears for the hour you 11 am
selected. M
nnn
2. In the Description field, ) Mondsiy2 am
enter a title for this clock. QEGE SH LB X
3. If desired, select a color for | Desipion | oo [MMNew <] £ oo
the clock’s hour-block in the i

Clock Builder grid display
for easy identification.

4. The most common satellite
rebroadcast clock consists
of the following events:

— A command to put your
satellite show on the air
(a satellite show start
event), which controls
your audio switching
and I/O hardware.

. %
£2) 2
3332 3130292827

" OK X Carcel | & “pel | |

— Commercial break periods, where OpX One is to replace network spots with your
local content (a commercial break event).

— A command to turn off the satellite show and return the automation system to local
audio (a satellite show stop event) or another satellite show.

To put your satellite show on the air, OpX One must know how to start your satellite
show-what inputs to turn on, what triggers to use, and how to behave. Leave the Clock
Builder open and see the following sections for procedures about performing these tasks.
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8.4.1 Creating a New Satellite Show Start Event

You create a new satellite show start event using the New Satellite Show dialog box. This
dialog box presents a number of pages containing configuration settings. To see examples

of completed clocks, see section 8.5.
& Monday 9 am
=y | |y =y, T
> To create a new satellite start event IE\_:'!:.-' g "IE L "4 ‘ ;& d
Hhl

1. Click the New Satellite Show icon.

D escrphar; I

The New Satellite Show dialog e @
box appears.
l:.f:\.'l Enter the cue. time, name and description of the
= szatellite show. This is the cue time of the show.
Later pages will allow start by time or closure if
applicable.
2. Complete the fields in the dialog Lue
box (see | Time Immediate (2] |
3 Time - bk:55
! onoo =+
4,
M arme
Dezcription
5. Table 8-4). & 0K % Cancel ‘

Page 217 of 390



Clock Builder Module

Table 8-4. Page 1 Fields in the New Satellite Show  Settings Dialog Box

Field Description Default
Cue Under most circumstances, select Time Immediate [@]. Time Immediate [@}
Time Select start time of your satellite show. For shows that start at the top of the 00:00

hour, select 00:00.

Name Enter a short name for your show. —
Description Enter a name that will be added to the list of created satellite shows. —
6. Click Next.

The second page appears in the New Satellite Show dialog box.
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New Satellite Show

I:'?.-' Enter the talent and tppe of the zatellite show.
=

[v Live
[ Tme Shift [ Wirtual Closures Only |

I Record

] Mot Applicable _.J
File M ame

I kd

[~ Trim File After Recard

[ Share 'With Other Stations [ Upload To File Server

=1 Back Mext =

o 0K X Caricel ‘

7. Complete the fields in the dialog box (see

8. Table 8-5).

Table 8-5. Page 2 Fields in the New Satellite Show  Settings Dialog Box

Field Description Default
Live Check this check box to go to the satellite feed playing at that time. Checked
Time Shift Check this box to play back a previously recorded show. Unchecked
Record If you want to record a satellite show at a time other than when the Unchecked
show is being broadcast, check this check. The file will then be
recorded at the time you specified in the previous dialog box.
Record Deck Select one of the four record decks in the system. Not Applicable
File Name Enter the name you want to assign to the recorded file. —
Trim File After Record Check this check box to remove the silence from the recorded file. Unchecked
Share With Other Stations Check this check box to upload the recorded file to the File Server, Unchecked
so the file can be shared with other stations.
9. Click Next.

The third page appears in the New Satellite Show dialog box.
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[ New Sstellite Show

l-.’”:'} Select the closure device, start of stop-set
= - clozure. switching and mixer.

Clozure Device
| 1ot 4
Start Commercial Break: Clozure Delay 1/10 Sec
[ Mot spplizable ~|| 0 [%]

[ Commercial Breslls FloakPazi T he Top GOF TheHo

I Sofornabcally Bl Sommercial Break s

Switching
Device | |nput | Dutput | M| MO __C.E:_
i |
x|
b iser
| Mat & pplicable _'j

_ ek | Nest =

o 0K X Caricel I

g

10. Complete the fields in the dialog box (see

11. Table 8-6).

Table 8-6. Page 3 Fields in the New Satellite Show  Settings Dialog Box

Field Description Default
Closure Device Select your closure hardware device. Not Applicable
Start Commercial Break Closure Select your local break trigger. Not Applicable
Delay Adds a delay to the commercial break closure. 0
Commercial Breaks Float Past Causes OpX One to look ahead in your clock each time a break start Unchecked
The Top Of The Hour trigger is received.
« Checked = if more break closures are received and there are no
more breaks in your clock (for example, all expected breaks have
been played), the closure is ignored.
» Unchecked = use this setting if you set up multi-hour satellite shows
that only have a satellite show start event in the first hour's clock.
Automatically Fill Commercial « Checked = OpX One automatically fills breaks that are not filled with Checked
Breaks content from your traffic software.
« Unchecked = OpX One does not automatically fill breaks.
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Field

Description

Default

Switching

Add profiles to determine the routing of audio-switching devices for this
satellite show. If you do not have any audio routing/switching hardware,
leave this field empty.

« Click the Add Switcher Routing button _é‘]il to add a profile.

« Click the Delete Switcher Routing button % | 0 remove the
highlighted device from the list.

Mixer

Determines what input/output of your audio card(s) are unmuted at the
start of your satellite show, muted during breaks, and muted at the end
of your show. For configurations with an audio switcher, connect your
audio switcher’s output to an input on your soundcard and set up the
audio switcher as a mixer in your audio server configuration. For
configurations without an audio switcher, connect your satellite’s output
directly to the audio card’s input and configure the audio card as a mixer
in your audio server’s settings. For information about setting up OpX
One’s mixers, see Chapter 4.

Not Applicable

Fade Up At Start Of Show

Check this check box to have the mixer adjust the volume control up at
the start of the show.

Checked

Fade Down At Start Of Show

Check this check box to have the mixer adjust the volume control down
at the end of the show.

Checked

12. Click Next.

The fourth page appears in the New Satellite Show dialog box.

New Satellite Show

’T‘J. Select the method to start the satellite show. If
= neither are selected, the show wall start asz it 12
encountered in the log.

T Start By Time

(1T Start By Closure -

Mot &ipplicabls ~]

an,.—_‘ =

[T}
£n
[}

=1 Back

13. Complete the fields in the dialog box (see Table 8-7).
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Table 8-7. Page 4 Fields in the New Satellite Show  Settings Dialog Box

show that has a floating start, this option allows you to join when the
satellite receiver sends a closure. By default, the closure selected is
“listened to” for the full hour, but you can limit the active window by
setting the Active Start and Active End fields

Field Description Default
Start By Time Allows you to delay the start of your satellite show until a time of your Unchecked
choosing. Like an offset, if you set your satellite show event to start at
the top of the hour and set this option to 5:00, your satellite show will
not start until 5:00 minutes after. This option is not used in most
circumstances.
Start By Closure Allows you to start your satellite show by closure. If you air a satellite Not Applicable

Active Start — SS:MM

Start time when this event will be active.

00:00

Active End - SS:MM

End time when this event will no longer be active.

59:59

14. Click Next.

The fourth page appears in the New Satellite Show dialog box.

New Satellite Show
('H:T.' Add audio items fired by closures.

=

Clozure Event

x[s e

=1 Back Mext =

J Ok x Caricel ‘
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15. Select audio files or carts to be played when specific closures are received from your
satellite receiver via closure hardware connected to your OpX One Audio Server. This
function is useful for station ID closures or “magic calls.” If you do not need to handle
these types of events, click Next to continue to the next page and go to the next step.

To add a new event, click the Add il button. When the Closure Event dialog box

appears, complete the fields in the dialog box (see

16. Table 8-8).

Closure Event
D ezcripticn

Clazure
i Mot &pplicable LJ

Active Start - Mi:55 Active End - kk:55

(0000 =+ GORY; . et
Audio Macros

Mame. | Description

% [+ |+

* Each audio itemn will run in rotation

[~ FadkiSateliteTo [0 [3¢] ercenthie Playing cudi

x Cancel |

Table 8-8. Fields in the Closure Event Dialog Box

Field Description

Default

Description Enter a description for your closure event.

Closure Select your incoming closure that will fire your event.

Not Applicable

Active Start — SS:MM Start time when this event will be active.

00:00

Active End - SS:MM End time when this event will no longer be active.

59:59
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Field

Description

Default

Name/Description

Add a new event by clicking the Add il button. Drag and drop your
audio files from the File Library to the Audio list, as shown in Figure 8-8.
You can add multiple items audio list if want multiple items to all play
consecutively each time the closure event is triggered. For rotator
behavior, create a cart of items and add it to the closure event.

Fade Satellite To

» Checked = forces the main satellite feed to duck under your Closure

Unchecked

Event rather than mute the satellite feed.

Closurebvent x|  EEEE———— £

2 Farnd
b | In Tl
[qu: Cal
Faldaty
Close JaLL =
||:Fﬁ:|.l= 13 _‘J
I5T e
Aciive Starl - MM 55 ictive End < MM SS | Tia | Azt | Mame | Langth [=]
= l | Toe Apr 22 2008 22086, Herdne Focod Hendu, (5250
o = e Tue &p¢ 29 20089 2206 . Herdie Aecod Hendi D053 50
Ak Tue dipe 29 2008 2306 . D, Lawa Recond Crleu  DOS25S
e Twrid Turd Tunl Byds a2 00230
Mame. Descoplion 1 e Tinst Ard S ot by Bt 17146 D002
WESI Mage Call  WESI Magiz Cal - lex H Tvnst Ard Shout Eealler 14502 000230
LS { Urehained Wetody Fighienus Biothe: 18510
Wacky Wisnvg Inftabibl . Wosske Waving Infistl . Inllats

x|

7 Fade Satelite To 25 5] Eencart Whie Playing fexdo

| o OK | xl:mull

I W Can Work It Du
ilad g 23 20 190 Do Laswa Record Dir L
Wed dpe 23 2008 220 Herdie Flecod Hesncki
Wed A 30 2008 150 Dy Lawa Recod Dir Lass
Wedadpr 30 2008 220 Herdne Aecod Hesudei
Swlow, T vohame
i Worswolves OF Londor  Wanien Zavon 57908

WES! 16 Secord Stali

o o o el L

_ e |

Alen B WSl

Bealles 43212

i

Figure 8-8. Dragging and Dropping Audio Files
X

@ Add audio items fied by closures.

You can add multiple closure events, where
each one handles the events for a single
closure during a specified time period. In the
figure below, two closure events are created:
one to handle a “magic call” closure event
and the other to handle a floating station ID
closure event.

To edit a closure event, click it in the closure
event list and click the Edit ﬁl button. To
delete a closure event, click it in the closure
list and click the Delete x| button.

Closure Event
Station 1D
Magc Call

= Back

[ x|+

Next <>

[[ Vo | % concel
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17. After you create, edit, or delete
closure events, click the Next
button to go to the next page.

The fifth page appears in the New
Satellite Show dialog box. These
settings determine how your
satellite program will be
stopped.

18. Complete the fields in the dialog

[ New Satellite Show

11'#:\,.' Select the method to stop the zatellite show.
e

T Stop By Closure

I Mat Applicable _J
oo:on = 5359 =
I Stop By Length

00:0man =

box (see .
IF neither stop by closure nor stop after a specified length
19. of time apply. then satellite shows must be stopped by
inserting a Stop Existing Satellite Show event.
20.
=1 Back Mext =
21. Table 8-9). % Cancel I
Table 8-9. Page 5 Fields in the New Satellite Show  Settings Dialog Box
Field Description Default
Stop On Closure Ends your satellite show when a specific closure is received during the Not Applicable
time period you select from the Active Start to the Active End fields.
Active Start - MM:SS Start time when this satellite show will be active. 00:00
Active End - MM:SS End time when this satellite show will no longer be active. 59:59
Stop By Length Runs your satellite show for the specified length. The time you select is Unchecked
a count-down time. For example, if you select 00:45:00 and your
satellite show starts at six minutes after the hour, your satellite show
ends at 56 minutes past the hour.
« Note: Many situations dictate that neither of the above satellite show stop

methods be used. Commonly, a clock uses a separate satellite show stop
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event at the end of the clock, without using the options available on this
page (see section 0).

Q Tip: There are ways to stop a satellite show in a clock:

« Stopping a show by a closure received from your satellite receiver.
« Stopping a show by a specific length.

« Stopping a show by the starting of another show (either within the same
clock, or a subsequent hour’s clock).

« Stopping a show by adding a satellite show stop event.

Click Next.

The sixth page appears in the New Satellite Show dialog box.

New Satellite Show

l'.f:\.-' Enter additional commands to execute when the
= zatellite show begins and ends.

Additional Commands To Run At Start OF Show

Command .;5;.

Additional Commandz To Fun gt End OF Show

Carrand [ iJ
x|

=1 Back
‘/ oK I x Cancel ‘

Page 6 is for macro commands you want to execute at the beginning or end of the
satellite show. Uses range from sending serial strings, setting mixer levels, and turning
I/O devices on or off to running other applications. For more information, see Appendix A
- Macros.

To add an item to either list, click the Add il button next to the particular list and type
your desired macro command into the command window that appears.
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25. If you are satisfied with your settings, click OK.

8.4.2 Adding an Existing Satellite Show Start Event

When you create a satellite show start event, as in the previous section, OpX One adds it to
a memorized list. This makes it easy to re-use the configuration of a previously set up
satellite show start event without having to “re-invent the wheel.”

The following procedure describes how to add
a previously defined satellite show start event

]
to your clock. To see examples of completed I::?:' Ifr':‘ o e t
clocks, see section 8.5. o tg‘]p "‘d’l- !ﬁ B

> To add an existing satellite show start event D-E!.EI:ril:.ltilIl.f'li ||'.,.'|_|r| S atelite Show

1. Click the Start Existing Satellite
Show button.

New Start Satellite Show
{a& Select zatellite show pou want to start

MHarme

The New Start Satellite Show

dialog box appears. Cus
g PP 1Auta Start [+] LJ

Time - bkd:55

[0 =

N

Complete the fields in the dialog
box (see

o OF x Cancel I

o

Table 8-10).
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Table 8-10. Fields in the New Start Satellite Show  Dialog Box

Field Description Default
Name Select a satellite show start event you created previously. —
Cue The cue type determines how the satellite show starts based on time or Audio Start [+]
interaction with previous item execution. Under most circumstances,
select Time Immediate. For a description of all available cue types, see
Appendix B - Cue Types.
Time — MM:SS Select the start time of your satellite show. This usually is 00:00 for 00:00

shows that start at the top of the hour.

6. Click OK to add the event to your clock.

Page 228 of 390




Clock Builder Module

8.4.3 Creating a Commercial Break Event

The previous two sections described how to add a satellite show start event to turn on your
satellite show at the correct time. As part of those procedures, you told OpX One what
trigger the satellite show will send to start a local break. Now you need to tell OpX One when
the breaks will occur, so that national breaks can be replaced with your local spots.

» To create a commercial break event

o T o A o i r

- - Gy

1. Click the New Commercial Break button. = ‘-")ﬁ‘ tﬂ)l ﬁ’l |
Fhyy

Ciescriotion: |My Satelite Shaw

) _ New Commercial Break %
The New Commercial Break dialog box :
= Enter the cue. time, length and type of the
appears. commercial break.
zure] [l
) ) ) Tirne - MM 55 Lenigth - Mk:55
2. Complete the fields in the dialog box oo = oo =
(see
* Mandatory
3. " Dptichal
4,
Mext =
5. Table 8-11).
« 0K X Cancel J
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Table 8-11. Page 1 Fields in the New Commercial Bre ak Dialog Box

Field

Description

Default

Cue

Enter the desired cue type for the break. Choices are:
« None = select for trigger-started breaks.

« Time Immediate = select for most other non-triggered/non-floating
breaks.

For a description of all available cue types, see Appendix B - Cue
Types.

None [Stop / Start By
Closure]

Time - MM:SS

Enter the start time of the break in minutes and seconds (MM:SS
format).

« For floating (trigger-started) breaks, time is an estimate of the start
time of the break.

« For breaks with a cue type of Time Immediate or Time Next, time is
the exact start time of the break.

Audio Start [+]

Mandatory

Always plays break content, including the audio files added in steps 3
and 4. If Auto Fill is configured on your Audio Server, breaks that are
not fully filled by your traffic software are filled automatically with the
content you selected.

Selected

Options

Plays content only when your traffic software places spots or other
content within the break. If no content is placed in this break’s time
period, OpX One does not replace the satellite show content with local
content (or the audio files selected in step 3 or 4 below), leaving the
satellite show’s underlying audio on the air.

Not selected

6. Click the Next button.
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The second page of the
New Commercial Break
dialog box appears. This
page allows you to have an
audio file of your choosing
appended to the end of
your break. This means that
if you have set your break
to 3:00 minutes in step 2,
then add a 15-second
station ID file to this page,
your total break time will be
3:15 minutes.

Clock Builder Module

P

Mew Cammercial Break

i

Tl

= Add a zingle audio element to plap after the
" break ends.

Mame: _Description

x|+ [+

Perzent While Flaying Audio

[ Fade Satelitz To |50 0 = lowe, 99 = max wolume

[ Play |f Break 1z Empty

Add a wirtual cart if rotation from break to break iz
desired.

=1 Back Mext =

] S x Caricel ‘

Figure 8-9. New Commercial Break Dialog Box (Pg. 2)
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7. Complete the fields in the dialog box (see Table 8-12).
Table 8-12. Page 2 Fields in the New Commercial Bre ak Dialog Box

Field

Description

Default

Name/Description

To add an audio element, click on the Add i‘ button. When the
File Library window appears (similar to Figure 8-8 on page 224), drag

and drop desired audio files to the list on this window.

You can also add an audio element by typing in the name, rather than
dragging and dropping, by clicking the Delete i‘ button.

To remove an audio element from the list, click the selection and click
the Delete X button.

Fade To

« Checked = the selected audio element plays over top of the satellite
show, causing a ducking effect. Use the selector to the right to select
the volume level of the satellite show while the audio element plays.

Checked

Play If Break Is Empty

» Checked = the selected audio element plays even if the break is
empty and the Optional option was selected in step 2.

Unchecked

8. Click the Next button.

-

The third page of the New New Commercial Break
Commercial Break dialog 4= Enter items thal you want to run at the
box appears. This page '@ beginning and end of the break.

allows you to specify audio ltems To Fun &t The Beginring OF The Break

elements that are added
automatically to all breaks,
except breaks you
configure as Optional,
which have not been filled
in by your traffic software.

Mame | Deszcription

[tems To Run &F The End OF The Break

[% [+ [+

Mame | Descrption

=1 Back

| |+ [+

X Cancel ‘

5

Figure 8-10. New Commercial Break Dialog Box (Page

3)
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9. Complete the fields in the dialog box (see

10. Table 8-13).

Table 8-13. Page 3 Fields in the New Commercial Bre ak Dialog Box

Field Description Default

ltems To Run At The Beginning

- : %
Of The Break To add an audio element, click on the Add _I button. When the

File Library window appears (similar to Figure 8-8 on page 224), drag
Items To Run At The End Of The

and drop desired audio files to the list on this window.
Break

You can also add an audio element by typing in the name, rather than
dragging and dropping, by clicking the Delete il button.

To remove an audio element from the list, click the selection and click
the Delete X button.

11. Click OK to add the commercial break to your clock.

12. Repeat this procedure for each additional break you have in the hour until you build up all
the breaks specified by your syndicator for your satellite show.
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8.4.4 Creating a Custom Event

You can add custom events to your clock. Custom events allow the scheduling of macros,
audio files, carts, or comments into your clock that are not part of a satellite show start
event, commercial break, or satellite show end event. Uses of custom events range from
playing station IDs, sending serial strings, setting mixer levels, turning on/off 1/0O devices,
and running other applications to loading the log for the next day and more. You can even
use custom events in clock hour-blocks that are not part of a satellite rebroadcast.

¥ 1[5 1L, ]
ALYy L : '
> To add a custom event to your clock A -' 4 “IB ! "4 | =2 E% || | &

1. Click the Add Event button. _-_E"-t-.

&)

Crescrption: IM_',' Satellite Show

=

The New Event dialog box New Event

appears. _ @

Cue [ Mone = Stop At This Event |

-

2. Complete the fields in the dialog Time - FAbA:55

box (see oo

3. Table 8-13). ]I:ate'gam =
Marmie / Macio Commands:
| a4
J Ok x Carcel I
Table 8-14. Fields in the New Event Dialog Box
Field Description Default
Cue Determines how OpX One’s automation will start your event. See —
Appendix B - Cue Types.
Time - MM:SS Used with the timed cues Time Immediate and Time Next to determine 00:00
when your custom event will be played.
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Field Description Default
Category Select the category of your event. —
Name/Macro Commands The entry you add here depends on your selection in the Category —

drop-down list.
« Audio = enter the name of your audio file.
« Comment = enter the actual comment text.

« Macro = enter the macro command followed by any required or
optional variables. See Appendix A - Macros.

« Text = the file name is entered without extension. When this event
executes, the text file opens on the Studio Client modules. This
function is useful for news/weather scripts or general information.

Name Field for Macro Commands

4. Click OK to add your event to your clock.
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8.4.5 Creating a Stop Satellite Show Event

OpX One needs to know how and when to end your satellite show, just as it needed to know
how to start your show.

Stop satellite show events are needed only when transitioning from a satellite show to local
audio for a live or time shift satellite show, or ending a recording for a recorded satellite
show. A stop satellite show event is not needed if transitioning directly from one satellite
show to another because the satellite show start event handles the ending the previous
show when starting the next. To see
examples of completed clocks, see section

8.5. ‘:3' K:Jpg%_f&: E«% | J

> To add a stop satellite show event to your Diescription: IM-"" S atellibe Shiow
clock [ New Stop Satellite Show
1. Click the Stop Existing Satellite (), 2oinc: tha satalte show you ward e st

Show button.

Mame

The New Stop Satellite Show dialog Cus
box appears. | fuito Start [+) |
Time - MM:55
fooon =

N

. Complete the fields in the dialog box
(see

q,/ OK x Cancel I

o

Table 8-15).
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Table 8-15. Fields in the New Stop Satellite Show D ialog Box

Field Description Default
Name Name of the satellite show you want to end. —
Cue Type of cue for your stop satellite show event. For most situations, a —
stop satellite show event uses a Time Immediate cue.
Time - MM:SS Time for the event to execute, in minutes and seconds (MM:SS) format. 00:00

6. Click OK to add your event to your clock.
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8.4.6 Creating Multi-Hour Satellite Show Clocks

The procedure is the same as for creating clocks for a multi-hour satellite show and creating
singular hour satellite show clocks, except that the events you place in the set of hour-long
clocks changes subtly. The difference in how you set up your clocks must take into account;

A satellite show start event is only required in the first hour of the string of the multi-hour
satellite show clocks, although adding them will not hurt in most cases.

Satellite show stop events are not needed until the end of the last hour of the string of
satellite show clocks, although adding them will not hurt in most cases.

See section 8.5.5 for an example of how a multi-hour satellite show clock is set up.

8.4.7 Recording a Satellite Show

Recording a satellite show is easy to perform using OpX One. The recording function of OpX
One records the audio content and includes the contact closures/triggers received
throughout the recording. As a result, recording multi-part shows is simplified compared to
other automation systems. Moreover, OpX One can play back your recorded material in a
completely automated fashion. You'll never again have to splice a long-form recording
manually. You can even air a show live using the procedures in section 8.4 while recording it
by checking the Record and Live options.

There is no need to add commercial break events to a clock that is strictly recording a
satellite show. Playback of breaks is handled by the Time Shifting clock that plays back your
recorded satellite show.

8.4.8 Time-Shifting a Satellite Show

For OpX One, the term “Time Shift” refers to the play back of a satellite show previously
recorded by OpX One. When you record a satellite show with the clock builder’s recording
functions, the triggers received are also recorded (see section 8.4). This allows OpX One to
play back a recorded show with dynamically inserted spots and/or liners, jingles, and so on.
Now you can record a show and play it back at a later date, with local spots inserted, without
any complicated commands or manual audio file editing or splitting. OpX One does it all for
you.

The procedure is nearly the same for creating a time shifted satellite show clock and
creating a clock for a live satellite show (section 8.4 describes how to configure a clock for
live satellite shows). The major difference is that the satellite show start event uses the Time
Shift option to play a previously recorded satellite show rather than airing live content from
your satellite receiver. All other configuration steps for setting up your closure device,
commercial break events, and so on are exactly the same as setting up a live satellite show.
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Other than the following procedure, setting up a time-shifted show is the same as the
procedure in section 8.4.1.

1. Perform steps 1 through 9 in section 8.4.1.

2. At step 10, add the TIMESHIFT macro to the Additional Commands To Run At Start Of
Show section. This command prompts your recorded file to play and allows you to
specify your recorded file using meta variables.

To add the TIMESHIFT command:
a. Click the Add Event button to the right of the Additional Commands To Run At Start
Of Show field.

b. Enter the command that specifies your recorded show to the Macro Command field of
the Command window that pops up (for more information about the TIMESHIFT

macro, see Appendix A - Macros).

c. Click OK.

The example shown in Figure 8-11 has a macro that specifies an audio file with the text
roshlimberg followed by the current date. To put it another way, if today’s date is
December 23, 2008, the audio file roshlimberg122308.wav will be played.

\, New Satellite Show ‘

(%) Enter additional commands to execute when the
2 satellite show begins and ends.

Addiional Commands To Run At Start Of Show

Command ij
x|

TIMESHIFT roshimberg%mendd%yy

Addiional Commands To Run At End Of Show

Command j_’
x|

¢ Back

7 oK | X Concel |

Figure 8-11. Example of Using the TIMESHIFT Macro
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The previous sections describe how to create clocks. This section provides examples of
clocks used for different purposes.

8.5.1 Satellite Talk Show with Top-Of-The-Hour News Examp  le

It is common to use a news service at the top of the hour for the first 5-to-6 minutes of the
hour. The example in Figure 8-12 shows a clock that contains a top-of-the-hour news
broadcast with its break followed by a switch to a second satellite show.

Specifically, this clock contains a satellite show start event to:

- Switch to news, and then

« At 5 minutes past, play a local spot using a time immediate cued commercial break

event, followed by.

. A satellite show start event for the rest of the hour’s satellite show with its break events.

The stop satellite show event is set with an auto start cue type. This forces the satellite show
to stop automatically at the break just before it finishes playing.

£ Wednesday 9 am _ . x|
O OG | & p M e
OROROREF P ARTIED
Description: |Lauris Colar: |I:|Yellow _ﬂ
Time | Type | Categoy | Detailz
iro Rt 2y 4@ 0000 StatSatelite Show  MACRD  SATSHOW START, ABGNEWS +
| & ® 0500 Cowmercial Break  MACRO  MANDATORYNOFADE SONOPLAYIFEMPTY
L+ ORO0  StatSatelite Show  MACRO  SATSHOW START. LAURIE L 4
% 1900 Commercial Bresk  MACRO  MANDATORY MOFADE S0MOPLAYIFEMPTY
P S R0 ConmercialBresk  MACRO  MANDATORY NOFADE SONOPLAYIFEMRTY
f | |9 4700 CommerislBresk  MACRO  MANDATORY.MOFADE 50 MOPLAYIFEMPTY
w ||% 5750 CommercialBresk  MACRO  MANDATORY NOFADE S0NOPLAYIFEMPTY
15| a+ 5353 StopSaeliteShow MACRO SATSHOW STOP, LAURIE
17
/18
5 e
Ham 3029282?2
4 | i
Carncel B 2pply
X Cancel | [

Figure 8-12. Sample Clock Containing a Top-of-the-H

our News Broadcast
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8.5.2 Satellite Music Show Example

This example shows a simple music from satellite show. There is no top-of-the-hour news to
worry about and there are four breaks started by trigger.

« At 59:50 past the hour, an audio event for “TOH Jingle” (top of the hour jingle) has been
added as a time immediate event. This forces the top-of-the-hour jingle to play, no

matter what else is going on.

« The stop satellite show event has a cue type of Auto Start, which means that it will
execute automatically as soon as the top of the hour jingle has played.

£ wednesday 9 am e g x|
: " e W =
QOGS L OOX
Description: [Joans Colar: II:l Yellow _j
- Time. | Tvpe | Category | Details
657590 12, 4 @ 00,00 Start Satelte Show  MACRO  SATSHOW START, JOAMS +
| i;a 14:00 Commercial Braak MACED  MaNDATORY NOFADE SONOPLAYIFEMPTY
$ 28:00 Commercial Break MACRD  MaNDATORY NOFADE S0NOPLAYIFEMPTY +
$ 43:.00 Commercial Break MACRD  MANDATORY MOFADE S0 MNOPLAYIFEMPTY
:7-;' 5780 Commercial Break MACRD  MANMDATORY MOFADE 50 MOPLAYIFEMPTY
'@ @ B350 Event ALDIO TOH Jingle
-t 5353 Stop Satelite Show  MACRO  SATSHOW STOP. JOANS
4 | k
X Cancel | B ool |
: s

Figure 8-13. Satellite Music ShowExample
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8.5.3 Background Recording Example

Setting up a clock for recording is simple. As shown in the clock in Figure 8-14, all you need
to add is the satellite show start command to start the recording and the End
Satellite Show command to stop the recording. This example uses the auxiliary Audio

Server, so there is only the recording function taking place. The triggers are recorded
automatically along with the audio, so there is no need to configure anything for breaks or

other events when recording.
To record a show while also airing it live, set up your satellite show start event for your live
show, enabling both the Live option and the Recording option (see section 8.4.1).

& Monday 9 am _ D : x|
S ot onl B N
&/ l‘:v)b"-Jl‘ » &‘!J:'I_J Wl X
Description: IABG Mews Fecard Calar: |[:] Agua _j
Time: | Tepe | E-atagory! Detallz
GorsE 0l 2 5 . Zh@ 0000 StaSat. MACROD  SATSHOW START, ABG_REC 1+
: -w@ 0600 StopSat. MACRO  SATSHOW STOP. ABG_REC %

5,
34, ——2
3332 3139292877

Figure 8-14. Background RecordingExample
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8.5.4 Time-Shift Playback Example

“Time shifting” refers to the playback of a previously recorded satellite show (see section
8.4.7 for setup instructions). A full satellite show including breaks is configured as if it was a
live satellite show. The only differences is that the satellite show start events in this hour’s

clock specify “Record” as the show type, and after the satellite show start events, the

TIMESHIFT macro has been inserted that references the recorded show to be played (the
TIMESHIFT macro is the mechanism that starts the playback of the recording).

Figure 8-15 shows an example of a clock configured to play back a previously recorded
satellite show.

x
/‘_"‘ I.":"" I':"‘ .d‘- [ _|'\. [ L 18 '._"_I
l-:"l t‘:i)[} I':% "§; & | !_‘! L‘_’] |,_| x
Desciption: |Lawis Time Shift Color: | I Fed |
Tirne: Tyvpe | Category | Dietals |
Go7senitl 2 4 @ 0000 StatSat., MACRD  SATSHOW START, ABCTS &
! G+ 00:00 Ewent MACRD  TIMESHIFT ABC News Zmm&ddioy
%@ 0500 Commers.. MACRO  MANDATORY NOFADESONOPLAYIFEMPTY +
@ 0800 StatSal. MACRD  SATSHOW START, LAURIETS
49 ¢+ OE0D Ewvent MACRO  TIMESHIFT Dr Launefmmzzddipy
o % [|% 1900 Commerc.. MACRO  MANDATORYNOFADESONOPLAYIFEMPTY
i W ||% 3200 Cowmerc.. MACRO MANDATORY NOFADE SONOPLAYIFEMPTY
15 15 | |35 4700  Commerc.. MACRD  MANDATORY NOFADE 50 NOPLAYIFEMPTY
9 o ||% 5750 Commec. MACRO MANDATORYNOFADE.SONOPLAYIFEMPTY
42 fe | |@@ 5350 Event AUDID 10SECID
p+ B389 SiopSal. MACRO  SATSHOW STOP,LAURIETS
3332 3130292827
SOk | Xoweed | H ey | y
11

Figure 8-15. Time Shift Playback Example

8.5.5 Multi-Hour Satellite Show Example

Multi-hour satellite programs are common. Handling them in OpX One is nearly the same as
handling single-hour satellite programs.

This example shows a 3-hour-long satellite program. Since each OpX One clock accounts
for one hour, we create three clocks.

In Figure 8-16, Figure 8-17, and Figure 8-18, each hour is nearly identical, except for the
first two hours not containing a stop satellite show event, while the third hour does.

The last event in hours 1 and 2 is a Station ID cart event (which your show may or may
not require, as this is a situational example) with a time immediate cue, while that same
event has an autostart cue in the third hour. This is because the stop satellite show
event has a time immediate cue with the station ID cart event automatically starting after

that event because of its autostart cue.
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© Thursday 9 am — x|
T L e =
QOGS L HOX
Description: |Bi|| O'Really Hour 1 Colar: |‘ Lirne j
- | Time. | Tupe | Cateaom | Details |
55“5:5“ 225 4@ D00 StantSatelite Show  MACRO  SATSHOW START, ABCNEWS +
! ';; = 0%00 Carnrnercial Break MACRO  MANDATORY NOFADE S0MOPLAYIFEMPTY
S @ 0600 Start Satelite Show  MACRO  SATSHOW START, BILLOREALLY +
$ 14:00 Commercial Break MACRD  MAMDATORY NOFADE 50 MOPLAYIFEMPTY
$ 28:00 Commercial Break, MACRO  MANDATORY MOFADE 50 MOPLAYIFEMFTY
E] 4700 Commercial Break MACRO  MAMDATORY MOFADE.SOMOPLAYIFEMPTY
$ 5750 Commercial Break MACRD  MANDATORY.NOFADE.S0MOPLAYIFEMPTY
15 -ﬁ@ @ B350 Event AUDIO Station |0 Cart

5 {
T el L P o
3332 3139292827

X Cancel | S | /

Figure 8-16. Hour One of a Multi-hour Satellite Sho w Example

O thursday 10am i
A Lt = =
QOQGIS@d (L0 X
Desuiptim:lBillD'HealI}l Hour 2 Color: |‘ Lime j
| Time | Type | Categom | Details |
“565755”‘23 CL@ 0000 StatSatelite Show  MACRD  SATSHOW START. ABGMEWS P
& @ 0500 CommercialBresk  MACRD  MANDATORY NOFADE.SONOPLAYIFEMPTY
4@ O0G00  Stat Satelie Show  MACROD  SATSHOW START. BILLOREALLY 4
S 1400  CommercialBresk  MACRD  MANDATORY WOFADE SONOFLAYIFEMPTY
& 2800 CommercialBresk  MACRO  MANDATORY MOFADE 50MOPLAYIFEMPTY
2. 1l% 4700 CowmerciolBresk  MACRO  MANDATORY MOFADE 50 NOPLAYIFEMPTY
11 |8 5750 CommercialBreak  MACRO  MANDATORY NOFADE SONOPLAYIFEMETY
1‘: -LQ@ 52:80 Ewent AUDID Station |0 Cart
17
18
5. [ i
M350 5130202827
IJK. x Eénc:BI;l EApply |
4

Figure 8-17. Hour Two of a Multi-hour Satellite Sho  w Example
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@ Thursday 11 am T 1'
CGGISHILHOX
Desenption: |Bi|| 0'Really Hour 2 Calar: |- Lime LI
- | Time | Tupe | Categow | Details.
5-555575' 9124 o b @ 0000 StatSateliteShow  MACRD  SATSHOW START, ABGNEWS t
ik \ > «§ @ 0500 Comrnercial Break, MACRO  MANDATORY NOFADE S0NOPLAYIFEMPTY
“h@ DE:00 Start Satellite Show — MACRO  SATSHOW START, BILLOREALLY +
$ 1400 Comrnercial Break, MACRO  MANDATORY NOFADE SONOPLAYIFEMPTY
4:’9 - $ 28:00 Commercial Break. MACRO  MANDATORY MOFADE BOMOPLAYIFEMPTY
a7 13 $ 47.00 Commercial Break. MACRO  MANDATORY NOFADE SONOPLAYIFEMPTY
46 14 h‘ib 5750 Commercial Break. MaCRO  MaNDATORY MOFADE S0MNOPLAYIFEMPTY
:i ] 115 ~g@ 5360 Stop Satelte Show  MACRO  SATSHOW STOP, BILLOREALLY
L ‘: -@ + 5380 Event AUDIO Station |0 Cart
42} /18
N s0z028%T
Cancel B ool
X Conce | |

Figure 8-18. Hour Three of a Multi-hour SatelliteS  how Example
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8.5.6 Utility Tasks without Satellite Show Audio Example

There are many instances where you might want to put utility tasks into your daily log,
without having to worry about putting them into your traffic or music log software before
importing into OpX One. You can use the clock builder for these “set-it-and-forget-it” tasks.

The example in Figure 8-19 shows a clock for the last hour of the day that contains only a
macro that tells the OpX One Audio Server to load the log for the next day.

x
N o ) el . =]
QGG I$@& £ OO X
Desenption: lEnd of the Day Colar: |- Ny _ﬂ
Time. | Type | C.at_e.gowl [retals |
. 55657585” 12y @ 5353 Ewenl MACRD  LOADLOG +
¥
49
13 12
7 12
1 1"
15 15
4 1
43 {17
42 12
5
M3 30292827262
Canicel H 2pply
X cercel | |

Figure 8-19. Utility Tasks without Satellite Show A

udio Example
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Topics:

A

Starting the Import-Merge
Module (page 248)

Quick Tour (page 249)

Third-Party Log
Requirements for
Importing (page 255)

Configuring the Import —
Merge Module (page 256)

Importing Program Logs
(page 270)

Manually Adding and
Editing Program Log
Events (page 274)

Working with Carts (page
277)

9 Import-Merge Module

This chapter describes the OpX One Import-Merge
module.

The Import-Merge module is used to import program logs
from traffic- and music log-generating software, and
merge them into a single log along with your clocks
generated with OpX One’s Clock Builder.
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9.1 Starting the Import-Merge Module

You must start the File Server module before you start the OpX One Import-Merge module.

> To start the Import-Merge module
1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > Import-
Merge.

You are prompted to select a station.

Select a Station

Stations

I =]

3. Using the Stations drop-down list, click a station.

4. Click OK.
The Import-Merge module is populated with the information from the selected station.
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9.2 Quick Tour

The following sections provide a quick tour of the Import-Merge module interface.

ETETTETTT o
(1] Fle Edt About
> —v o e
@ — W% [ *HFO W % 0%/ 4%
© —— @l import Station: [WBSI - BSI SAT Station |
QAMQ_IMMM Al
0 00:00:00 MACRO SATSHOW START, ABCNEWS =
1 @ 00:05:00 MACRO COMMERCIALBREAKBEGIN 01:00, MANDATOR
2 + 00:05:.00 COMM... 01:00 Local Spots
3 + 00:05:00 6435 01:00 AUDIO Safeway
4 + 00:05:00 MACRO COMMERCIALBREAKEND
5 + 00:06:00 MACRO SATSHOW START, HENDRIE
6 @ 00:27:.00 COMM... Time Sync
i 00:30:00 MACRO COMMERCIALBREAKBEGIN 04:00, MANDATOR
8 + 00:30:00 COMM... 04:00 Local Spots
0 9 + 00:30:00 6511 01:00 AUDIO AlHarington -
10 + 00:31:.00 6309 01:00 AUDIO Alpine Bank Promo
11+ 00:32:00 6242 01:00 AUDIO Feather Petroleum / Stop-N-Save
12 + 00:33:.00 6684 01:00 AUDIO ForrestPaint- Country Fair
13 + 00:30:00 MACRO COMMERCIALBREAKEND
14 @ 00:55:00 COMM... Time Sync
15 00:57:50 MACRO COMMERCIALBREAKBEGIN 02:00, MANDATOR
16 + 00:57:50 COMM... 02:00 Local Spots
17 + 00:57.50 6435 01:00 AUDIO Safeway
18 + 00:58:50 6634 01:00 AUDIO Emrald Pool & Patio
19 + 005750 MACRO COMMERCIALBREAKEND
20 @ 01:00:00 MACRO SATSHOW START, ABCNEWS
21 @ 01:05:00 MACRO COMMERCIALBREAKBEGIN 01:00, MANDATO
2+ 010500 oveemmmamn COMM.. 0700 Local Spots _ .
<
| 4

Menu bar. See section 9.2.1

Tool bar. See section 9.2.2.

Log name and station selector. See section 9.2.3.

Program log display. See section 9.2.4.
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9.2.1 Import-Merge Module Menu Bar

The menu bar appears at the top of the Import-Merge window. The following sections
describe the menus on the menu bar.

9.2.1.1 File Menu

Open Log = opens a program log so you

Edit About can re-import traffic or modify the log.
Open Log... [
Cart Properties... Cart Properties = sets Artist/Advertiser and
G save Ctrl+S Title/Description information, as well as the
Save As... A average length.
2}}] Using Music Format...  Ctrl+M Save = saves the current file.
?4. Using Traffic Format...  Ctrl+T )
Log From Clock... Ctrl+K Save As = saves the current file under a
& Verify Traffic... different name and/or location.
New ' Using Music Format = imports from your
Import ’ Music Log software See section 9.5.1.
Export . . , .
= Using Traffic Format = imports from your
2= File Library... ) .
e —— Traffic Log software See section 9.5.2.
I Exit Ctrl+Q

Log From Clock =imports data from the
clocks you created using the Clock Builder
Module into your program log.

Verify Traffic = checks the traffic event expire
dates and file existence in your log.

New = creates a new program log or cart

Import = imports music, traffic, alternate,
CSV, and XML formats. See section 9.5.

Export = exports music, traffic, alternate,
CSV, and XML formats. Also, allows you to
save your log to your file server. See section
9.6.

File Library = adds events to your program
log. See section 9.7.1.

Exit = exits the Import-Merge Module.
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9.2.1.2 Edit Menu

J

Loc

#

File About

Z| Verify

Ctrl+V

Program Log Options...

Select All

Edit Fields...
Insert New Item

) Settings...

Ctrl+A

Ctrl+E
Ctrl+N

Import-Merge Module

Verify = checks your program log for errors or
missing files.

Program Log Options = opens a calendar with
dates you can click to see options configured for a
particular day.

Undo = reverts to the version before you last saved
the current file (helpful when you make an error while
creating or editing a program).

Cut = removes the highlighted event from your
program log and copies it to the Windows' Clipboard.

Copy = copies the highlighted event to the Windows’
Clipboard.

Paste = pastes a cut or copied event from the
Windows’ Clipboard under the currently highlighted
item in your program log.

Delete = removes an event from your program log,
highlight it and choose this menu option. This option
is similar to the Cut option, but the event is not
copied to your Windows’ Clipboard.

Select All = highlights all events in the program log.
This option can be used with the Cut, Copy, Paste,
and Delete menu options

Edit Fields = edits the fields of the highlighted event
in the program log. This is useful when you want to
correct a mistake or slightly modify an existing entry.

Insert New Item =to add a new item to your
program log, highlight the event in the program log
previous to the location where you want to add your
new event, and then click this menu option. You can
then manually enter the command of your choice.

Randomize = randomize carts. This option is
available when creating carts, not when creating
program logs.

Settings = accesses the Import — Merge Module
configuration settings and adds events to your
program log.
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9.2.1.3 About Menu

Opens a window that shows the version and
File Edit |About build date of the Import-Merge module you are
running. This window also shows the amount
of memory and virtual memory being used,
and the amount of time that the File Manager
module has been running. See Figure 9-1 for
an example. To close the window, click OK.

-~

’About @

v0.0.0.235 -

Build Date:
Aug 14 2014 20:53:35

m

Memory Usage:
14,600K 7 14,768K

VM Usage:
7.176K / 7,820K

Figure 9-1. Example of About Information
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9.2.2 Tool Bar

The Import-Merge module tool bar appears below the menu bar.

WS | YHFO KHI X OO X] =
= 7 7 =
l,j'__vJ! H.J J Q 4—1
Table 9-1 describes the tools on the tool bar.
Table 9-1. Import-Merge Module Tool Bar
Tool Tool Name Description Tool Tool Name Description
Import Using Imports from your music Cut Removes the
b Music Format log software. highlighted event from
Jg % your program log and
copies it to the
Windows’ Clipboard.
Import Using Imports from your traffic Copy Copies the highlighted
e Traffic Format log software. By event from your
$ L‘j program log to the
Windows' Clipboard.
Open Log From Opens and modifies a Paste Pastes a cut or copied
= Server log that has been saved s event from the
to the File Server. J Clipboard to the item
below the highlighted
item in your program
log.
Verify Program Checks your program Delete Removes an event
— Log log for errors or missing from your program log.
=< files. x
Verify Traffic Log Checks a traffic log for Find Finds an event in your
missing or out- of-date s program log using the
s’ audio files without ' criteria you specify.
importingit.
Go To Next Error Finds errors in the Find Again Finds the next instance
program log marked in 3 of an event with the
@ red by the Program Log . o search criteria used
option. with the Find option.
Save To OpX One | Saves the program log File Library Adds events to your
I I Server to the File Server. b program log.
|§I
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9.2.3 Log Name and Station Selector

The log name and station selector appear below the tool bar.

Table 9-1 describes the tools on the tool bar.

Q@ —oLog 041208

2]

l

Station: IWOP‘X - The Best Rock! LI

Figure 9-2. Log Name and Station Selector

Table 9-2. Import-Merge Module Log Name and Station  Selector

Number Description
(1] Name of the open program log. Your OpX One program log is automatically named with the
file name of the first imported item. For example, if you import a traffic log named
“041208.log", your OpX One log automatically inherits “041208.xml” as its file name.
(2] The station you are creating logs for is determined by the station selected in this drop-down

list. In the figure above, logs are being created for the station “WOPX ONE”, with the
configuration settings (import format settings, log locations, and so on) particular to the
WOPX ONE station.

9.2.4 Program Log Display

The program log display shows the program log events as they are imported. It uses the
same display formatting as the Audio Server Module’s program log display.

#i Cus | Scheduled | Actual | Mame | Length | Cateqory | Drescription :I
0 @ 000000 MACRO SATSHOW START, ABCMEWS =
1 @ 000500 MACRD COMMERCIALEREAKBEGIN 01:00, MANDATOR
2+  [O0s00 COMM.. 07:00 Local Spots
3 + 0nom:oo 6435 0100 AUDID Safeway
4 « 000500 MACRD COMMERCIALBREAKEND
5+ DB0E:00 MACRO  SATSHOW START. HENDRIE
E @ 002700 COMK... Time Svnc
% 00:30:00 MACRD COMMERCIALEREAKEEGIN 04:00, MANDATOR
g + 00acoo0 COMM.,. 04:00 Local Spots
3 + 003000 B511 01:00  AUDIO Al Harington = YWAhaFT M
10+  00:31:00 E309 01:00 AUDIO Alpine Bank Pramo
11+ 03200 B24e 0100 AUDID  Feather Petroleum f Stop-N-Save
12+  00:33:00 BEE4 0100 ALUDIO  Forrest Paint- Countre Fair
13 + 003000 MACRD COMMERCIALEREAREND
14 @ 00:ER00 COMB... Time Svnc
15 00670 MACZRO COMMERCIALBREARBEGIN 02:00, MANDATOR
16 + DO57ED COMM.,. 02:00 Local Spots
17 + BOG7ED 5435 01:00  AUDIO  Safewsy )
18 + 006350 BE34 0100 AUDIO Emrald Pool & Patio
19 + BOG7ERD MACRO COMMERCIALEREAKERD
20 @ 010000 MACRD SATSHOW START, ABCHEWS
21 @ 010500 MACRD COMMERCIALEREAKBEGIN 01:00, MANDATOR
22+ 010E00 COMM.. 0100 Local Spots -
B Flacy | -

Figure 9-3. Program Log Display
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9.3 Third-Party Log Requirements for Importing

The program logs you want to import into OpX One must meet the following requirements.
Files must either be delimited or in position-dependent ASCII text format

Each break/stop set must contain a signifying event as the first event of the break, such
as a comment of BREAK START STOPSET or $$COMMERCIALS$$You configure the
Import — Merge module to recognize your marker text, so it is actual text does not matter
as long as it is consistent.

« At a minimum, every event must contain a scheduled time for each event, a category,
and a file name (without file extension) for audio events.

« If combining a music log, traffic log, and clocks (from the OpX One Clock Builder),
ensure that each log/clock has the same number of breaks scheduled at corresponding
times.
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9.4 Configuring the Import — Merge Module

Configuration of the Import — Merge module is critical. In particular, the import format
settings must be accurate for import operations to work properly. The following sections
describe how to configure the Import — Merge module.

¢ Note: Many settings are available only on the Import-Merge module on the File
Server. To access these settings on a different system, you must import the
settings from the File Server to the new machine using the Restore from File
Server button (see the figure in section 9.4.2).

> To configure the Import — Merge module settings

1. On the Edit menu, click Settings .
The Settings dialog box appears, with the General tab displayed.

Settings

| Import Formats |

W File Server Address
| 10 - 1 . 1 _ 10

I Default Station Assignmert

W Verify After Merge

fv Show Wamings For Out-of-date / Missing Cart Hems

[~ Require Restart To Change Stations

Secondary Stations

Primary Station | Secondary Station

x[ale

* Secondary stations are used for log
verification, the library list and to ssve the
Fecondsry program log

Set List Font

[ ok | % caneal |

Figure 9-4. Settings Dialog Box with General Tab Di  splayed
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2. Complete the fields in the dialog box tabs.

3. When you finish, click the OK button.

9.4.1 General Configuration Settings

Figure 9-5 shows the field in the General tab and Table 9-3 describes them.

W File Server Address

[ 10 . 1 . 1 . 10

I Default Station Assignmert

W Verify After Merge

iv Show Wamings For Out-of-date / Missing Cart tems

[~ Require Restart To Change Stations

Secondary Stations

Primary Station | Secondary Staion

x[ale

* Secondary statfons are used for log
verification, the library list and to ssve the
secondsry program log

Set List Fort

| ok | % cancel |

Figure 9-5. General Tab
Table 9-3. Fields in the General Tab

Field

Description

Default

File Server Address

« Unchecked = Import — Merge module searches your network for the OpX
One File Server.

» Checked = Import — Merge module uses the IP address specified to find
the OpX One File Server. This can speed up start-up time or aid your
computer in finding the OpX One File Server.

10.1.1.10

Default Station Assignment

» Unchecked = you must select your desired station each time you open
the Import-Merge module.

« Checked = specify one of your stations to load automatically when
opening the Import — Merge module.

Unchecked

Verify After Merge

Check this check box to have the system check for duplicate files and valid
air dates as program logs are being imported into the system.

Checked
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Field Description Default
Show Warnings For Out-of- Check this check box to have the system generate an error message if it Checked
date/Missing Cart ltems finds a cart of items (such as commercials) that are out of date.
Require Restart To Change Check this check box to force the Import-Merge module to be restarted Unchecked
Stations before the station can be changed.
Secondary Stations If you import program logs or virtual/nonexistent stations whose libraries —
reside on another station, this field allows verification to be performed by the
secondary station.
Set List Font Allows you to select the typeface for the Import-Merge module interface. —

9.4.2 Import Formats Configuration Settings

The Import Formats tab allows you to define the settings for files you will import into the
OpX One system.

1. Click the Import Formats tab.

A tab similar to the following appears.

Settings
Gerersl |
Select A Station
| e}
[y Restore From Server | o OK I X Cancel ‘

2. Using the Select A Station drop-down list, click the station whose import format settings
you want to configure. The import formats you select are particular to each station.

The Import Formats tab gets populated with fields and buttons (see Figure 9-6).
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e ==

Gerieral  Import Formats l

Station

Muszic Traffic B Test

petblascails Select the folder containing the log file that you wizh to

LPQ Tupe import. Input the file name template including the file

Filter Setup extension. Apply any applicable options. Click Mext.

Block b arker

Feplace Texst Input File Folder
| =
File Mame Template

5 Secondany File Mame Template [ Used for zaving anly |

Next m=
[y Restore From Server ] o OK | x Cancel J

Figure 9-6. Input File Folder and File Settings

Click the type you want to configure or modify. There are three types of import format
definitions for each station:

— Music

— Traffic

— Alternate import format definition

Complete the remaining fields in the Import Formats tab (see Table 9-4).
If desired, click the Test button to test your settings.

Proceed to section 9.4.3.
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Table 9-4. Fields in the Import Formats Tab

Field Description

Default

Input File Folder Enter the path to the directory where you save your traffic/music log software
export files. Alternatively, click the Browse to Folder button on the far right side
of the field and select the file.

File Name Template Enter the naming format of your log. This can be either static text (such as
‘mylog.txt") or meta-variables so OpX One will automatically recognize date/day
specific log names. The meta-variables convert to the current day/date
automatically (using your workstation’s date and time) in the following formats:

* ‘hyy
Year as a 2-digit number.
Examples: For 2009, replace %yy with “09”. For 2016, replace %yy with “16”.

« oyyyy
Year as a 4-digit number.

Example: For 2016, replace %yyyy with “2016".

e %m
Month as a 1- or 2-digit number without a leading zero.
Examples: For June, replace %m with “6”. For November, replace %m with
“11”.
e %mm
Month as a 2-digit number with a leading zero.
Examples: For July, replace %mm with “07”. For October, replace %mm with
“10".
* %mmm
Month as a 3-letter abbreviation.
Example: For November, replace %mmm with “Nov”.

e %mmmm
Month as a full name.
Example: For August, replace %mmmm with “August’”.

> %d
Day as a 1- or2-digit number without a leading zero.
Examples: For the 5™, replace %d with “5.” For the 12, replace %d with “12”.

* %dd
Day as a 2-digit number with a leading zero
Examples: For the 7, replace %d with “07”. For the 24, replace %d with
0

> %ddd
Day as a 3-letter abbreviation.
Example: For Tuesday, replace %ddd with “Tue”.

> %dddd
Day as a full name.
Example: For Friday, replace %dddd with “Friday”.

Figure 9-7 on page 261 shows an example of using meta-variables to represent
a log naming convention that uses the month, day, and year as 2-digit numbers.
This means that when you import your log for the next day by selecting
“Tomorrow” during the import process described later in this chapter, on
December 23, 2008, OpX One looks automatically for a log file named
“122408.1og”.

Another example, if your traffic log-generating software created a file that looked
like “122308t1.txt", you enter %emm%dd%yyt1.txt into the File Name Template
field. OpX One treats any character that is not part of a valid meta- variable as
literal text. In this example, “t1” is not a meta-variable and is included as part of
the file name.
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9.4.3 Log Type Configuration Settings

1. Click the Next button or click Log Type in the left pane.
The settings in Figure 9-7 appear.

Settings
Genersl
Station
|WBSI - The Best OFf BSI ~|
Music Traffic Test
Input Folder & File 5 . o
Select the format of your log file. For Delimited the Delmited
Lpg Tupe Character can be a . [comma) | [vertial bar) or the word tab for
Filter Setup the tab character. Click Next when complete.
Block Marker
Feplace Text % Position D ependent
™ Delimited
- Back Mewt =
[y Restore From Server ‘ | o OK | x Cancel J

Figure 9-7. Log Type Settings

2. Click the format of your logs (Position Dependent or Delimited ). See sections 9.4.3.1

and 9.4.3.2 to determine whether your music and traffic logs are in position-dependent or
delimited format. Then proceed to the appropriate step:

If the log is in position-dependent format, click the Next button or click File Setup in
the left pane. Proceed to step 3 below.

If the log is in delimited format, click the Next button or click File Setup in the left
pane, and then enter the character used by your log-generation software to
differentiate between its various fields. Proceed to step 4 on page 262.

3. When configuring a position-dependent import format, the settings in Figure 9-8 allow you
to enter the position and length of each piece of data from your log. Enter the starting
character position of each field type into the Start column, and the total length of the field
into the Length column. Use the Scheduled Format and Length Format fields to specify
the time format your import file gives in the Scheduled and Length fields.
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— hh = hour digits

— mm = minutes digits

— ss =seconds digits

— A/P = 12-hour time (AM or PM)

— Other options are in 24 hour format.

Settings = ll

General  Import Formats |

Statian
0PX - The Best Rock! i
I Music Trafhic I B Test |
Iput Folder & Fils Input Start and Length for position dependent format or
Log Type Position for Delimited. Click Next when complete.
Filter Setup
Block Marker = o
Feplace Teaxt atart engt . L .
Enter itern beginning pozition and length
Cue [ [ of field. Example; If CUE begins with the

Soheced 2 B e S START
Schedulad m b and 1in the START bas hest to
Farmat CUE

File: M arne iT iS_

e

Length ’T F

Length Format Imm: 3T vi

Category ir ’3_

Description 1 ,31._ EEI_

Brescription 2 IE_ iﬁ_

[~ Add Auto Step Cue "+ ta-all events

' Back | Mext = |
L4 Restors From Server | o OK I X Carcel |

Figure 9-8. Example of Configuring a Position-Depen  dent Import Format

4. When configuring a delimited import format, enter the field order of each piece of data
from your log (see Figure 9-9). Enter the field number of each field type into each
corresponding Position field. Use the Scheduled Format and length Format fields to
specify the time format your import file gives in the Scheduled and Length fields.

— hh = hour digits

— mm = minutes digits

— ss = seconds digits

— A/P =12-hour time (AM or PM)

— Other options are in 24 hour format.
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Settings ] x|

General  Import Formats !

Statian
0P - The Best Bock! st
l Muszic Traffic I B Test |
Input Folder & Fil Input Start and Length for position dependent Format or
Lo_g Type Pozition for Delimited. Click Next when complete.
Filter Setup
EBlock Marker i
asitiar
Replace Tex! i1_ E rter delimiting character [, | ar tab),
Cue then enter a position number, Example: |f
’_ CUE iz the third item irf & fine separated
Scheduled 2 by commas, enter a-comma in the: above

Scheduled Im bowt and 3 in the Cuie box
Format o

File: Mame 13_
File-Mame I

Leading Char

Length I4

Length Format Imm:ss vi
Cateqony ’5

Description 1 IS
Description 2 |?

[T Add Auto Step Cue "+ to all events

= Back | Meut = |
L Restors From Server | o OF I X Cancel |

Figure 9-9. Example of Configuring a Delimited Impo  rt Format

5. Proceed to section 9.4.3.

9.4.3.1 Position-Dependent Format

Position-dependent program logs such as the one in Figure 9-10 are organized with the
various pieces of data in nice columns that are easy for people (not just computers) to read.
Each column starts at the same position on each line when you count the characters from
the left side and each column always contains the same number of characters, including
spaces. Another indicator of position-dependent program logs is that the “white space” is
made up of spaces, not tabs or other characters. If your program log does not fit this
description, you have a delimited program.

Figure 9-10 shows a typical position-dependent program. Each “field” is in a specific column,
with each data type always starting at the same position on all lines/rows. Notice the cursor
positioned just before the Category column and the “Col 23" shown in the lower right corner.
This indicates that the starting position of the category starts at character 23. Counting the
number of characters to the right, we find that the column can fit 8 characters. Another
indicator that this is a position-dependent log is that the “white space” is made up of spaces,
not tabs or other character.
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o x|
File Edit Formak  Wiew Help
+ 00:5sl:30 5011 01:00  |lupIo Toma Ads/ 5011 -
+ 00:52:30 5552 00:30 AUDIGO red Lobster 5592
+ 00:53:00 2692 01:00 AUDIo  Image Media Marketing Inc. /2692
+ 00:54:00 5451 00:30  AUDIO  cumulus — Mandan Progress Organs/5451
+ Q0:54:30 0718 0015 ALUDIO East 4070716
01:51:30 COMMENT BREAKSTART
+ glsslnan 5517 00:30  AUDID  Heartland Mortgage Company/5517
+ 0l:52:00 2692 01:00  AUDIS  Image Media Marketing Inc. /2692
+ 0l:53:00 1344 00:30  AUDIO  cCumulus — Joh opportunity/1344
+ 0l:53:30 1352 00:30 AUDIO MD Broadcasters associations/1362
+ 0l :54:00 5592 00:30 ALDIO red Lobster/5592
+ 01:54:30 o7la 0015 ALDIO East 40/071&
0z:51:30 COMMENT BREAKSTART
+ 02:51:30 5662 00:30 AUDIO red Lobster /5592
+ 02:52:00 5011 0L:0Q ALDIO Toma ads 5011
+ 02:53:00 5543 01:00 AUDIo  cumdlus - Job opportunity 5543 =
4 | _'I_I
[ | Ln1,col 23 v

Figure 9-10. Sample Position-Dependent Program Log

To configure the Import-Merge module for a position-dependent file, collect the following
information by analyzing your file:

. The starting position of each data type’s field (for example, Cue, Description, Length,
Scheduled Time, Filename, and so on.).

- The maximum length of each field above.

. The format of each time field (mm:ss or hh:mm:ss).

@ Tip: To find the starting position of each column easily, enable Notepad’'s Status
Bar (on the View menu, and enable the Status Bar option). The cursor’'s
position appears as column numbers (“Col #") and line numbers (“Ln #") appear
in the lower right corner of the Notepad window. Place your cursor at the start of
a column to find the position, place your cursor at the end of the column, and
then subtract that position from the previous one to get the column’s length.

9.4.3.2 Delimited Format

Delimited program logs are quickly apparent in their difference of style from position-
dependent logs. Each piece of data is separated by a specific character, with no spaces
(“white space”) between the data and the separating character. This means that each row
will have a differing overall length from other rows in your program log.

Figure 9-11 shows a typical delimited program log file. Every line and row is a single event,
and each line contains the same number of “fields”, separated by the “|” delimiting character.
This example has Cue as field 1, Scheduled Time as field 2, File Name as field 3, Length as
field 4, Category as field 5, and Description as field 6.

Page 264 of 390



P 100608KU.Ext - Notepad

File Edit

Farmat

Vigw Help

Import-Merge Module

=10f x|
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Q42
05:
052
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05
@50
Q0&:
0&:
Qe
Q&
Q&:
Q&:
0&:
Qi
Q0&:
Qe:
0&:

53:
54
a2l:
521
53
53
54
23
24 :
2
2,57
28
26
40
471 :
425
43
)

43

30
oo
30
30
Qo
30
Qo
30
30
oo
30
Qo
10
30
30
30
Qo

3962
5763
5011
5450
5459
1345
2042
4752
5641
4054
5562
L705
4343
3923
G624
3453
5708
5623

[o]4]
0o
ol
oo
00
og
00
0l
oo
00
00
0o
0o
o1
0l
0o
0o
0o

130
(15
100
130
130
130
(15
;00
130
]
130
;10
15
100
Hiele]
130
115
(15

AUDIO
ALDTO
AUDIO
AUDIO
ALUDTO
AUDIO
ALDTO
AUDIO
AUDIO
ALDTO
AUDIO
ALDIO
AUDIO
AUDIO
ALDTO
AUDIO
AUDTIO
AUDIO

Feist Electronics IncC/3962]

walker's N' Daughters Jewelers/5763|
Toma Ads 5011 |

cumulus - Mandan Progress Organs5450]
Downtowners Business Associatios5459]
cumulus - Job opportunity/1345|
schoepp Family chiropractic/2o42]|

Sun & Fun Media 4752

Morthwest Tire and auto (expres 5641
UPS Store, The 4954 |

Red Lobsters5592]|

wells Fargo Bank CAgency)/L705|
SuEeriDr Silk screenys4343|

Mobile Ads (TRADE) 3523 |

Applebees (Bismarckl /5624 |

Ramkota Hotel (Trade) 3453

skowys autoplex/5708|

Exact Med UTTCs 5623 |

| Lml,colt

Figure 9-11. Sample Delimited Program

As Figure 9-11 shows, the most common delimiting character is the “|” pipe symbol (this is
usually the upper-case character of the “\" key on your keyboard). If your file does not use
the pipe symbol as its delimiting character, you should be able to recognize it by looking at
the program log, since the delimiting character will be between each piece of data.

To configure the Import-Merge module for a delimited file, collect the following information by
analyzing your file:

« The delimiting character.

« The order of the fields in each row is (for example, Cue, Description, Length, Scheduled
Time, Filename, and so on). The left-most field is field 1, the next field is 2, and so on.

« The format of each time field (mm:ss or hh:mm:ss).

9.4.4 Block Marker Configuration Settings

1. Click the Next button or click Block Marker in the left pane.

The settings in Figure 9-12 appear.
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e

Gerersl  Import Formats |

Station
| WBSI - The Best Of BSI =]

l Music Traffic

Input Folder & File

Fieplace Text Block karker

[~ Enable Time Spnc Parameters

Input the stop-get position marker for music logs or start of

LF'Q Type stop-set block for traffic logs. Input ignore and change to
Filter Setup comment settings. Click Next when complete.

Block Maker

| In Field [Cue ]

Test

4

| Change To Comment | In Figld

|gnore | In Field

[+ =[]+

5

Yoicetrack Marker | InField

<= Back |

Lmﬁ@m

Mewt

[y Restore From Server | o OK I

X Cance |

Figure 9-12. Block Maker Settings
2. Complete the fields in the Import Formats tab (see Table 9-5).

3. Proceed to section 9.4.5.
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Table 9-5. Block Marker Fields in the Import Format s Tab

Field Description Default
Block Marker Enter your Block Marker's text. —
In Field Select the field that contains that text you entered in the Block marker field. Cue
Enable Time Sync Parameters Enables the automatic insertion of a time-next event prior to the commercial —

break created by the text specified by the Block Marker field. For example, if the
music log contained STOPSET 15:30:00, a time-next event is inserted
automatically before the commercial break with a scheduled time of 15:30:00.
You can specify an optional parameter of the number of elements preceding the
commercial break. For example, STOPSET 15:30:00, 5 inserts the time-next
event five elements prior to the commercial break.

Change To Comment To convert imported events into comments, click the Add button to the right of —
the Change to Comment field. Complete the following fields in the Change to
Comment pop-up window:

« Text = enter the distinguishing text, such as a category of “TEXT” or “NOTE”.
« Field is Empty = if the field is empty, check this check box.

« Infield = select the field where OpX One will find that text.

Buttons are also provided for editing and deleting entries.

Ignore If your log-generating software includes events that you do not want OpX One to —
import, click the Add button to the right of the Ignore field to convert imported
events into comments. Complete the following fields in the Ignore pop-up
window:

« Text = enter the distinguishing text to be ignored.

« Field is Empty = if the field is empty, check this check box.
« Infield = select the field where OpX One will find that text.
Buttons are also provided for editing and deleting entries.

Voicetrack Marker From your log-generating software (most commonly from your music log), you —
can add voicetrack markers to your program log using comments. This simplifies
voicetracking with OpX One’s Studio Client by allowing your talent to click the
NEXT button to automatically move the Voicetrack Editor to the position in the
Program Log for which they need to record the next voicetrack. To define your
voicetrack marker, click the Add button to the right of the Voicetrack Marker field.
Complete the following fields in the Voicetrack marker pop-up window:

« Text = enter the distinguishing text.

« Field is Empty = if the field is empty, check this check box.
« Infield = select the field where OpX One will find that text.
Buttons are also provided for editing and deleting markers.

9.4.5 Replacing Text Configuration Settings

If you need to auto-replace text entries in your import logs, use the Replace Text settings to
configure these entries.

1. Click the Next button or click Replace Text in the left pane.

The settings in Figure 9-13 appear.
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. Settings

Station

Gerieral  Import Formats |

Input Folder & File
Log Type
Filter Setup
Block karker

| WBSI - The Best Df BSI e

Music Traffic Test

Enter replace text settings. These allow text in a field to be
replaced with alternate text or overwrite text in another field.

FromText | InFi.. | | Mame | Cateq.. | Des.| Sche.. | 4p
[
x|
=

. 1 v H

& Back et w2

[fy Restore From Server J o OK I X Cancsl ‘

Figure 9-13. Replace Text Settings

. Click the Add button.

The Replace Text dialog box appears (see Figure 9-14).

. Complete the fields in the dialog box (see Table 9-6).

. Click OK.

If you need to edit or delete entries, use the appropriate buttons to the right of the field.
Below these are buttons for replacing and exporting txt strings and importing replace text

strings.

Page 268 of 390




Import-Merge Module

ﬁRE:pFBI;:E Texdt

From Text

|
I Field

| *]

ToFields

Cue Status
| = =

[ Scheduled HH:MM:55]

|']r.1.|.'||7|:|:||'.| — [T KespSchedulsdH
Marme I Length [MB:55]

noon —
Categari

| =
Dezcrption / Macro Event

| ; X Cancel |

Figure 9-14. Replace Text Dialog Box

Table 9-6. Fields in the Replace Text Dialog Box

Field Description Default
From Text Enter the text to be read. —
In Field Field from which the text is read. —
Cue Cue type to be inserted —
Status Status of the event to be inserted. —
Scheduled Date and time for which the item is scheduled. If unchecked, keeps the 00:00:00

scheduled time in place.

Name Name of the item. —
Length Duration of the item. 00:00
Category Category to which the item belongs. —

Description/Macro Event

Description of the audio item or the parameters of the macro.
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9.5 Importing Program Logs

Most music-oriented stations import a music log containing all the music selections to play
throughout the day, and a secondary traffic log that must be combined with the music log to
insert all the advertisements to be played. These users start the import process described in
section 9.5.1 followed by the procedure in section 9.5.2 on page 271.

For talk stations that do not play music, or for stations that have only a traffic log to import,
skip section 9.5.1 and proceed to section 9.5.2 on page 271. Conversely, to import a music
log only and not a traffic log, perform the procedure in section 9.5.1.

w 0pX Log Import / Cart Builder

9.5.1 Importing Your Music Log Eis CEdE BHG
a *r—y — I.-n. | |
BB HIO X
> To import your music log
. . . Log: @Hed Station;
1. Click the Import Using Music Import
button or click File > Using Music Format . | # | Cue | Scheduled | Actual | Name
Import Music Log @
O[g Import Music Log

The Import Music Log dialog box

appears. Station
WBSI - The Best Of BSI

&= Saturday, January 23, 2016 =

Mon | Tue | Wed | Thu I Fri | Sat | Sun I
2. Select the month, day, and year from ; 2 3
the calendar, and then click OK.
4 5 6 7 8 9 10
By default, the import function imports 1 12 13 14 15 16 17
from your locally configured import 18 19 20 21 22 2
path. To import from your File Server’s 25 26 27 28 29 30 3
import path for your station, choose the

Server option.

- Music . Traffic . Both Music & Traffic

3. Toimport a log that does not conform to R

your configured File Name Template,
click the Browse For File button on the
right side of the Local field and select
an import file. |

4. Click OK.

The events in your music log are
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: ; |
imported. A progress window shows the Itegaing cbeis ot 12 5
progress of the import, along with any ety chcks for g 14
errors or warnings. After the logs are ek e
. . . Integrating clocks for hour 17
imported, an Information pop-up window Interaling ooks o hou 18 -

ntegrating clocks far hour *
alerts you to the number of errors Inteagrating clocks for hour 20
) K :n:egra:!ng c::oc:ll:s For nour 312 i Mo errors
egrating Clocks far hour o
generated during the import process. e I )
Inte_gratln_g clocks. for hour 24
5. Click OK to remove the message. e
erify uzing air date: Tue, Moy 18,0
6. Click Done. -

() Dpen Ir Notepad | " DOME I

B

9-52 Importing Your Traffic Log

> To import your music log Bie Edit About

1. Click the Merge Using Traffic Format button | '?Jg %U @ %’ @ | H | 3‘

or click File > Using Traffic Format
Log: 1116(% Statian:

| # | Cue | Scheduled | Actual | Mame
The Import Music Log dialog box TrroTIRE Ty
appears.
Jg Import Music Log
Station

WBSI - The Best Of BSI
2. Select the month, day, and year from

the calendar, and then click OK. - Saturday, January 23, 2016 =
By default, the import function imports Mon | Tue | Wed [ Thu | Fi | Sat [ Sun |
from your locally configured import 1 2 3
path. To import from your File Server’s 4 5 6 7 8 9 10
import path for your station, choose the 1 12 13 14 15 16 17
Server option. 18 19 20 21 22 24
3. Toimport a log that does not conform to o e T e B T O T L
your configured File Name Template,
click the Browse For File button on the .Music .namc - Both Music & Traffic

right side of the Local field and select

. ] No Information
an import file.

4. Click OK to remove the message.

5. Click Done.

If you imported a music log before =
importing the traffic log, the events , |
from your traffic log and clocks are
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combined automatically with your music log events in the correct order. You can
now edit your log, add new events, or remove events from your final log before saving it.

6. To save your finished program log to the File Server, click the Save To OpX One Server
button.

9.6 Exporting/Saving a Finished Program Log

The following sections describe how to save program logs to the file server and export
program logs for use in third-party applications.

9.6.1 Saving Your Program Log to the File Server

File Server Eite Edit About

1. Click the Save To OpX One Server

button on the tool bar. ‘ yg ":ii ‘ @ $ "-r.;:;] |_ ” éﬁ

A progress window shows the progress
of the save operation.

Log,  untitled

2. Click Done to remove the window. L# | Cue | Scheduled | Actud e
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9.6.2 Exporting Your Program Log for Third-Party Ap  plications
" &, OpX Loglmport / Cart Builder - 101110 =
> To export your File| Edit About
current program Opin Log..
Cart Properties...
log for use by a [ e
third party | Swvede | [ Neme [ Length | Catsgoyy | Desription
:3’3 Using Music Format...  Ctr+M
Eg Using Traffic Format..  Crl+T
. Log From Clock... Ctrl+K
1. On the File menu, | % verty Traffic. ‘
click Export . New b
. o ’ Using Music Format..,  Ctrl+M
The aValIabIe Export * "‘é‘? Using Traffic Format.., Ctrl+T
Import CommandS %2, File Library... Using Alt.erhateFurmat
appear. W e CrleQ | XML Format Cire1
2. Click the

appropriate option
(see

5. Table 9-7).

Table 9-7. Import Options

Option

Description

Using Music Format

Exports your program log using the settings configured in the preferences for importing in music
format.

Using Traffic Format

Exports your program log using the settings configured in the preferences for importing in traffic
format.

Using Alternate Format

Exports your program log using the settings configured in the preferences for importing in
alternate format.

CSV Format

Exports your program log in comma-separated-value (CSV) format.

XML Format

Exports your program log as an .xml file. xml is the format OpX One uses natively.
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9.7 Manually Adding and Editing Program Log Events

9.7.1 Adding Audio Files Using the File Library

You can add audio files to your program log using the file library to browse through the audio
files on your File Server and then dragging-and-dropping them to your program log. This
method allows you to add audio files. You cannot use this method to add other commands to
your program log. To add macros, or any other event type, to your program log, see

Append A - Macros. B
N . . . " . N = |
> To add audio files using the file library _'-I |_J x | & 7 | %ﬂ\k

1. Click the File Library icon on the tool bar E
or click File > File Library . =5 T R S File Library | =
A File Library similar to the following | Length | Category | Descrption
appears, with all audio files from W —— .
all folders displayed. o ]
) I in Mame
2. Use the following steps to — -

. . L - Mone far Rotating Cart
enhance File Library viewing: [Music G IR | e
L. i ) P ‘% 27 |tams
— To limit the file list to show lzl l =
; ; Title [ atist | Name & [Lengh [ =]
only a single folder, click the
“'ou Showed Me Turles 402-11 00:03:05
_ H H One Fine Day Chiffons 408-10 00:02:04
drOp down IISt and CIICk the Five O'Clock Waorld Yogues 405-18 00:02:04
H Suspicion Stafford, Terry 406-03 00:02:26
desired folder. Soulful Strut Young-Holt Unlimited 40603 000254
The End Of TheWorld  Dawis, Skeeter 406-24 00:02:34
: H Ain't Mothing Like The . Gaye, Marvin & Tammi.., 409-01 oo:oz:11
— To search through the file list Pelease M (And Let... Humperdinck. Enqelber 41109 000315
H arm e aun eac oy's o i ra
by keyword, type text in the *ou Belong To Me Duprees 415-18 000233
. . YWyalking To Mew Orlea... Domino, Fats 416-04 00:01:55
Find field. The label to the Blugherry Hill Darmino, Fats 420-14 000219
. . . The Letter Box Tops 421-08 00:01:50
Wl ays RS
right of the Find field Evil v 00:02:50
ou kdake ke Feel Lik.. F 0'02'3?

indicates what column will be | N TP ]
searched. The column that i Wantane it L

WI" be SearChed iS the same Er;%;gurEves[Ediﬂ gg{anrxi'eliepneter gggiig
column by which the File List  |21951E50 e Romehian Saish £124-01 v

iS Sorted. AS Error! The Pink Fanther Koz, Dave HZo720-11 00:03:38 ZI
Reference source not

A

found. shows, the sort
indicator is in the Name column, so OpX One searches the Name column for the text
you type in the Find field.

— To refresh the list to show new items added to your file server while the File Library
window has been open, click the Refresh ﬂ button.

3. Click and drag your desired item from the File Library’s File Listand drop it into your
program log.
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— If you drop the event below another in the program log, the new event is added as
the last item in the log.

— If you drop your event on top of an existing event, the new event is added after that
event and all subsequent events shift down to make room.

'
& OpX Log Import / Cart Bullder
Bl Edt About inName
SRS NS
NS = ¥O H L) QX[+ % & i ~ e ~ ing Carts
[Musc 2 [rsosieni) 2] g0 Stat or ProgramLogs
Log untitied Station: [WOPX - The Best Rock! v
3B 27 ltems
[ Cue | Schedied | Actusl | Nome Length | Categary | Descrplion
0. 2216 0230 AriToo Proud ToBeq-~ =
: 9901 0448 [ Asist [Nome A [ Leny [ =l
21911 0240 Can e Cloary Now-n Ynu Showed Me Turtles 402-11 00:03.05
3 40207 0216 AlllHeve To Do Is Dream | One Fine Day Chiffons 405-10 00:02:04
4. 40208 0240 Chapel Of Love - Die Cul | Five O'ClockWorld ~ Voques 40518 00:02:04
1 3T YouShowed Me_ Turtes | Suspicion Stafford, Teny 406-03 000226
8 =) == P e sronitont | Soultul Strut YounaHoR Unlimited  406-08 00,0254
[ oy % Suspcon- Sakord Temy The End Of TheWorld  Davis, Skeetet 406-24 000234
9 406-08 0254 Soultul Strut - Youna-Hot | | Ain't Nothing Like The .. Gaye. Manvin & Tammi... 409-01 00:0211
0 . 40624 0234 The End Of The World - D | Release Me (And Let .. Humperdinck. Engelbert 411-08 00:0315
! ; . :?‘s-g; % 1 ; Aot “°"".2“ti’; Warmth Of The Sun Beach Boys q11-n 00:02:45
1 o g Warmnorhe Bompe,Fais dede  Qooree
11 4518 0233 YouBelona To Doming. F 2014 000219
15 41604 0155 Walking To New orina, Fels
6+ 42014 0213 Blueberry Hill ) BoxTops 421-08 00:01:50
17 42108 0150 The Letter - Box Tops Santana 421-09 00:02:50
8 . 42109 0250 Evil Ways - Santena Franklin Aretha 421-23 00.02:37
Stevie Nicks & Don He.. 55751 00:03:2
Leather And Lace - Stevie Nicks & Don Henley v David Lee Roth 56787 000239
My o Pretenders 57718 00:05:19
m Cream 57718 00:0454
! -2-3 Barry. Len 601-24 00:02:20
In Your Eves[Edn'I Gabriel Peter 922-01 00:04:48
AngellEdil] McLachlan, Sersh 982-04 000358
AHorse With No Name America c124-01 00:04:07
The Pink Panther Koz, Dave HC0720-11 00:03:38 —
 DONE

Figure 9-15. Dragging and Dropping from the File Li  brary File List to the Program Log

9.7.2 Adding New Events Manually

> To add new events manually
1. Inthe program log, click the event above which you want to insert the new event.
2. On the Edit menu, click Insert New Item .

An Adding New Item dialog box similar to the following appears.

ddng vewttem x
Status Cue  Scheduled Actual Name Length Category  Description
| |@ j100600 | | | |MACRD  [DEVICE ACS82, ON
Modify [~ [V v - - u v v
Check the field's Modify box to update the corresponding field in the selected
record. |f unchecked the field will be remain unmodified o 0K I X Cancel |
To clear a field, cmhnndfyboxumdbavelhee&hddu'fﬂy

3. Click in each field and enter the data pertinent to your event.

4. Click OK.
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9.7.3 Editing Events in Your Program Log

> To edit events in your program log
1. Inthe program log, click the event you want to modify.
2. On the Edit menu, click Edit Fields .

An Edit Item dialog box similar to the following appears.

I x|
Statuz Cue  Scheduled  Actual Mamz Lenath Cateqon Deseription
[ [+ [ooeon | | | [MACRO  |DEVICE ACSE2, OFF
Modify [ [ = I o I r v

Check the field's Modify bos to update the corresponding field in the selected
record, IF unchecked the figld will be remain unmodified ' I |
To clear afisld, check the madify bax and leave the edit fisld smpty. "/ ok x el

Figure 9-16. Edit Item Dialog Box
3. Click in each field you want to change and edit the value.
When you enter a value, the corresponding Modify box gets checked automatically.

4. To clear a field, check the Modify check box and leave the corresponding entry blank.
5. Click OK.

9.7.4 Changing the Cue Type of Events In Your Progr am Log

The editing method described in section 9.7.3 allows you to edit all fields of an event in your
program log. Sometimes, however, you need only change the cue type of an event.

> To change the cue type

1. Click the event in the program log.

2. Press the key on your keyboard for the new cue type you desire:
— To set your event’s cue type to Auto Start, press the + key.
— To set your event'’s cue type to Time Immediate, press the @ key (Shift+2).
— To set your event’s cue type to Time Next, press the # key (Shift+3).

— To toggle the event to Manual, press the same key as the existing cue type.
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9.8 Working with Carts

9.8.1 Creating a Cart

You create a cart using the same procedure you use to create a program log. A cart is like a
mini-program log. Carts allow you to create a singular item that contains links to multiple
audio files and/or macros. When creating a program log or Hot Key, you can insert a single
cart that you created instead of inserting multiple items to do the same thing. When creating
a trigger set, scheduled event, or program log, using carts instead of single event, allows
you to execute multiple items in succession.

The way carts behave depends how you set the cue types of the events in the cart. See
Table 9-8.
Table 9-8. Cart Behaviors

Cue Type Cart Behavior

All events in the cart have Manual Start (blank) cues When you first play the cart, only the first event is played, and then the cart
stops. The next time the cart is played, only the next event in the cart is
played. The third time the cart is played, only the third item is played. This
sequence continues until the cart is played enough times that all items in
the cart have been played. At this point, the next time the cart is played, it
starts from the top again. This type of cart is referred to as a “rotator.

All the events in the cart have Auto Start (+) cues. When you play the cart, all events in the cart play in succession, from the
first event in the cart through to the last event in the cart.

Some events have Auto Start cues and some have The cart plays in order from top to bottom, continuing to play events from

Manual Start cues. the cart until the cart encounters a Manual Start event, at which point the

cart stops. The next time you play the cart, it starts from where it left off
(the Manual Start item it stopped on last time) and plays the rest of the
events until it encounters another Manual Start event. This sequence
continues until the cart is played enough times that all items in it have been
played. At this point, the next time the cart plays, it starts at the top again.

> To create your cart
1. On the File menu, click New, and then click New Cart.

2. Add events to your cart using the File Library (see section 9.7.1) or by using Edit > Insert
New Item (see section 9.7.2).

¢ Note: All events in a cart must have either an Auto Start (+) or Manual Start
(blank) cue type. No other cue types are valid.

3. After you add the items to the cart, save the cart (see section 9.8.3).
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9.8.2 Editing a Cart

> To edit a cart

1. Create a new cart.

Using the File Library, find the cart you want to edit and drag it into the new cart.

N

The events are placed into the new cart and the file name is updated with the name of
the existing cart.

Edit, add, or delete events from the cart.

w

Click the Save To File Server button to overwrite the previous file of the same name or
click File > Save As to save the file under a different name, and then click OK.

»

9.8.3 Saving a Cart

< OpX Log Import / Cart Builder

> To save the current cart (File Edit  About -
. . > A ] y | .
1. Click the Save To File Server button on Jg $ | g @’ { 9 | H a\g
the tool bar. = ™
Log:  untitled
_ | # Cue | Scheduled | Actual | Name
You are prompted with the Name &
Type dialog box. x|
(" Wirtuial Cart
€ Rraoran Log
2. In the Name field, enter a file name for Name
your cart. [My Cart
3. Click the OK button.
Your cart is saved to the File Server, W Ok X Carcel |
making it available to your station’s &

Audio Server.
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10 Info Editor Module

Topics: This chapter describes the OpX One Info Editor module.
A Starting the Info Editor The Info Editor module allows you to edit all available
Module (page 280) tags; set intro, segue, and hook times; and transfer audio

. files to the File Server.
4 Quick Tour (page 281)

4 Setting Intro and Segue
Times (page 289)
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10.1 Starting the Info Editor Module

You must start the File Server module before you start the Info Editor module.

> To start the Info Editor module

1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > InfoEdit

A BS Info Editor window similar to the following appears.

‘ & BSIInfo Editor o[ -E () ‘
[ Deskiop =~ Qmipe!mmw I MW:WLGGTM Lﬁ” I
PREPYDHYXOAX BAE@E Title / Description
Name Size | Modiied [

Atist / Advertiser
gnvoommzl |
<4 DVD RW Diive (F:)
&, Local Disk () Start Date & Time (24 hr.) Time Window (24 hr.)
77 ol & |
End Date & Time (24 hr.) To
Za it RS
[0 Q0 | & Tones ¢ |[HPPRA
From start Length From end
[omooo [ [ 00000
I}
Intro Segue
[ | 37
OutCue
|
Format
e =
I~ No fade at seque
Location
|
HS&‘-.’E I an
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10.2 Quick Tour

The following sections provide a quick tour of the Info Editor module interface.

| B Desktop
PREFDYXBX|(BE- @

Start Date & Time (24 hr.)
7 gr o
End Date & Tiraﬂ he)

a1l

Time Window (24 hr.)

To

|

Io 0 o | & Tones
From start Length

[“ooo00 [ [ ooo00

C B

From end

J

Intro N Segue .
—d Elpz
OutCue

|
Format

DIO ~|

™ No fade at seque

(1) File list. See section 10.2.1.

(2] Tabbed section. See section 10.2.3.




10.2.1 File List

The Info Editor’s file list allows you to browse to any folder available on your workstation. It
displays folders and audio files to simplify navigation through your audio files.

Info Editor Module

) Spots _ﬂ
= - -, LS \] bad ah
2@ DXOX[E
Table 10-1describes the tools on the file list.
Table 10-1. File List Tools
Tool Tool Name Description Tool Tool Name Description
Go up to parent | Shows the contents of the Cut Copies the highlighted
» folder folder that contains the x | file to the Clipboard,
folder you are viewing. but once you paste the
file to another location,
the file is removed from
its current location.
Refresh current | Updates the files and folders Paste Puts a cut or copy of
Lﬂ | folder in the file list. :} | the file currently from
i | , the Windows’
Clipboard to the
directory displayed in
the file list.
Go to selected | Brings the item in the tabbed Delete Moves the highlighted
é item section of the Info Editor into x file in the file list to the
view on the file list. Useful if Windows’ Recycle Bin.
you scroll the file list away
from the tab’s displayed file
and want to find it.
: Find Finds the first audio file in Select Columns Allows you to add or
ot the file list based on your @ remove the columns in
. criteria. the file list.
Find Next Finds the next audio file Favorites Adds the displayed
using the criteria entered | folder to a list of
\33 using the Find button. : favorite locations. Click
the drop-down button ¥
to access or edit a list
of favorite locations.
Copy Copies to the Windows Explore current Opens Windows
Qi'] Clipboard the currently folder Explorer to the Info

highlighted file in the file list.

Editor’s currently
displayed folder.
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10.2.2 Editing Multiple Files

The Info Editor can edit the tags of multiple files at the same time.

> To edit multiple files
1. Click the Select Columns button.

The column for the tag you want to modify appears.
2. Click the first file you want to edit.

3. To edit additional files, perform the appropriate step:

— If the files are contiguous to the one you clicked in step 2, hold sown the Shift key
and click the last file. All files between the first and last ones you clicked are selected

automatically.

— If the files are not contiguous, hold down the Ctrl key and click each additional files.

— If you change your mind about a selected file, hold down the Ctrl key and click the file

to deselect it.
4. With all your files selected, right-click the column title.

A Category pop-up window appears.

Name | Size | Modified | Categor | ~l

4] Copy of GC1747 FAIRGR... ~ 5172KB 03/31/2008 4:22:30 .. Category X

=) EMERALD POOL & PATI..  5226KB 03/31/2008 4:22:28 ..

A FORREST PAINT -LAN...  5211KB 03/31/2008 4:22:26 .. |SPOTS

4] GC 1655.wav 5199KB 03/31/2008 4:22:14 .. 24 h)
~] GC 1750 092607.wav 5224KB (3/31/2008 4:22:14 .. Set Clear | 00
+| GC 1751 092607.wav 5224KB (03/31/2008 4:22:14 .. :

~| GC 1753 092607.wav 5224KB (03/31/2008 4:22:16 .. w4 hr)
+| GC1743 CIVIL WAR wav 5172KB 03/31/2008 4:22:28 ... [12/3172012 [} [23:59
#/GC1744 LUQUIDATION .. 5157KB 03/31/2008 4:22:28 ..

#| GC1745LIQUIDATION 2. 5,172KB 03/31/2008 4:22.28 ..

#| GCI746FAIRGROUND ... 5172KB  03/31/2008 4:22.20 .. &
#| GC1747 FAIRGROUND ... 5172KB 03/31/2008 4:22:14 ..

+| GC1748 ITASCA wav 5193KB 03/31/2008 4:22:14 .. From start Leng

5. Enter the data you want to apply to all the selected files, and then click the Set button.

OR

To “blank-out” the entries for the highlighted files, click the Clear button.

OR

To cancel the procedure, click on the pop-up window’s Close button in the top-right

corner.
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10.2.3 Tabbed Section

The Info Editor's tabbed section has seven tabs to allow you to enter various data into your

audio files.

> To edit an audio file's tags

1. Using the File List on the left side of the Info Editor, browse to the file whose tags you
want to edit, and then click it.

2. Edit the file’s tags in the Info Editor’s tabs on the left side of Info Editor.

The following sections describe the Info Editor tabs.

10.2.3.1 Fields in the Description/Times Tab

Authoring | Commercial | Music | Classical | About
Description / Times | Server I Album

Title # Description

Option Description I
Title/Description Enter the name of your audio file. Artist / Advertiser
Artist/Advertiser Enter the name for the creator of the !
file Start Date & Time (24 hr.) Time Window (24 hr.)
Start Date & Time Sets the date range and time your file i EI : g : g
is to be played. End Date & Timﬂ&t hr.) To
/7 5 : E
Time Window When entered, the audio file will only : g
be playable between the hours
selected. 00O & Tone p
Play/Stop/Pause buttons Allows you_to preview your file inside From start e From end
the Info Editor. 00:00.0 00000
Tones/Hook When you set tones, you can set both ' '
regular Intro and Secondary Tones. J
You can also set Hook Tones for use Intro Segue
with Simian's Hook Cart functionality. = 21T 5|
d l%d lZd
From start Allows you to see how far the slider is OutCue
from the beginning of the file during |
playback.
Category Format
Length Shows the length of the file. 4UDIO =
I~ Nofad
From end Allows you to see how far the slider is ° S
from the end of the file during focelin
playback. |
Slider Allows you to scrub through the song during playback. You can see the Tones or Hook within
the slider: Look for white space at both ends of the blue bar under the slider. The white at the
beginning is your intro and the white at the end is your segue.
Intro button Visible when Tones is selected. This button allows you to set the intro tone for the audio file,

while the time window allows you to see exactly where the tone is set.

Segue button

Visible when Tones is selected. This button allows you to set the Secondary Tone for the audio
file, while the time window allows you to see exactly where the Secondary Tone is set.
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Option Description
Outcue Text that appears in the decks as the song is going out.
Hook Start Visible when Hook is selected. Allows you to set the start for the "hook” for the audio file.
Hook End Visible when Tones is selected. Allows you to set the end for the audio file's "hook."
Category You can assign a category to a file so that it will always display the correct category in the audio
list and event builder
Format Shows the file attributes of your file.

No fade at segue

Assures that the file will never fade out at the end no matter what settings are configured in
Simian. Great for spots.

Location

Shows you where the file is stored on your hard drive.

10.2.3.2 Fields in the Server Tab Sever |

WKGL - Spots

Option

Description =@ Stations

Folder List

=@ WKGL - 96.7 The Eagle

Browse to a stations’ audio folder. i
(= Spots

Save To Server button

Click this button to transfer the currently — g::'; %

loaded audio file to the selected folder on = Music
the file server. 7 Program Logs

= Runlogs
y Carts
Voicetracks
Temporary
Imaging
Fill Material
Liners
Jingles
7 Promos
+ @ WROK - News Talk 1440
+ @ wWXXQ -0-985
+ @ WZ0K - 97 Z0K
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10.2.3.3 Fields in the Album Tab

Option Description
Album Enter the album name.
Year Holds the year information for the file.
Genre Holds the genre information for the file.
Track# Holds the track information for the file.

10.2.3.4 Fields in the Authoring Tab

Album

Album

[Disintegtation

Year

1989

Genre

lAllemative

Track #

s

Option Description
Producer Holds the producer information for the file.
Talent Holds the talent information for the file.
Composer Holds the composer information for the file.
Publisher Holds the publisher information for the file.
Copyright/Record Holds the copyright information for the file.
Company
Comments Holds any comment information that you

want to include in the file.

Authceng |
Producer

[Emﬂm
Talent

Robert Strth
Simon Galup
Pod Thompson
Boas Wikams

Composer

[Robert Sth
Publsher

[WEA
Copyaght / Record Compary

[Elekuo
Comments
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10.2.3.5 Fields in the Commercial Tab

Option Description
Agency Holds the agency information for the file.
Account Holds account executive and sales person
Executive/Sales information.
Person
Copy Holds information you want to add to the file.

This tag can be displayed in a text box within
Simian any time the file is played. Select
Tools/Program Options/General and check
in Display Copy Field option.

URL

You can associate a URL with each file and
then send that URL to the Dynamic HTML
Page, or the MS Encoder.

10.2.3.6 Fields in the Music Tab

Commercial

Agency

[The BSI Agency!

Account Executive / Sales Person

[J ohn Doe

Copy

URL

http: \Mwww. bsiusa.com

Option Description
Key Holds the key in which the cut was
performed.
End Holds information about how the cut ends.
Energy Common descriptor for audio cuts.
Texture Helps you sort your cuts by audience.
Tempo Holds the tempo in which the cut was

performed.

Beats Per Minute

Holds the BPM information for the file.

Key

End

[Fade
Enetgy

[Metow
Testue

[Core

[Medim Siow
Beats per mnute
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10.2.3.7 About Tab

The About tab shows the Info Editor
version, a link to the BSI website, and
information about the versions of
supporting dynamic link library (DLL)
files.

The Output device for audition
drop-down list allows you to select the
audio device you want to use for
playback while you're tagging files.

To force your computer to use the
Windows’ CODEC instead of on-
soundcard CODECSs that you may
have, check Force use of ACM
CODEC.

About

7

Broadcast
Software
International
Fs,
BSI ) Visit BSI on the Web

Info Editor / Tagger
0.0.0.15
Copyright © 2006 Broadcast Software International

Module Version
HolyGrl32.dll 4,0,0,58
wavinfo32.dll 4004

Output device for audition
| Speakers (2- High Definition Au |

[~ Force use of ACM CODEC
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10.3 Setting Intro and Segue Times

Setting intro and segue points in your music files is critical to smooth-sounding transitions
between songs on a music station. The Info Editor makes it easy to set intro and segue
points.

> To set intro and segue times

1. In the file list on the left side of the Info Editor, browse to and click the audio file to which
you want to add intro and segue points.

The file loads into the tabbed section.

-] 07 Lights in the Sky.wav
\ 08 Corona Radiata.wav 1
9 The Four of Us are Dy...

-l am - ~ '

M N L

2. Go to the Description/Times tab on the tabbed section of the Info Editor.

Sunonng | Lommercial | Music | K200
Description / Times I Server Albu
Title / Description

|Corona Radiata
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3. To set the intro point of your song, click the Play button to start playback of your
audio file.

%o @  © Tones ( Hook

Fror Play (Ctrl+P) Length From end
00 10:08.0 10:08.0

4. As your audio file plays back, listen to the track. When the track gets to the point
where you want to set your intro point, click the Set Start ﬁ' button.

From start Length From end
00:24.9 10:08.0 09:43.1

[

Intro Seque

—ﬂz[y [
e — U I m—

5. If you want to re-set the intro point, move the pointer on the scrubber back in the
file.

Inten Canmia
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6. To fine-tune your intro point, click the Fine Adjust buttons to increase or decrease the
intro point in tenths of a second.

Intro Seque
00:23.3 ;l‘[é pd I
Nt e

7. You add the segue point using the same procedure that is used to add the intro
point. The only difference is that you click the Set End button to set the segue
point.

From start Length From end
09:42.6 10:08.0 00:25.4

| [

Intro Seque

o233 | | oG /f !

OutCue et End (CtrI+E)]

8. Re-settings or adjusting the segue point uses the same technique shown in step
3.
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11 FTP Server Module

Topics: The FTP Server is automatically launched by the File
Server when it starts up. Under normal circumstances,
users will not need to interact with the OpX One FTP
Server.

4 Starting the FTP Server
Module (page 293)

+ Quick Tour (page 294) This chapter describes the OpX One FTP Server

4 Configuring the FTP module.

Server Module (page 299) The FTP Server module is responsible for transferring

4 Starting and Stopping the files to the audio servers.
FTP Server (page 299)
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11.1 Starting the FTP Server Module

» To start the FTP Server module

1. Start the File Server module (see section 3.1), which will automatically launch the OpX

FTP Server.

2. Look for the OpX FTP Server icon in the “System Tray”

w1114 AM

by the Windows System Clock (as shown at right). Hold -5 | S R 03713018 MR
down the CTRL key on your key while double-clicking
on the OpX FTP Server icon.
An OpX One 1 OpXFTP Sever = =
FTP Serv.er. File Edit About!
window similar

Files || 14:33:36

to the following

[> [E el 0 (MGG o [EEVEES o [T O |

appears. [13:46:10] File modified: D:\WWESIA\ConfighSerialServer Settings. #ml

[13:46:10] File modified: D:\WWESI\ConfighSerialServer Settings. #ml
[13:46:30] File modified: D:\WWwWEBSI\ConfighDevice TALKT #ml
[13:46:30] File modified: D-"\WESIA\ConfighSenalServer Settings. sml
[13:46:30] File modified: D:"WWESI\ConfighSerialServer Settings. sml
[13:46:44] Storing updates for; D:YMWEBSIAConfigiDevice_AUDT, xml
[13:46:53] File modified: D:"WES|\ConfighDevice AIDT wml
[13:46:53] File modified: D:\WESIA\ConfighDevice ALIDT wml
[13:48:53] File modified: D:\WEBSIA\ConfighS enalServer Settings. sml
[13:48:53] File modified: D:\WESI\ConfighSenalServer Settings. sml
[13:47:04] Storing updates for; D:NWES I ConfighDevice TALE. wml
[13:47:24] Storing updates for: D:MWES I ConfighSenalServer S ettings.wml
[13:47:31] Storing updates for: D:NWESIAConfigiDevice 407 xml
[14:24: 18] FTP Server started

m

Type | Address Station | Module | Status

Last Reply.
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11.2 Quick Tour

The following sections provide a quick tour of the FTP Server module interface.

| 1 OpXFTP Server o] @ ==
(1) File Edit About!

—o P el PNl Dol s M Fies D EIEEEESE

13:46:10] File modified: D:\WBSI\ConfighSerialServer Settings.xml -
13:46:10] File modified: D:\WBSI\ConfighSerialServer Settings.xml
13:46:30] File modified: D:\WBSI\Config\Device_TALK1.xml
13:46:30] File modified: D:\WBSI\ConfighSerialServer Settings.xml
13:46:30] File modified: D:\WBSI\ConfighSerialServer Settings.xml
13:46:44) Storing updates for: D:\WBSI\Config\Device_AUD1.xml
13:46:53] File modified: D:\WBSI\ConfighDevice_AUD1.xml
9 _|.L1 3:46:53] File modified: D:\WBSI\ConfighDevice_aUD1.xml

[13:46:53] File modified: D:\WBSI\ConfighSerialServer Settings.xml
[13:46:53] File modified: D:\WBSI\Config\SerialServer Settings.xml
13:47:04] Storing updates for: D:\WBSI\Config\Device_TALK1.xml
13:47:24] Storing updates for: D:\WBSI\Config\SerialServer Settings.xml
13:47:31] Storing updates for: D:\WBSI\Config\Device_aUD1.xml
14:24:16) FTP Server started

m

Type Address Station Module Status Last Reply
(4] °
4
Number Description
(1) Menu bar. See section 11.2.1.
(2] Tool bar. See section 11.2.2.
© FTP server status. See section 11.2.3.
(4] FTP server status list. See section 11.2.4.
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FTP Server Module

The menu bar appears at the top of the FTP Server window. The following sections describe

the menu options.

11.2.1.1 File Menu

Edit About!
Build Databases

Exit

11.2.1.2 Edit Menu

File About!

Q Settings
@ v Status Display

11.2.1.3 About Menu

File Edit  About!

Build Databases = rebuilds the FTP Server
database.

Exit = exits the FTP Server module.

Settings = configures FTP Server module
settings. See section 11.3.

Status Display = shows (checked) or hides
(unchecked) the status display.

Opens a window that shows the version and
build date of the FTP Server module you are
running. This window also shows the amount
of memory, virtual memory being used, and
the amount of time that the FTP Server has
been running. See Figure 11-1 for an example.
To close the window, click OK.
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'-A'hnut

v0.0.0.83 +

Build Crate:
Apr 15 2013 07:45:42

m

b emom Usage:
14,600k, /14,876

W Llzage: [
10,003k, 4 10.276K

Running Time: 2 Hours, 3 Minutes, 38 Seconds

Figure 11-1. Example of About Information
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11.2.2 Tool Bar

The FTP Server module tool bar appears below the menu bar.

b TcPfll FTPE Data [l Sync T Fies | 14:33:36 |

Table 11-1describes the tools on the tool bar.
Table 11-1. FTP Server Module Tool Bar

Tool Tool Name Description
Start FTP Server Starts the OpX One FTP server. See section 11.4.
Stop FTP Server Stops the OpX One FTP server. See section 11.4
TCP Shows the number of files transferred via TCP.
il 0 |
FTP Shows the number of files transferred via FTP.
Fre R
Data Shows the number of pending database updates.
Data -
Sync Shows the number of files remaining to be synchronized between the FTP
Sync - Server module and the File Sync module.
Files A color-coded field that shows the status of the transfers.
Files . « Green = normal operation.
+ Red = problem with transfers.
Clock Shows the amount of time that the OpX One FTP server has been
[ 14:35:36 | rning
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1 1 2 3 FT P Se rver 13:46:10] File modified: D:\WBSI\Config\SerialServer Settings.xml

"= 13:46:10] File modified: D:\WBSI\Config\SerialServer Settings.xml
13:46:30] File modified: D:\WBSI\Config\Device_TALK1.xml

Stat u S 13:46:30] File modified: D:\WBSI\Config\SerialServer Settings.xml

13:46:30] File modified: D:\WBSI\ConfighSerialServer Settings.xml

13:46:44] Storing updates for: D:\WBSI\Config\Device_AUD1.xml
13:46:53] File modified: D:\WBSI\ConfighDevice_AUD1.xml

The FTP Server Status ShOWS 13:46:53] File modified: D:\WBSI\Config\Device_AUD1.xml

13:46:53] File modified: D:\WBSI\ConfighSerialServer Settings.xml

any aCthlty on the FTP Server 13:46:53] File modified: D:\WBSI\ConfighSerialServer Settings.xml
. 13:47:04] Storing updates for: D:\WBSI\Configh\Device_TALK1.xml
mOdUle, such as files that are 13:47:24] Storing updates for: D:\WBSI\Config\SerialServer Settings.xml
. A 13:47:31] Storing updates for: D:\WBSI\Config\Device_AUD1.xml
being retrieved and the status of 1425 1G] FIF evon st

the FTP Server itself.

11.2.4 FTP Server Status List

The bottom of the FTP Server module shows the FTP server status list. This list shows
status of various connections to the FTP Server module.

Type Address Station Module Status Last Reply
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11.3 Configuring the FTP Server Module

Before you use the FTP Server module, you must configure its settings. After setting up the
FTP Server, you add devices with which the module will communicate.

> To configure the FTP Server module settings
1. On the Edit menu, click Settings .
The Settings dialog box appears.

Settings @
Network Interface

[10.1.1.10- OpX ~|

[~ Reindex Databases On Rebuild

v 0K X Cancel l

2. Complete the fields in the dialog box (see Table 11-2).

3. Click OK.
Table 11-2. Fields in the Settings Dialog Box
Field Description Default
Network Interface If the OpX One system detects multiple NICs, this drop-down list allows you 10.1.1.10 - OpX
to select the NIC you want the FTP Server to use. If you have a single NIC One
on your machine, the FTP Server selects that NIC automatically, and the
drop-down will be gray and unavailable.
Reindex Database On Rebuild Do not change the default setting unless otherwise instructed by BSI Unchecked
support.

11.4 Starting and Stopping the FTP Server

> To start the OpX One FTP server

»
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1. Click the Start FTP Server button

A message in the FTP server status list shows that the FTP server started. If this
message does not appear, check the FTP server settings (see section 11.3).

> To stop the OpX One FTP server

1. Click the Stop FTP Server button
A message in the FTP server status list shows that the FTP server stopped. If this
message does not appear, check the FTP server settings (see section 11.3).

Page 300 of 390



OPYONE

12 Data Repeater Module

Topics: This chapter describes the OpX One Data Repeater
i module.
4 Starting the Data
Repeater Module (page The Data Repeater module takes the PAD data output
302) from the Audio Server, reformats it if needed, and sends
it to multiple destinations, such as to RDS or stream

4 Quick Tour (page 303) encoders

4 Working with Data
Repeaters (page 307)

4 Changing the Network
Interface and Port (page
313)

4 Starting and Stopping the
Data Repeater (page 313)
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12.1 Starting the Data Repeater Module

You must start the File Server module before you start the Data Repeater module.

> To start the Data Repeater module
1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > OpX One
Repeater .

An OpX One Repeater window similar to the following appears.

(@ OpX Repeater o E )
File About
[ 15:33:36 |

4
Listen Network Interfface ;I%Pm #Newl % | 171 LIL‘

[10.1.1.10-0pX

[~ Active l

& UDP ¢ TCP I~ Connect/Send/Disconnect (" HTTP
Network Interface

[10.1.1.10 - OpX ~|
Address Port

[0 .0 .0 .0 |

" Serial COM1, 9600. N, 8. 1 Configure
Default Title Default Arist —‘

| Delay Repeat Last Every Substitutions |
* These are used when a STOP trigger is received. lo %ms Io %m

“ | ¥ Append CR/LF
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12.2 Quick Tour

The following sections provide a quick tour of the Data Repeater module interface.

) OpX Repea

File

o ’,i [ 15:33:36 ]

Listen Network Inteface Listen Port
New Del 1/1
(3) [101110-0px | ooonm ptew | x| / | =]
— Adive ——| -
@ UDP (" TCP I Connect/Send/Disconnect ¢~ HTTP
Network Interface (5]
]10.1.1.10-0pX =1
Address Port
Jo.0.0.0 |
c [ comi.se00.N.81
. - Serial COM1, 9600, N. 8, 1 Corfigure_|
l I Delay Repeat Last Every Substitutions
* These are used when a STOP trigger is received. lo_@m 0 o T—e'
‘ + | ™ Append CRALF

Menu bar. See section 12.2.1.

Tool bar. See section 12.2.2.

Data repeater seftings. See section 12.2.3.

Data repeater status list. See section 12.2.4.

Data repeater parameters. See section 12.3.
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12.2.1 Menu Bar

The menu bar appears at the top of the Data Repeater window. The following sections
describe the menu options.

12.2.1.1 File Menu

About
Exit

Exit = exits the Data Repeater module.

12.2.1.2 About Menu

Opens a window that shows the version and

File | About build date of the Data Repeater module you
are running. This window also shows the
amount of memory, virtual memory being
used, and the amount of time that the data
repeater has been running. See Figure 12-1
for an example. To close the window, click
OK.

[ About |

0.0.0.103 +

Build Drate:
Jun B 2014 20:19:57

m

b emary zage:
7.956E, / 8,956k,

Wi Llzage:
4852/ 4.852F,

Running Time: 0 Hours, 0 Minutes, 28 Seconds

Figure 12-1. Example of About Information
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12.2.2 Tool Bar

The Data Repeater module tool bar appears below the menu bar.

b [ 15:43:38 |

Moving the screen pointer over a tool displays the tool’s function as a tooltip. For example:

OpX Repeater
File About

h}l

Sta rt l.b Lo mof mmm

Table 11-1 describes the tools on the tool bar.

Table 12-1. Data Repeater Module Tool Bar

Tool Tool Name Description

Start Starts the Data Repeater. See section 11.4.

Stop Stops the Data Repeater. See section 11.4

Clock Shows the amount of time that the Data Repeater has been running.

10E
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12.2.3 Data Repeater Liston Network Interface Listen Port
Interface and Port 10.1.1.10 - OpX 4 § 1000

The Listen Network Interface and Listen Port fields show the IP address and port that the
current data repeater is using to communicate.

If the OpX One system detects multiple NICs, this drop-down list allows you to select the
NIC you want the data repeater to use. If you have a single NIC on your machine, OpX One
selects that NIC automatically, and the drop-down will be gray and unavailable.

If you want to change the port number that the current data repeater is using, change the
value in the Listen Port field.

12.2.4 . Data Repeater Status List

The data repeater status list shows when the OpX One data repeater is listening using the
IP address and port number shown in the list. The IP address and port number are
separated by a slash (/). This list also shows when the data repeater stops.

[15:51:25] Listening on 0.0.0.0 / 1000 -
[15:51:29] Stopped

[15:54:27] Listening on 10.1.1.10 / 1000

[15:54:31] Stopped
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12.3 Working with Data Repeaters

The right side of the OpX One Repeater window provides buttons and fields for creating,
editing, and deleting data repeaters.

dlNew | 0o | 171 | -]

[~ Active |

(¢ UDP ¢ TCP [ Connect/Send/Disconnect (" HTTP
Network Interface

[10.1.1.10-OpX ~|
Address Port

" Seral COM1, 9600, N. 8. 1 Configure |

Delay Repeat Last Every Substitutions |
0 [%ms |0 [2%]seconds Template |

v Append CR/LF

12.3.1 Creating a Data Repeater

> To configure a data repeater

1. You cannot create a data repeater while another data repeater is running. Check the data
repeater status list to ensure that a data repeater is not running. If one is running, click
the Stop button on the tool bar.

2. Click the New button N |

3. Complete the fields on the right side of the window (see Table 12-2).
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Table 12-2. Fields in the OpX One Repeater Window

Field Description Default
Active You can set up multiple rata repeaters, but only one can be active. To make Unchecked
this repeater check this check box.
UCP/TCP/HTTP Select the protocol that the data repeater will use. Ucp
Network Interface If the OpX One system detects multiple NICs, this drop-down list allows you 10.1.1.10 - OpX
to select the NIC you want the Data repeater to use. If you have a single One
NIC on your machine, the Data repeater selects that NIC automatically, and
the drop-down will be gray and unavailable.
Address Enter the IP address for the data repeater. 0.0.0.0
Port Enter the number of the port that the data repeater will use for —
communications.
Serial If the device with which the data repeater will be communicating requires COM1, 9600, N,8.1
serial parameters be configured:
1. Click Serial.
2. If the serial device uses settings other than the OpX One defaults, click
the Configure button to display the Serial Device dialog box (see Figure
12-2).
3. Configure the settings based on the requirements of your serial device
(refer to the documentation for your serial device).
4. Click OK.
Delay Number of milliseconds between when data is received and when data is 0
transmitted. This feature can be used to guard against profanities from being
sent over the airwaves.
Repeat Last Every Number of seconds when received data is transmitted repeatedly. 0
Substitutions button If substitutions are applicable to your setup: —
1. Click the Substitutions button to display the Substitutions dialog box (see Figure
12-3 on page 309).
2. Click the Add button il to display the Substitutions dialog box (see Figure
12-4 on page 310).
5. 3. Complete the fields in the dialog box (see
Table 12-3 on page 310).
4. Click the OK button two times.
The Substitution dialog box also has buttons for editing and deleting substitutions.
Template button If templates are applicable to your setup: —
1. Click the Template button to display the Template dialog box (see Figure 12-5 on
page 311).
2. Click the buttons at the top of the dialog box to define your template.
3. Click the OK button.
Append CRILF « Checked = appends a carriage return when a line feed is received. Checked

Unchecked = do not append a carriage return when a line feed is
received.
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[ Vo] _oma

Figure 12-2. Serial Device Dialog Box

| Cantition | Fromalue | Action | NewYalues

Figure 12-3. Substitutions Dialog Box
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i Substitution

Field

Condition
lCorrtains LJ

From Valus

" |gnore

~{% Substitute
WNew CutlD New Folder
Wew Title New Cateaory
Mew Artist MNew Type
Mew Length

[ o] ceed |

Figure 12-4. Substitution Dialog Box

Table 12-3. Fields in the Substitution Dialog Box

Field Description Default
Field File to be searched for a specific string of text. —
Condition Condition associated with the search. Contains
From Value String that is being searched. —
Ignore Allows you to skip the data shown at the bottom of the dialog box. —
Substitute Replaces the string with the values shown at the bottom of the dialog box. —

¢ Note: Leave the tab blank for raw output.
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-

Template

EutID] TitIeJ Artist] Len I mm:ssi Fldr I Cat I T_vpe]

| oK X Cancel |

Figure 12-5. Template Dialog Box

12.3.2 Editing a Data Repeater

There may be times when you need to edit a data repeater. For example, you might have to
change the serial settings.

> To edit a data repeater

1. You cannot edit a data repeater while a data repeater is running (either the one you want
to edit or a different repeater). Check the data repeater status list to ensure that a data
repeater is not running. If one is running, click the Stop button on the tool bar.

2. On the right side of the OpX One Repeater window, use the scroll arrows to find the data
repeater you want to edit (see Figure 12-6). The field to the left of the arrows shows the
number for the current data repeater and the total number of data repeaters that have
been set up (for example, 2/5 means the settings for data repeater number 2 is displayed
out of 5 data repeaters that have been set up).
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4 New | 3 Del | 2/5 ﬂ k Scroll arrows

[ Active |
(« UDP ¢ TCP [ Connect/Send/Disconnect ¢ HTTP
Metwork Inteface

110.1.1.10 - OpX ~]
Address Port
|l o .0 .0 .0 |

" Seral COM1, 9600, N, 8,1 Configure

Delay Repeat Last Every Substitutions
|D % ms |D % seconds Template

v Append CRALF

Figure 12-6. Scroll Arrows
3. Change the fields on the right side of the window (see Table 12-2 on page 308).

12.3.3 Deleting a Data Repeater

If you no longer need a data repeater, you can delete it from the OpX One system.

('"'" Note: A precautionary message does not appear before you delete a data
repeater. Therefore, be sure you do not need a data repeater before you delete
it. You cannot undo a data repeater after it has been deleted.

> To delete a data repeater

1. You cannot delete a data repeater while a data repeater is running (either the one you
want to delete or a different repeater). Check the data repeater status list to ensure that a
data repeater is not running. If one is running, click the Stop button on the tool bar.

2. On the right side of the OpX One Repeater window, use the scroll arrows to find the data
repeater you want to delete (see Figure 12-6).

Del
3. Click the Delete button X_‘
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12.4 Changing the Network Interface and Port

The OpX One Repeater window has a Listen Network Interface  drop-down list and a Port
button that make it easy to change these values for the currently used data repeater (see
Table 12-4).

Listen Network Interface Listen Port
[10.1.1.10 - Op> ~|[19
Table 12-4. Listen Network Interface and Port Field s in the OpX One Repeater Window
Field Description Default
Listen Network Interface If the OpX One system detects multiple NICs, this drop-down list allows you 10.1.1.10 - OpX
to select the NIC you want the data repeater to use. If you have a single NIC One

on your machine, the data repeater selects that NIC automatically, and the
drop-down will be gray and unavailable.

Port Enter the number of the port that the data repeater will use for —
communications.

12.5 Starting and Stopping the Data Repeater

> To start the OpX One Data Repeater
1. Click the Start button D

A message in the Data Repeater status list shows that the Data Repeater started. If this
message does not appear, check the Data Repeater network interface and ports.

> To stop the OpX One Data Repeateter
1. Click the Stop button

A message in the Data Repeater status list shows that the Data Repeater stopped. If this
message does not appear, check the Data Repeater network interface and ports.
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13 Mobile Gateway/Client Module

Topics: This chapter describes the OpX One Mobile

. . Gateway/Client module.
4 Starting the Mobile

Gateway/Client Module The Mobile Gateway/Client module is used for I0S
(page 315) remote operation. The gateway runs on the OpX One

. network and allows access from the IOS device.
4 Quick Tour (page 317)

4 Configuring the Mobile
Gateway/Client Module
(page 320)

4 Starting and Stopping the
Mobile Gateway/Client
(page 321)
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13.1 Starting the

Mobile Gateway/Client Module

Mobile Gateway/Client Module

You must start the File Server module before you start the Mobile Gateway/Client module.

> To start the Mobile Gateway/Client module

1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > OpX One

Mobile Gateway .

A Settings dialog box similar to the following appears.

e

Settings @
Opi Metwork Interface
[10.1.1.10 - Oz

|nternet Metwark, [nterface
[10.1.1.10 - Oz

Part

—

Pazzword

[ Connect At Start Up

Figure 13-1. Settings Dialog Box

3. Complete the fields in the dialog box (see Table 13-1).

4. Click OK.
Table 13-1. Fields in the Settings Dialog Box
Field Description Default
OpX One Network Interface If the OpX One system detects multiple NICs, this drop-down list allows you 10.1.1.10 - OpX
to select the NIC you want the mobile gateway/client module to use for One

accessing the OpX One network. If you have a single NIC on your machine,
the mobile gateway/client module selects that NIC automatically, and the
drop-down will be gray and unavailable.
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Field

Description

Default

Internet Network Interface

If the OpX One system detects multiple NICs, this drop-down list allows you
to select the NIC you want the mobile gateway/client module to use for
accessing the Internet. If you have a single NIC on your machine, the mobile
gateway/client module selects that NIC automatically, and the drop-down
will be gray and unavailable.

10.1.1.10 - OpX
One

Port

Enter the number of the port that the mobile gateway/client module will use
for communications.

Password

Enter the case-sensitive password for accessing the mobile gateway/client
module. Record the password for future reference.

Connect At Startup

Select whether you want the mobile gateway/client module to start (check)
or not start (uncheck) automatically when the OpX One system starts. If
configured to start automatically, a Mobile Gateway/Client module icon
appears in the system tray.

Unchecked
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13.2 Quick Tour

The following sections provide a quick tour of the Mobile Gateway/Client module interface.

¢ OpX Mobile Gate

File Edit

> B

| Desciiption | System | Address

[19:32:11 12/28/2015] Ready...

Menu bar. See section 13.2.1.

Tool bar. See section 13.2.2.

Connection list. See section 13.2.3.

Module status panel. See section 13.2.4.




Mobile Gateway/Client Module

13.2.1 Menu Bar

The menu bar appears at the top of the Mobile Gateway/Client window. The following
sections describe the menu options.

13.2.1.1 File Menu

Exit = exits the Mobile Gateway/Client

Edit module.

Bxt

13.2.1.2 Edit Menu

Settings = displays the Settings dialog box in
File Figure 13-1 on page 315.

h_ Settings
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13.2.2 Tool Bar

The Mobile Gateway/Client module tool bar appears below the menu bar.

Mobile Gateway/Client Module

> B

Table 11-1 describes the tools on the tool bar.

Table 13-2. Mobile Gateway/Client Module Tool Bar

Tool Tool Name Description

Start Starts the Mobile Gateway/Client module and places a Mobile
D Gateway/Client module icon in the system tray.

Stop Stops the Mobile Gateway/Client module.

13.2.3 Connection List

The connection list shows the connections to the Mobile Gateway/Client module.

13.2.4 Module Status Panel

The module status panel shows the
status of the Mobile Gateway/Client

module.

[19:32:11 12/28/2015] Ready...

[19:32:44 12/28/2015] Stopped

[19:32:46 12/28/2015] Binding to: 10.1.1.10
[19:32:46 12/28/2015] Bound

[19:32:46 12/28/2015] Started

[19:55:56 12/28/2015) Started

[19:55:57 12/28/2015] Stopped
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13.3 Configuring the Mobile Gateway/Client Module

The Mobile Gateway/Client module prompts you for settings the first time you launch it.
If you need to change these settings, use the following procedure.

> To change the Mobile Gateway/Client module settings

1. If the Mobile Gateway/Client module is not displayed, double-click its icon in the system
tray.

The OpX One Mobile Gateway window appears.

2. On the Edit menu, click Settings .
The Settings dialog box appears (see Figure 13-1 on page 315).

3. Complete the fields in the dialog box (see Table 13-1 on page 315).
4. Click OK.

Page 320 of 390



Mobile Gateway/Client Module

13.4 Starting and Stopping the Mobile Gateway/Clien t

> To start the OpX Onee Mobile Gaivay/Client

1. Click the Start button [)

A message in the module status panel shows that the Mobile Gateway/Client started. If
this message does not appear, check the Mobile Gateway/Client settings (see section

13.3).

> To stop the OpX Oned bibmé Gaway/Client

1. Click the Stop button

A message in the module status panel shows that the Mobile Gateway/Client stopped. If
this message does not appear, check the Mobile Gateway/Client settings (see section

13.3).
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Topics:

4 Starting the Watchdog
Module (page 323)

4 Quick Tour (page 324)

4 Configuring the Audio
Server Watchdog Timer
(page 326)

4 Starting and Stopping the
Audio Server Watchdog
Timer (page 328)

14 Audio Server Watchdog Module

This chapter describes the OpX One Audio Server
Watchdog module.

The Audio Server Watchdog module is a precautionary
module that monitors the Audio Server process. If the
Audio Server Watchdog module detects that the Audio
Server stopped responding (or is “hanging”), it restarts
the Audio Server module automatically.
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14.1 Starting the Watchdog Module

You must start the File Server module before you start the Watchdog module.

> To Start the Audio Server Watchdog module

1. Start the File Server module (see section 3.1). @/{5

2. Double-click the Audio Server Watchdog icon on your desktop Hs or click the

Windows Start button and click Programs > Broadcast Softftware > Op»Dne Audio
Server Watchdog .

An Audio Server Watchdog window similar to the following appears.

Audio Server Watchdog , ;L’:]Ll

File About

Interval (ms) Timeout [ms)  Falures

1000 [s00 %] [2 %] Start |

Patameters Start On

I IAudioOnly ;I I Stop

Las{ Event
=
4|
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14.2 Quick Tour

The following sections provide a quick tour of the Audio Server Watchdog module interface.

=10 x]
@ ———————————oFile About
Interval (ms) Timeout [ms) Falures
ooz« o 7« e 7 T
(> Parameters Start On e
—o
I IAudioOnly ;I I Stop
l_.as&Event :
© — |
=
(4] °
=
Number Description

Menu bar. See section 14.2.1.

Parameters. See section 0.

Last Event field. See section 0.

Status area. See section 14.2.3.

® 0 00

Start and Stop buttons. See section 0.
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14.2.1 Audio Server Watchdog Module Menu Bar

The menu bar appears at the top of the Audio Server Watchdog window. The following
sections describe the menus on the menu bar.

14.2.1.1 File Menu

) Exit = exits the Audio Server Watchdog

Exit

14.2.1.2 About Menu

Opens a window that shows the version and

File | About build date of the Audio Server Watchdog
module you are running. This window also
shows the amount of memory and virtual
memory being used, and the amount of time
that the Audio Server Watchdog module has
been running. See Figure 14-1 for an example.
To close the window, click OK.

e |

w0.0.0.11 +

Build Drate:
Jan 25 2015 11:48:36

m

b emom Usage:
gazaK [/ 8.ha4k

Wi Llzage:
1.9326 / 2104k,

Running Time: 1 Hour, 2 Minutes, 51 Seconds

Figure 14-1. Example of About Information
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14.2.2 Last Event Field

The Last Event field shows the date and time Last Event
when the Audio Server Watchdog module
detected that the Audio Server was not

responding.
[11:57:02] Start
[11:57:02] Audi handle = 0x00020538
14.2.3 Status Area e iy
[11:57:12] Audio server handle = 0x00020598
H [11:57:12] Audi PID =1236
The Status area shows the status of the Audio [11:57.29] A sarver handle < (00020598

Sel’ver Wa.tCthg tlme [11:57:23) Audio server PID = 123§

14.3 Configuring the Audio Server Watchdog Timer

You configure the Audio Server Watchdog Timer module using the fields on the module
window. Figure 14-2 shows the fields and

Table 14-1 describes them.
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Audio Server Watchdog i E

Fila  About

Irkereal [ms) Timeaul [me] Failures

MEpd o Bl P st |
Faramelers Stait On

| Jib.udlu Only _:1 | Stop
sl k

-

|
Figure 14-2. Audio Server Watchdog Module Configura  tion Fields

Table 14-1. Audio Server Watchdog Module Configurat  ion Fields

Field Description

Default

Interval (ms)

How often the Audio Server Watchdog module checks that the Audio Server
is running.

1000

Timeout (ms)

The maximum number of timeouts that must occur before the Audio Server
Watchdog module resets the Audio Server.

500

Failures (ms)

The maximum number of failures that must occur before the Audio Server
Watchdog module resets the Audio Server.

Parameters

Enter any of the following optional parameters you want to run with the
Audio Server. Before using these parameters contact BSI technical support.

« -auxilialry = starts the Audio Server as an auxiliary instead of as
aa primary.

 -fs <ip address> = tells the Audio Server where the file server
is located.

« -nic <ip address> = tells the Audio Server to use a specific
network-interface card to use on the system.

Start On

Allows the Audio Server to start on a non-audio log item or requires the
Audio Server to start on an audio item.

Audio Only
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14.4 Starting and Stopping the Audio Server Watchdo ¢
Timer

> To start the Audio Server Watchdog Timer

1. Click the Start button Start
Messages in the status area show that the Audio Server Watchdog Timer started.

[11:57:02) Start -
[11:57:02) Audio server handle = 0x00020598

[11:57:02) Audio server PID = 1236

[11:57:12) Audio server handle = 0x00020598

[11:57:12) Audio server PID = 1236

[11:57:23) Audio server handle = 0x00020598

[11:57:23) Audio server PID = 1236

> To stop the Audio Server Watchdoa Tjmer

Stop

1. Click the Stop button
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15 Troubleshooting

Topics: In the unlikely event you encounter a problem using OpX
One, refer to the information in this chapter to identify

4 “Security key / driver is not and correct the problem.

installed” Message (page
330)

4 Program Does Not
Activate (page 331)
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15.1 “Security key / driver is not installed” Mess age

If the message Security key / driver is not installed

Server module or click Edit > Register :

appears when you launch the File

Register

Serial Number

=]

|5C5A-1 167-347B-22AC

Authorization Code

|5C5A-1167-347B-22A0]

Security key / driver is not installed

ol

V’ 0K

X Cancel I

1. Be sure the BSI-supplied dongle is inserted into a working USB port on your computer.

2. Remove the dongle and re-insert it into another USB port that is known to work. Confirm
that a message in the system tray states that the device driver is being installed.

1) Found New Hardware | X
SafeMNet USB SuperProjUltraPro

545 PM

3. If all troubleshooting efforts fail, contact BSI technical support.
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15.2 Program Does Not Activate

If your program does not activate:

1. Check the version of your program (Help > About ) and confirm that it matches the code
version given.

2. To avoid possible typing errors, copy the code and serial numbers provided, and paste
them into the appropriate fields. Otherwise, check the characters in the authorization

code:
a. Codes are entered with all uppercase letters and a dash after every four characters.
b. Codes contain the letters A — F only.
c. The programs take up to 60 seconds to activate.
3. Is there a dongle key inserted into the same computer that is running your program?
4. |s your program using the dongle key serial number?

5. Do you have the latest version of the Sentinel hardware key drivers installed (see section
2.4).

6. If all troubleshooting efforts fail, contact BSI technical support.
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Topics:
4 List of Macros (page 333)

4 Macro Descriptions (page
335)

Appendix A - Macros

This chapter describes the OpX One macros.

In OpX One, the term “macro” refers to commands that
may use variables to allow you to perform automation
functions. Using macros, for example, you can record
audio files, send data via the serial port, enable or
disable hardware devices, switch OpX One’s playback
mode, and add a comment to your program log.

You can add macros to program logs, carts, scheduled
events, triggers, clocks, and Hot Keys.

Macros have a specific syntax that must be followed. In
this appendix, macro names are shown in capital letters,
required variables are enclosed in [brackets], and
optional variables are enclosed in {squiggly brackets}.

Tip: Most users will not need to enter macros manually because the Clock
Builder module enters automatically the most commonly used macros.
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A.1 List of Macros

Table 15-1 lists the macros in alphabetical order and describes their function. For more
information about a macro, go to the page in the “See Page” column.

¢ Note: Some macros have abbreviated or alternate names that can be used to
execute them. The TCPOUTmacro, for example, can also be executed by typing
UDPOUTIPOUT, or IPSEND instead of TCPOUTIf a macro has one or more
alternative names, the names are shown in parentheses in the heading of the

macro.
Table 15-1. Macros
Macro Description See Page
ADDTORUNLOG Adds an entry to the run log. 335
APPLICATION Runs the specified application. 335
ATTIME Runs a command at a specified time. 336
AUTOFILLENABLE Enables or disables auto-fill. 336
CHANNELRELAY Enables or disables channel relays. 337
CLEARASYNC Clears items from the auxiliary deck. 338
CLOSURE Fire a specified closure. 338
COMMENT Adds comments to your log. 339
COMMERCIALBREAKBEGIN Starts a commercial break. 340
COMMECIALBREAKEND Ends a commercial break. 341
CONSOLEOUT Sends a command to an Axia console. 341
DECKTIMER Superimposes a countdown timer over the top deck on the Studio Client 342
Playback Deck Stack.
DEVICE Enable or disables the use of a hardware I/O device. 343
FADECURRENT Fades out the currently playing items. 344
FADEOUTLASTITEM Looks ahead from the current item for a @ time-immediate cue, and then 344
backs up to find an audio item before the time-immediate event.

FLUSHEVENTLOG Flushes the run log. 344
GETFILLFILES Scans the folders for your station that contain Fill material, and copy any 345
new or modified files to the Audio Server’s local folder.

GETPROGRAMLOGS Updates program logs form the file server. 346
GETVOICETRACKS Gets voicetracks from the file server program log for the specified hour. 346
LOADLOG Loads a program log. 347
LOADLOGFROMSERVER Loads a program log from the file server. 348
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Macro Description See Page
LOADSCHED Loads a Scheduled Event Set. 348
LOADSCHEDULEDEVENTS Switches between different Scheduled Events sets. 349
LOADTRIGGERS Loads a trigger set. 350
MIXFADE Forces one of the Audio Server’s configured mixers to fade in, fade out, or 351

fade to a specific level.
MIXVOLUME Forces one of the Audio Server’s configured mixers to cut to a specific 352
volume level instantly.
MODE Set the automation mode. 353
PADENABLE Enables or disables PAD output. 354
PADOUT Outputs PAD from the specified parameters. 354
PAUSE Wait for pause time. 355
PLAYASYNC Plays an audio file in the auxiliary playback deck. 355
PLAYTIMESHIFT Plays a file in the timeshift deck. 356
RECORD Records a file in the background. 357
RELAY Runs a relay command. 359
RESETCART Resets a cart to play at the first item. 360
RUN Starts the next item regardless of cue. 360
RUNAPPLICATION Allows you to enter the path to an executable file on your Audio Server 361
machine.
SAVEPROGRAMLOG Saves the program log. 361
SATSHOW Starts or stops a satellite show. 362
SATSHOWTIMER Shows a sat show count-up in the playback deck. 363
SCHED Enables or disables the execution of scheduled events loaded in the Audio 364
Server
SCHEDULEDEVENTS Turns the scheduled events function on or off. 365
SENDPAD Outputs PAD from a file name. 366
SERIALOUT Sends a serial string out the serial port of any configured serial device. 366
START Starts playback of the next event in your program log. 367
STARTDECK Starts the specified deck. 367
STARTNEXT Similar to the STARTmacro, but changes its behavior based on the state 368
of the Playback Deck Stack.
STARTENABLE Enables or disables the start command. 368
STEPTHROUGH Allows you to turn the Step-Through function on or off. 369
STOP Stops playback of all events being played by the Playback Deck Stack. 370
STOPDECK Stops the specified deck. 370
SYNCRECORDSFOLDER Immediately syncs the Records folder to the file server. 3N
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Macro Description See Page
SUNCYRUNLOGSFOLDER Immediately syncs the RunLogs folder to the file server. 3N
TCPOUT Sends a command to a TCP/UDP device 372
TIMEDBLOCKSTART 373

Specifies the length of a block of audio.
TIMEDBLOCKEND 374
TIMEEVENTS Changes the Time Events mode on the Audio Server. 375
TIMESCALEITEM Sets the time scaling for the specified program log item. 376
TRIGGERS Enables or disables the trigger functionality of the Audio Server. 377
TRIM Trims silence from the specified file 378

A.2 Macro Descriptions

A.2.1 ADDTORUNLOG (or RUNLOG)

This macro adds an entry to the run log.

ENTRY FORMAT

ADDTORUNLOGATEGORY], [DESCRIPTION]

VARIABLES

- CATEGORY¥ adds a category that can be used as a key when running reports.

- DESCRIPTION= any text.

EXAMPLE

This example adds the entry BROWNS BENGALS GAME STARTHEDthe run log.

| ADDTORUNLOG INFO, BROWNS BENGALS GAME STARTED
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A.2.2 APPLICATION (or APP)

This macro runs an external application.

ENTRY FORMAT

APPLICATION [NAME]

VARIABLES

NAME= name of the application you want to run.

A.2.3 ATTIME

This macro runs a command at a specified time.

ENTRY FORMAT

ATTIME [TIME], [COMMAND]

VARIABLES

TIME =time, in mm:ss format, when the command will run. Add a plus sign (+) in front of
this variable to specify forward relative time. For example, +0100 corresponds to one
minute from the present time. Omitting the plus sign allows you to include a scheduled
event in the program log. For example, 18000 means that an event will run at 18:00
(6:00 pm).

.  COMMANS®command that is to run.

EXAMPLE 1

| ATTIME +0010, START
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A.2.4 AUTOFILLENABLE (or ENABLEAUTOFILL, FILLENABLE , or
ENABLEFILL)

This macro enables or disables auto-fill.

ENTRY FORMAT

AUTOFILL [*ON / OFF"]

VARIABLES
ON= enable autofill.

OFF = disable autofill.

EXAMPLE 1

[ AUTOFILL ON

A.2.5 CHANNELRELAY (or CHANNELRELAYENABLE or
CHANNELRELAYENABLED)

This macro enables or disables channel relays.

ENTRY FORMAT

CHANNELRELAY [‘ON / OFF”]

VARIABLES
ON= enable channel relays.

OFF= disable channel relays.

EXAMPLE 1

| CHANNELRELAY ON
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A.2.6 CLEARSYNC (or CLEARAUX)

This macro enables or disables channel relays.

ENTRY FORMAT

CLEARSYNC

VARIABLES

None.

EXAMPLE 1

| CLEARSYNC

A.2.7 CLOSURE (or TRIGGER)

This macro simulates the sending of a virtual closure from a device that supports closures to
the Audio Server. For example, if you have a satellite receiver on closure 5, you can issue
this macro to mimic the sending of a virtual closure from that receiver to the Audio Server.
This macro often is used for troubleshooting. For ease of use, you might want to map this
macro to a Hot Key.

ENTRY FORMAT

CLOSURE [NAME], #

VARIABLES
NAME= name of the device, as configured in the Audio Server.

# = number of the closure.

EXAMPLE 1

| CLOSURE BTACSS2, 1
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A.2.8 COMMENT (or THECOMMENT)

This macro allows you to add comments to your run log. The cue type of comment macro
events can be used to affect playback of your program log. Common examples are:

Stopping playback and making it obvious why.

Creating a COMMENMacro similar to Example 1 below with a Manual Start (aka Stop)
cue type. You can mark your top of the hour with a comment by creating a COMMENT
macro similar to Example 2, with a cue type of Time Immediate or Time Next.

These are but a few of the many functions you can perform using the COMMENMacro.

ENTRY FORMAT
COMMEN[THECOMMENT]

VARIABLES

«  THECOMMENT comment text.

EXAMPLE 1

This example shows a comment about going live on the air using a manual cue type.

| COMMENTalent:  Golive on the air!

EXAMPLE 2

This example shows a comment about a top-of-the-hour resync, with a Time Immediate or
Time Next cue type.

| COMMENTOp of the hour re-sync
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A.2.9 COMMERCIALBREAKBEGIN (or BREAKBEGIN)

This macro signifies the start of a commercial break.

ENTRY FORMAT

COMMERCIALBREAKBEGIN [LENGTH], ['[MANDATORY/OPTIONAL], {"FADE"}, {FADE%}, {"PLAYIFEMPTY },
{NAMETOPLAY}

VARIABLES
« LENGTH= length in mm:ss format.

«  MANDATORY¥ the break must be filled with content. The system fills the break
automatically to the alllotted time, even if there is no content.

«  OPTIONAL= the system skips the break automatically if empty.
FADE= uses the fade percentage specified.

FADE%- if FADEIs included, sets the volume of the “rejoin liner” (typically, a 10-second
blurb of audio that you hear after a commercial break before returning to a satellite
broadcast). If FADEis omitted, this variable is ignored.

PLAYIFEMPTY = plays an event if a break has no items.
NAMETOPLAY =filename of item to play if empty.

EXAMPLE

| COMMERCIALBREAKBEGIN 3:00, MANDATORY
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A.2.10 COMMERCIALBREAKEND (or BREAKEND)

This macro signifies the end of the break period.

ENTRY FORMAT

| COMMERCIALBREAKEND

VARIABLES

None.

EXAMPLE

| COMMERCIALBREAKEND

A.2.11 CONSOLEOUT

This macro sends a command to an Axia console.

ENTRY FORMAT

[ CONSOLEOUT [NAME], [COMMAND]

VARIABLES
- NAME= name of the Axia console.

. COMMANS®command to be sent to the Axia console.

EXAMPLE

| COMMERCIALBREAKEND
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A.2.12 DECKTIMER

This macro superimposes a countdown timer over the top deck on the Studio Client
Playback Deck Stack. This is useful to run during a live show to display to the on-air talent
the amount of time remaining in a show segment, among other uses. When a new event
starts, or when the time runs out, the superimposed countdown timer disappears.

In the following figure, the countdown timer created by the DECKTIMERmMacro appears over
top of the top deck in the Studio Client’s Playback Deck Stack.

LIVE! - DINGO & THE BABY SEGMENT 1 _ T —— ]
Greatest IXITS of the
WA AW WA

80 s, 90s, and today!

Entry F ORMAT

[ DECKTIMER [DESCRIPTION], [DURATION]

VARIABLES
- DESCRIPTION= description to display on the deck.

- DURATION= duration of the countdown timer, in mm:ss format.

EXAMPLE

| DECKTIMER LIVE! — Dingo & The Baby Segment 1, 13:00
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A.2.13 DEVICE

Use this macro to enable or disable the use of a hardware 1/O device, such as a switcher or
trigger/relay hardware.

¢ Note: Use the exact name of the device you configured on the Device I/O page
of your Audio Server module’s configuration settings. If the name differs from the
one specified in the macro or is misspelled, your macro will return an error when
it executes.

ENTRY FORMAT

[ DEVICE [NAME],['ON" / "OFF"]

VARIABLES
- NAME= name of the device.
« ON=turn on the device.

«  OFF = turn off the device.

EXAMPLE 1

This example turns on the Broadcast Tools ACS 8.2 audio switcher/GPIO device, which is
named “WBSIACS8.2" when it was configured. This device connects to the WBSI Audio
Server. This example makes the device available to send audio channel switching
commands, relay commands, and receive triggers from OpX One.

| DEVICE WBSIACS8.2, ON

EXAMPLE 2

This example allows OpX One to disable communications with the ACS 8.2 from Example 1.
As a result, triggers are no longer acknowledged, and switching and relay commands are
not sent to the device.

| DEVICE WBSIACSS8.2, OFF
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A.2.14 FADECURRENT (or FADECUR)

This macro fades out the currently playing items.

Entry F ORMAT

| FADECURRENT

VARIABLES

None.

EXAMPLE

| FADECURRENT

A.2.15 FADEOUTLASTITEM (or FADE_OUT_LAST_ITEM)

This macro looks ahead from the current item for a @ time-immediate cue, and then backs
up to find an audio item before the time-immediate event. It then sets the fade on that item,
which will be the last audio item before the time-immediate.

Nothing happens when you run the macro. It merely sets the fade out on the last item before
the time-immediate event. See the example below.

Entry F ORMAT

[ FADEOUTLASTITEM [TIME], [LENGTH]

VARIABLES
« TIME = the time to start the fade in HH:MM:SS
« LENGTH= length of the fade, in milliseconds.

EXAMPLE

Assume that your log looks resembles the following:

+ 17:56:00 SONG
+ 17:58:00 LAST
@ 18:00:00 SATSHOW START, THESHOW
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Also, assume that some time before the last item in the hour starts, the following macro is
executed:

| FADEOUTLASTITEM 17:59:55, 4000

This macro sets the fade to start at 17:59:55 over four seconds, giving a second of silence
before the satellite show starts at 18:00:00.

You can run the macro in the log, for example, 15 minutes prior to the end of the hour.

A.2.16 FLUSHEVENTLOG (or FLUSHRUNLOG)

This macro flushes the run log.

Entry F ORMAT

| FLUSHEVENTLOG

VARIABLES

None.

EXAMPLE

| FLUSHEVENTLOG

A.2.17 GETFILLFILES (or GETFILL)

This macro forces the File Server to scan the folders for your station that contain Fill
material, and copy any new or modified files to the Audio Server’s local folder.

Entry F ORMAT

| GETFILLFILES

VARIABLES

None.

EXAMPLE

| GETFILLFILES
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A.2.18 GETPROGRAMLOGS

This macro forces the File Server to scan the program log folder for your station, and copy
any new or modified program logs to the Audio Server's local folder.

Entry F ORMAT
| GETPROGRAMLOGS

VARIABLES

None.

EXAMPLE
| GETPROGRAMLOGS

A.2.19 GETVOICETRACKS

This macro forces the Audio Server to compare the specified hour of the currently loaded
program log with the same hour in the File Server’s copy of the program log, and update the
on-air log with any new remotely created voicetracks.

Entry F ORMAT
| GETVOICETRACKS [HH]

VARIABLES

HH= hour of voicetrack events update.

EXAMPLE

The following example updates the voicetrack files in the current on-air log for the 2:00pm

hour with any newly created or modified remote voicetrack files currently on the File Server.
| GETVOICETRACKS 14 |
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A.2.20 LOADLOG

This macro loads a program log using the entry in the Program Log Name Template field
of the General tab in the Audio Server configuration settings.

This macro always loads the log using the date of your workstation’s system date. If this
macro is run before noon of the current day the current day’s log is loaded. If after noon, the
next day’s log is loaded. This means that if your system’s date is Tuesday December 23,
2015 at 11:55:25 PM when the LOADLOGnNacro is run, the program log for Wednesday
December 24, 2015 is loaded. No variables apply to this macro.

For options about loading specifically named program logs and additional options for

reloading today’s log using the Audio Server's Program Log Name Template settings, see
the LOADLOGnNacro later in section A.2.20.

If {NAME} is omitted, the configured program template log is loaded.

Entry F ORMAT

| LOADLOG {NAME}

VARIABLES

NAME= name of the log to be loaded.

EXAMPLE

| LOADLOG
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A.2.21 LOADLOGFROMSERVER

This macro loads a program log from the file server. If {NAME} is omitted, the configured
program log template is loaded.

Entry F ORMAT
| LOADLOGFROMSERVER {NAME}

VARIABLES

«  NAME= name of the log to be loaded.

EXAMPLE
| LOADLOGFROMSERVER

A.2.22 LOADSCHED (or LOADSCHEDULED or
LOADSCHEDULEDEVENTS)

This macro loads a Scheduled Event set.

Entry F ORMAT
[ LOADSCHED {NAME}

VARIABLES

- NAME= name of the Scheduled Event Set to be loaded.

EXAMPLE
| LOADSCHED BEACHSONGEVENTSET
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A.2.23 LOADSCHEDULEDEVENTS (or LOADSCHEDULED)

The OpX One Audio Server can use only one Scheduled Events set at a time. Using this
macro, however, makes it possible to switch between different Scheduled Events sets.
Running this macro loads the named Scheduled Events set and unloads the previously
loaded set. If the name of the Scheduled Events set is omitted, the Audio Server unloads
any currently loaded scheduled events set.

Entry F ORMAT

| LOADSCHEDULEDEVENTS [NAME]

VARIABLES

NAME= name of Scheduled Events set.

EXAMPLE 1

The following example unloads the currently loaded Scheduled Events set, so the events in
that set will no longer execute. The BaseballSchedSet loads and all events in that set
execute at their configured times, as long as the Scheduled Events function is enabled
(turned on).

| LOADSCHEDULEDEVENTS BaseballSchedSet

EXAMPLE 2

Since no scheduled events set name is specified, the Audio Server unloads any currently
loaded scheduled events set. In this example, the alternate macro name LOADSCHEDULEDB
used instead of LOADSCHEDULEDEVENTRhe two macros are functionally equivalent. The
only difference is that one macro name is longer than the other macro name.

| LOADSCHEDULED
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A.2.24 LOADTRIGGERS

This macro loads a trigger set. You can run this macro from a scheduled event, the program
log, a cart, or another trigger set.

Entry F ORMAT
[ LOADTRIGGERS [NAME]

VARIABLES

«  NAME= filename of the trigger set.

EXAMPLE 1

The following example loads a trigger set named DavesTriggerSet .
| LOADTRIGGERS DavesTriggerSet

EXAMPLE 2

Since no trigger set is named, running this example unloads the currently loaded trigger set.
| LOADTRIGGERS |
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A.2.25 MIXFADE

Use this macro to force one of the Audio Server’s configured mixers to fade in, fade out, or
fade to a specific level (for ducking or other purposes). You can use either the name you've
given your mixer or the mixer's number. Volume is in percent, with 100% being fully open/up
and 0% being fully closed/down.

Entry F ORMAT

[ MIXFADE [NAME OR #],[START%],[STOP%],[TIME]

VARIABLES
NAME OR # = mixer name or number,
START% start volume percentage.

«  STOP% stop volume percentage.

« TIME = duration, in milliseconds.

EXAMPLE

The following example fades the mixer named SATELLITE from an initial 0% to a final 100%
over a length (or ramp time) of 2.5 seconds.

| MIXFADE SATELLITE, 0, 100, 2500
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A.2.26 MIXVOLUME

Use this macro to force one of the Audio Server’s configured mixers to cut to a specific
volume level instantly. Use either the name you've given your mixer or the mixer's number.

Volume is specified as a percentage, with 100% being fully open/up and 0% being fully
closed/down.

Entry F ORMAT

[ MIXVOLUME [NAME OR #] [PERCENT]

VARIABLES
NAME OR #= mixer name or number.

PERCENT= volume percentage.

EXAMPLE

The following example set the volume of the first defined mixer to 100%.

| MIXVOLUME 1, 100
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A.2.27 MODE

This macro allows you to change the Audio Server’'s automation mode to Auto, Assist, or
Manual mode.

Entry F ORMAT

| MODE [‘AUTO” / “ASSIST” / “MANUAL"]

VARIABLES
« AUTO= change the Audio Server’'s automation mode to auto.
« ASSIST = change the Audio Server’s automation mode to assist.

+  MANUAIL= change the Audio Server’s automation mode to manual.

EXAMPLE 1

The following example sets change the Audio Server's automation mode to auto.

| MODE auto

EXAMPLE 2

The following example sets change the Audio Server's automation mode to assist.

| MODE assist

EXAMPLE 3

The following example sets change the Audio Server's automation mode to manual.

| MODE manual
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A.2.28 PADENABLE (or ENABLEPAD)

This macro enables or disables PAD output.

Entry F ORMAT

| PADENABLE [*ON” / “OFF’]

VARIABLES
« ON=enable PAD output.
« OFF=disable PAD output.

EXAMPLE

| PADENABLE ON

A.2.29 PADOUT (or OUTPAD)

This macro outputs PAD from the specified parameters.

Entry F ORMAT

[ PADOUT

VARIABLES

None.

EXAMPLE

| PADOUT
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A.2.30 PAUSE

This macro allows you to put a pause between events.

Entry F ORMAT

| PAUSE [LENGTH]

VARIABLES

« LENGTH= length of the pause, in mm:ss format.

EXAMPLE

The following example pauses playback of events for 10 seconds.

[ PAUSE :10

A.2.31 PLAYASYNC (or PLAYAUX)

This macro plays an audio file in the auxiliary playback deck. This is useful to play a
background audio file at the same time audio is playing in the main playback decks, such as
a backing track behind a weather forecast.

Entry F ORMAT

[ PLAYASYNC [NAME]

VARIABLES

NAME= filename of audio file to play without extension.

EXAMPLE

If the following macro is run from the program log followed by an audio file containing a dry
reading of the weather, the audio file weatherbedl.wav executes on the Async deck, and
then the weather would play immediately over top.

| PLAYASYNC weatherbed1
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A.2.32 PLAYTIMESHIFT (or PLAYTS or TIMESHIFT)

This macro plays a file in the timeshift deck. After using a clock from the Clock Builder to
record a satellite show, this macro is added to a clock to play back the recorded audio. This
macro prompts the OpX One system to start playback of your pre-recorded satellite show’s
audio file.

Entry F ORMAT

[ PLAYTIMESHIFT [NAME]

VARIABLES

NAME= name of the audio file to play.

EXAMPLE

This example starts playback of the audio file BILLOREALLYHR1.wav . This file was
created with the record function of the Clock Builder module.

| PLAYTIMESHIFT BILLOREALLYHR1
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A.2.33 RECORD

Use this macro to record audio using one of your Audio Server’s record decks (for recording
audio manually rather than using the record function of the Clock Builder).

Audio files can be recorded to a specified length by entering a [Length to record] variable
with a specific time (such as 30:00). To record a variable-length audio file, specify the time
as 00:00, and when you want to stop recording, run a second RECORD STOP, [Deck #]
macro.

Time is interpreted as mm:ss if only five digits are entered (including the colon), or as
hh:mm:ss if 8 digits are entered (including the two colons).

The Filename |, Title/Description , and Artist  variables you use can include meta
variables for the date or time, as shown in the following table.

Meta Variable Description
%yy Year as a 2-digit number (00-99)
%yyyy Year as a 4-digit number (0000-9999)
%m Month as a number without a leading zero (1-12)
%mm Month as a number with a leading zero (01-12)
%mmm Month as a 3-letter abbreviation (Jan-Dec)
%mmmm Month as a full name (January-December)
%d Day as a number without a leading zero (1-31)
%dd Day as a number with a leading zero (01-31)
%ddd Day as a 3-letter abbreviation (Mon-Sun)
%dddd Day as a full name (Monday-Sunday)

Entry F ORMAT

[ RECORD ['START'/'STOP'], [DECK#], [NAME], [LENGTH 1, [TITLE],[Artist], [UPLOAD], [TRIM]

VARIABLES

«  START= starts recording.

«  STOP= stops recording.

«  DECK#= number of the deck on which recording is to start or stop.
«  NAME= filename to save to.

« LENGTH= length to record.
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TITLE = description.
« ARTIST = name of the artist.
«  UPLOAD= copies a file from the Audio Server to the File Server.

« TRIM = removes the silence (“dead air”) from the start or end of the specified file.

EXAMPLE 1

This example records an audio file that will be 5 minutes long from Record Deck 1. The file
will be saved with the file name NEWS.wav (or other extension for other file types), with the
audio file’s Title field showing ABG News and the artist field showing Doug Haiku .

| RECORD START, 1, NEWS, 05:00, ABG News, Doug Haiku

EXAMPLE 2

This example records an audio file of variable length that must be stopped at some point
with the RECORD STOP, 2 macro or it will eventually fill up the hard drive. The file is played
from Record Deck 2 with the file name Rosh-122315.wav (if the file were recorded on
December 23, 2015) and the audio file's Title/Description field would show Rosh Limberg
Show — 12/23/2008 .

| RECORD START, 2, Rosh-%mm%dd%yy, 00:00, Rosh Limber g Show - %mm/%dd/%yyyy

EXAMPLE 3

This example stops Record Deck 2 from recording and save its audio file to the File Server.

| RECORD STOP, 2
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A.2.34 RELAY

This macro forces a relay closure open (on), closed (off), or to pulse closed for a period of
milliseconds.

Entry F ORMAT

[ RELAY [NAME], [#], ['ON"/ “OFF" / MS]

VARIABLES

«  NAME= name of the device.

«  # =relay number.

« ON=relay is turned on.
OFF=relay is turned off.

MS= milliseconds.

EXAMPLE

This example pulses for 500 milliseconds the first relay on the device named ACS8.2
configured in the Audio Server’s Device /O settings.

| RELAY ACS8.2, 1, 500
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A.2.35 RESETCART

This macro resets a cart’s “event executed” flags, so that all items within a cart are marked
as unplayed. The next time the cart is played, the first item is played (or in randomized carts,
all items within the cart will be available to play again).

Entry F ORMAT

| RESETCART [NAME]

VARIABLES

NAME= name of the cart to reset.

EXAMPLE

This example causes the cart named STATIONIDCART to remove the internal event
executed flags from each event in the cart, so that the next time that cart executes, it starts
playing from the first event in the cart.

| RESETCART STATIONIDCART

A.2.36 RUN (or START)

This macro starts the next item regardless of cue.

Entry F ORMAT

| RUN

VARIABLES

None.

EXAMPLE

[ RUN
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A.2.37 RUNAPPLICATION

OpX One can execute any application that can be executed using the Microsoft Windows
Command Prompt. This allows you to have OpX One start any custom application you might
need.

This macro allows you to enter the path to an executable file on your Audio Server machine,
including any parameters required by that executable file, as the macro’s variable.

Entry F ORMAT

[ RUNAPPLICATION [PATH]

VARIABLES

PATH= full path and parameters for executable file.

EXAMPLE

This example tells Windows to execute the command C:\Program Files\My

Apps\CustomApp.exe /X , Which starts the CustomApp.exe executable and passes it the
parameter /x .
| RUNAPPLICATION C:\Program Files\My Apps\CustomApp.e xe /x

A.2.38 SAVEPROGRAMLOG

This macro saves the program log.

Entry F ORMAT

| SAVEPROGRAMLOG

VARIABLES

None

EXAMPLE

| SAVEPROGRAMLOG
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A.2.39 SATSHOW

This macro is usually generated by the Clock Builder module to start a satellite show.
However, it is possible to manually use this macro. If placed in a Hot Key, you can restart a
satellite show if necessary.

Entry F ORMAT

| SATSHOW ['START" /"STOP" / “STOPLIVE” / “STOPRECOR D"], [NAME]

VARIABLES
START= start the satellite show.
«  STOP= stop the satellite show.
« STOPLIVE = stop live satellite show.

«  STOPRECORB®D search the list of active satellite shows and stop the ones that are
recording.

.« NAME= name of the satellite show.

EXAMPLE

This macro puts all the settings configured in the Clock Builder for the Satellite Show Start
event titled BILL OREALLY .

| SATSHOW START, BILL OREALLY
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A.2.40 SATSHOWTIMER

This macro shows a sat show count-up in the playback deck.

Entry F ORMAT

| SATSHOWTIMER ['START" / "STOP"], [NAME], [DESCRIPTI ON]

VARIABLES

« START= start the satellite show count-up in the playback deck.

« STOP= stop the satellite show count-up in the playback deck.
NAME= name of the satellite show count-up in the playback deck.

DESCRIPTION= description of the satellite show count-up in the playback deck.

EXAMPLE

This macro puts all the settings configured in the Clock Builder for the Satellite Show Start
event titled BILL OREALLY .

| SATSHOWTIMER START, BILL OREALLY
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A.2.41 SCHED (or SCHEDULED)

This macro enables or disables the execution of scheduled events loaded in the Audio
Server.

Entry F ORMAT

[ SCHED ["ON"/ "OFF"]

VARIABLES
- ON= enable execution.

- OFF=disable execution.

EXAMPLE

| SCHED ON

SEE ALSO

LOADSCHED (or LOADSCHEDULED or LOADSCHEDULEDEVENTS) on page 348.
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A.2.42 SCHEDULEDEVENTS (or SCHEDULED)

This macro turns the scheduled events function on or off.

Entry F ORMAT

| SCHEDULEDEVENTS ['ON"/ "OFF"]

VARIABLES
- ON= enable the scheduled events function.

- OFF=disable the scheduled events function.

EXAMPLE 1

This macro turns on the Scheduled Events function, so that the events in the currently
loaded Scheduled Events set executes its events at the specified times.

| SCHEDULEDEVENTS ON

EXAMPLE 2

This macro turns off the Scheduled Events function, so if events in the currently loaded
Scheduled Events set are set to execute at a specific time, they are ignored. In the following
example, the command SCHEDULEID> used instead of SCHEDULEDEVENT%he two macros
are functionally equivalent. The only difference is that one macro name is longer than the
other macro name.

| SCHEDULED OFF
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A.2.43 SENDPAD (or PADSEND)

This macro outputs PAD from a file name.

Entry F ORMAT

| SENDPAD

VARIABLES

None.

EXAMPLE

| SENDPAD

A.2.44 SERIALOUT

This macro sends a serial string out the serial port of any configured serial device.

Entry F ORMAT

[ SERIALOUT [NAME], [COMMAND]

VARIABLES
- NAME= name of the device.

COMMANSB serial string.

EXAMPLE

This macro sends the serial string *1051 out the serial port or serial server to which the
device named ACS82 on the Audio Server is connected. This serial string is commonly used
to switch most Broadcast Tools switchers, such as the ACS 8.2 and others, to set Output 1
to open Input 5.

| SERIALOUT ACS82, *1051
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A.2.45 START

This macro starts playback of the next event in your program log. If audio is already playing,
this macro starts the next event playing at the same time, without cutting off the currently
playing event. For a macro that stops the currently playing event and start the next event,
see the STARTNEXTmacro in section A.2.48.

Entry F ORMAT

| START

VARIABLES

None.

EXAMPLE

| START

A.2.46 STARTDECK

This macro starts the specified deck.

Entry F ORMAT

| STARTDECK [DECK#]

VARIABLES

DECK#= number of the deck to be started.

EXAMPLE

This example starts deck number 2.

| STARTDECK 2
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A.2.47 STARTENABLE

This macro enables or disables the start command. Use this macro when your programming
is automated and you want to prevent manual intervention.

Entry F ORMAT

| STARTENABLE [*ON” / “OFF"]

VARIABLES
« ON= enable the start command.

. OFF=disable the start command.

EXAMPLE

| STARTENABLE ON

A.2.48 STARTNEXT

This macro is similar to the STARTmacro, but changes its behavior based on the state of the
Playback Deck Stack:

- If an event is playing when this macro executes, it fades out and the next event in the
program log executes.

« If no event is playing in the Playback Deck Stack, the item loaded in the top of the
Playback Deck Stack executes.

Entry F ORMAT

[ STARTNEXT

VARIABLES

None.

EXAMPLE

| STARTNEXT
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A.2.49 STEPTHROUGH

The Step-Through function of the Audio Server determines how timed events (events with a
Time Immediate or Time Next cue type) start. This macro allows you to turn the Step-
Through function on or off.

If the Step-Through function is enabled, timed events start when their time is reached. If
a particular timed event is reached before its scheduled time, that event starts
automatically, as if it were an Auto Start cued event. This is useful for “Music-from-Hard-
Drive” stations that encounter missing audio files and want their timed events to run early
rather than having dead air until a timed event'’s time is reached.

- If the Step-Through function is disabled, timed events do not execute until their specified
time is reached. This is the standard setting for OpX One, since it is the expected
behavior of timed events for most users.

Entry F ORMAT

| STEPTHROUGH [‘ON” / “OFF”]

VARIABLES
ON= enable stepthrough.
OFF= disable stepthrough.

EXAMPLE 1

| STEPTHROUGH ON

EXAMPLE 2

| STEPTHROUGH OFF
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A.2.50 STOP

This macro stops playback of all events being played by the Playback Deck Stack. This
macro is most commonly used with the trigger set function to allow you to configure stop
buttons on consoles.

Entry F ORMAT

| sTopP

VARIABLES

None.

EXAMPLE

| sToP

A.2.51 STOPDECK

This macro stops the specified deck.

Entry F ORMAT

| STOPDECK [DECK#]

VARIABLES
DECK#= number of the deck to be stopped.

EXAMPLE

This example stops deck number 2.

| STOPDECK 2
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A.2.52 SYNCRECORDSFOLDER (or SYNCRECORDS)

This macro forces the File Server and Audio Server to synchronize the Records folder for

your station. It copies any new or modified files between the Audio Server’s local folder and
the File Server's Records folder, so both have the most recent versions of all files. You can

use this macro to ensure that all files in the Audio Server’s local folder are up to date.

Entry F ORMAT

| SYNCRECORDSFOLDER

VARIABLES

None.

EXAMPLE

| SYNCRECORDSFOLDER

A.2.53 SYNCRUNLOGSFOLDER (or SYNCRUNLOGS)

This macro forces the File Server and Audio Server to synchronize the Runlogs folder for

your station. It copies any new or modified files between the Audio Server’s local folder and
the File Server's Runlogs folder, so both have the most recent versions of all files.

ENTRY FORMAT

|SYNCRECORDSFOLDER

VARIABLES

None.

EXAMPLE

|SYNCRECORDSFOLDER
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A.2.54 TCPOUT (or UDPOUT, IPOUT, or IPSEND)

This macro sends commands to a TCP/UDP device.

ENTRY FORMAT

[ TCPOUT [NAME], [COMMAND]

VARIABLES
- NAME= name of the device.

. COMMANS®command to be sent to the device.

EXAMPLE

| SYNCRECORDSFOLDER
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A.2.55 TIMEDBLOCKSTART

This macro is used with the TIMEDBLOCKENIEnacro to specify the length of a block of audio,
such as a break, and have OpX One “stretch” (slow down) or “squeeze” (speed up) the
audio so that the audio fits the specified block length.

ENTRY FORMAT

[ TIMEDBLOCKSTART [LENGTH]

VARIABLES
LENGTH= length of block, in hh:mm:ss format.

EXAMPLE

This example adds to the start of a break which the operators wants to be stretched or
squeezed automatically to be a total of 3:00 minutes long. When using this macro, add the
TIMEDBLOCKENINacro after the block of audio. The pair of these macros is the way OpX
One ascertains which audio files are to be stretched or squeezed. Without the
TIMEDBLOCKENINacro at the end of your block of audio files, OpX One would not know the
end point of your block of audio and cannot fit your audio properly to the specified length.

| TIMEDBLOCKSTART 03:00

¢ Note: Do not use carts and timed events (events with a Time Immediate or Time
Next cue type) within the TIMEDBLOCKSTART TIMEDBLOCKENDnacro pair. This
is because the length of audio events within carts cannot be determined until the
cart itself starts to play, and timed events affect the start point of playback (either
stopping playback or starting early if their specified time is reached), Both of
these actions are beyond the control of this macro.
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A.2.56 TIMEDBLOCKEND

This macro is used with the TIMEBLOCKSTARTacro to specify the length of a block of

audio files, so that OpX One can time scale the block of audio automatically to your desired
length. The TIMEDBLOCKENINacro is added to the end of your block of audio (with the
block started with the TIMEDBLOCKSTARTacro), which is to be time-scaled.

Entry F ORMAT

| TIMEBLOCKEND

VARIABLES

None.

EXAMPLE

| TIMEBLOCKEND
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A.2.57 TIMEEVENTS (or TIMEDEVENTS)

This macro changes the Time Events mode on the Audio Server to change OpX One’s
behavior when playing time cued events in the Program Log and when executing events
from your current Scheduled Events set.

Entry F ORMAT

| TIMEEVENTS ['ON" / "OFF" / "ALL"

VARIABLES
ON-= turn on time events.
«  OFF=turn off time events.

« ALL =turn on stepthrough.

EXAMPLE 1

| TIMEEVENTS ON

EXAMPLE 2

| TIMEEVENTS OFF

EXAMPLE 3

| TIMEEVENTS ALL
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A.2.58 TIMESCALEITEM (or SCALEITEM or TSITEM)

This macro sets the time scaling for the specified program log item. For example, if you have
an infomercial that is 14:45 long, but must fit into a 15-minute timeframe, you can use this
macro to stretch the infomercial so it fills the 15-minute spot. Similarly, you can use this
macro to squeeze content that exceeds the time in which it is scheduled to play.

Entry F ORMAT

[ TIMESCALEITEM ['NEXT"/ +#, #]

VARIABLES
NEXT= next program log item.
+# = number of item forward from current position.

« # = absolute log position.

EXAMPLE

This example sets the time scaling for 5 items forward.

| TIMESCALEITEM +5
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A.2.59 TRIGGERS

This macro enables or disables the trigger functionality of the Audio Server.

- If triggers are turned on, all incoming triggers execute the events from your currently
loaded Trigger Set.

- If triggers are turned off, all incoming triggers are ignored.

Entry F ORMAT

| TRIGGERS ['ON"/"OFF"]

VARIABLES
«  ON=turn on triggers.

«  OFF=turn off triggers.

EXAMPLE 1

This example turns on triggers.

| TRIGGERS ON

EXAMPLE 2

This example turns off triggers.

| TRIGGERS OFF
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A.2.60 TRIM

This macro trims silence from the specified file.

Entry F ORMAT

| TRIGGERS [NAME]

VARIABLES

«  NAME= name of the file.

EXAMPLE

| TRIM 50954
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Appendix B - Cue Types

This appendix describes the cue types supported by OpX One event playback. Cue types
determine how events are started in the program log or from within carts.

«  With program logs, every event is started by a scheduled time (such as with Time
Immediate cued events) or from the interaction of previous items playing back. Examples
of the latter include Auto Start cued events, which start when the previous event finishes,
and Stop cued events, which stop playback after the previous event finishes.

- Carts use the Stop cue and Auto Start cue to determine how many events are played
from a cart. When a Stop cued event is reached during cart play, the cart quits. If the cart
is being played from a program log, the next event in the program log executes with
respect to its specified cue type.

Cue Type Description
Stop (blank) Event will not start playing when the previous item finishes.
Auto Start (+) Event starts playing automatically when the previous itemfinishes

Time Immediate (@)

If playback has not reached the event at the time set in the Scheduled Time field:
« The currently playing event(s) stops.

« All events in the program log between the currently playing event and the Time Immediate event
are skipped.

 The Time Immediate event plays. Playback continues from this point forward and all previous
events are skipped.

If playback reached the event at the time specified in the Scheduled Time field, playback stops
until the specified scheduled time, at which time it starts playing the Time Immediate event.

Time Next (#)

The behavior of the Time Next cue type is almost identical to the Time Immediate cue type. The
difference is in when the Time Next event executes. While the Time Immediate event cuts off any
playing events and starts playing, a Time Next event waits for the currently playing event to finish
before executing.

The trade-off is that the Time Next event might be delayed by the end of the previous event, while
the Time Immediate event will play at exactly the time specified in the Scheduled Time field. For
most ‘music-from-hard-drive’ stations, close to the top-of-the-hour is satisfactory for station IDs, so
a song is not cut off, which would offend the listening audience.
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Appendix C - Glossary

Term

Definition

Audio pass-through

The ability of an audio device to route the audio coming through the line-in directly to the
line-out, usually with the ability to control the volume of that audio from 0% (not passing
through) to 100% (fully passed-through). This function is used for spot replacement when
broadcasting syndicated satellite shows.

Cart

In OpX One, a cart is a special file created by the Log Import/ Cart Builder program that
contains references to other files. Think of it as a mini program log. It can contain audio
cuts to rotate or a list of macros to execute. OpX One ftreats carts just like an audio cut,
but the cart its self can contain a set of audio files/commands to execute (playing multiple
audio files/commands when the cart is ‘played’), or a rotation of audio files (playing a
different audio file/command each time the cart is ‘played).

Categories

OpX One can visually differentiate different types of audio files in the OpX One Studio
Client. It does this according to which category each audio cut is assigned to. The
category attribute is stored in the tagging information of each audio file.

Closures

Momentary contacts from an external source received through a device and relayed to an
OpX One Audio Server. Closures are also known as outgoing triggers, or relays.

Database

The internal database OpX One keeps of all audio files and carts in your OpX One
system. The database exists on the OpX One File Server.

De-bouncing

A function that allows a trigger system to ignore triggers for a specified amount of time
after a trigger has been received. This helps combat accidentally repeated triggers from a
satellite syndicator, sloppy relays in a satellite receiver, or if wired to a console switch,
accidentally pressing a button multipletimes.

Default ducking level

The OpX One Audio Server reduces the volume level of audio cuts playing underneath
voicetracks by this amount unless a different amount is specified when a voicetrack is
recorded.

Default segue time

If no segue time is specified in a certain audio cut, OpX One uses the default segue time
to determine when to segue into the next audio cut following it in the program log. The
default value is 250 milliseconds or ¥z second.

Device

A piece of equipment that communicates with an OpX One Audio Server to facilitate
communication with external equipment or switch audio, such as a BSI Trigger Kit,
Broadcast Tools audio switcher or an Axia node.

Device I/0

A setting in the OpX One Audio Server module that allows the module to interface with
external devices such as BSI Trigger Kits, Broadcast Tools switchers, and Axia nodes.

FTP

File Transfer Protocol. A standard “language” for communicating dataffiles across a
network. It is also the means by which audio files and carts are transferred from one OpX
One module to another.

Macro

A command issued to the OpX One Audio Server as a string of text or text and numbers to
perform various functions.

Maximum fade out

A user-selectable option on each Audio Server that allows you to set a maximum amount
of time OpX One will fade each audio cut during playback. This is useful for song libraries
where you want each song to fade over a certain period of time after the segue point of
each song is reached. The default is 3,000 milliseconds or 3 seconds.
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Mixers

Each OpX One Audio Server can control the audio levels of some audio devices such as
audio pass-through in sound cards and Axia nodes. The level controls of each audio
device are accessed through the mixers command.

Mode

Designates how each OpX One Audio Server advances through a program log. There are
two modes for each Audio Server — auto and manual. In auto mode, the audio server
advances through the log automatically unless it encounters a command in a log directing
it to do otherwise. In manual mode, the audio server steps through the log manually,
relying on outside input before advancing

Network

A system of communication between 2 or more computers. This is also referred to as a
LAN, or local area network. Some in the radio/broadcasting industry use the term
‘network” interchangeably to mean either a satellite show, or a computer network. This
manual uses it to mean a computer network.

NIC

Network Interface Card. An expansion board you insert into a computer to connect to a
network.

PAD

Program Associated Data. Each OpX One Audio Server is capable of sending PAD data
via UDP to a single device such as an HD Radio importer, streaming audio encoder or
RDS encoder. PAD data is useful for providing artist/ title information, commercial
substitution, etc.

Playback device

An audio device in or connected to your OpX One system for audio playback. For
example: This could be an audio card, an individual channel of a multi- channel audio
card, or individual output of an Axia node.

Record deck

A device that allows background recording of any type of audio. Recording is a function of
the OpX One Audio Server, with up to 4 simultaneous background records possible.

Satellite show

A function of the OpX One Clock Builder - a simple, Q&A method of building clocks for
syndicated programming. This is the same as what some refer to as a “network” show.
The term “satellite show” is used to differentiate between it and a computer data network.

Sample rate

The number of samples taken of an audio source per second in digitally recorded audio.
By default, OpX One operates at a sample rate of 44,100 Hz.

Scheduled events

Events programmed to execute in the background on an OpX One Audio Server,
independent of the program log. Scheduled events are most commonly used for utility
tasks or “set-it-and-forge- it” tasks.

Segue

A general term used to indicate the transition between two audio cuts. For example: This
can be a “cold” transition, where one audio cut stops and the next one starts, or a cross-
fade between two cuts.

Step through

A preference setting that, when enabled, causes timed events to automatically start if they
are reached in the program log before their specified time effectively treats timed events
as an “Auto Start” cued event. Disabling this setting (which is the default setting) causes
playback of the program log to wait to play an item until its specified time. Typically used
for non-music live, voicetracked or satellite programming.

System tray

Area in the Windows desktop that contains the system clock and status icons of many
applications. The system tray usually appears the right side section of the Taskbar, which
also contains the “Start” button. For example:

- 226PM

Time shift

Recording a satellite show for playback at a later time, complete with triggers. These are
played back through a special deck in the OpX One Audio Server.

Triggers

Also known as closures, they are signals typically from a satellite receiver relay closure or
start/stop buttons on a console that OpX One receives through a “trigger kit” device and
uses to play audio files or perform commands.
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Trigger set

A collection of commands or audio files that OpX One executes when specific closures
are received. Each trigger set is individually named and can be loaded into the OpX One
Audio Server at any time.

Time events

Audio or Macro events scheduled to execute at a specific time. For example, a timed
event is used to ensure that your top of the hour ID will play exactly at the top of the hour.

Verify

A command in the OpX One Studio Client that checks to see whether the files specified in
the currently loaded program log are available to play. This process also verifies that the
artist, title, and description information listed in the program log matches the data
imbedded within each specified audio cut.

Voicetrack

An audio file recorded in OpX One Studio Client to be inserted between two audio cuts
and simulate live air talent. A voice track is a pre-recorded voice-over.
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Index

Playback tab, 55

A program log display, 59
Adding quick tour, 51
a common folder to a station, 44 record configuration settings, 70
a folder to a station, 44 Record tab, 56
audio files using file library, 274 scheduled event set configuration settings, 104
categories, 72 starting, 50
events to Hot Keys, 154 Status tab, 57
events to program log, 151 trigger set configuration settings, 93
items to the program log, 116 Audio Server Watchdog module
local files to carts, 190 menu bar, 325
new program log events, 275 quick tour, 324
satellite show start event, 227 starting, 323
stations to file server, 42 Audio tagging info, editing, 196
ADDTORUNLOG macro, 335 Audition/cue configuration settings, 143
Appearance of Studio Client, 170 Auto fill and time scaling configuration settings, 68
APPLICATION macro, 336 AUTOFILLENABLE macro, 337
ATTIME macro, 336 Automation report template, 197
Audience, 10 Automation reports, 197
Audio events loading into Voicetrack Editor, 164 running, 202
Audio files Auxiliary Audio Server module, starting, 123
adding using file library, 274
editing tagging info, 193 B
Audio Server module Background recording example, 242
auto fill and time scaling configuration settings, 68 Block marker configuration settings, 265
closure and relay configuration settings, 110
configuring, 60 C

Connections tab, 58
Carts

adding local files, 190
creating, 187, 277
editing, 189, 278

data configuration settings, 101
device configuration settings, 75
Devices tab, 58

general configuration settings, 62

saving, 278
menu bar, 52 .
Categories
i fi ti tti ,97 .
mixer configuration settings adding, 72
mode and log configuration settings, 108 deleting, 73

playback configuration settings, 65
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editing, 73 files from file server, 185
CHANNELRELAY macro, 337 files to file server, 183
CLEARSYNC macro, 338 Creating
Clock Builder module automation report template, 197

adding a satellite show start event, 227 carts, 277

configuring, 215 commercial break event, 229

creating a commercial break event, 229 custom event, 234

creating custom event, 234 data repeater, 307

creating multi-hour satellite show clocks, 238 multi-hour satellite show clocks, 238

creating satellite show start event, 217 new carts, 187

creating stop satellite show event, 236 rotating Hot Keys, 155

menu bar, 208 satellite show start event, 217

quick tour, 207 stop satellite show event, 236

recording a satellite show, 238 voicetracks, 164

starting, 205 Cue types, 379

time-shifting a satellite show, 238 program log events, 276

tool bar, 210 Custom event, 234

Clocks, samples, 240
Closure and relay configuration settings, 110 D
CLOSURE macro, 338

COMMENT macro, 339

Commercial break event, 229

Data configuration settings, Audio Server module, 101
Data repeater

creating, 307
COMMERCIALBREAKBEGIN macro , 340 deleting, 312

COMMERCIALBREAKEND macro, 341 editing, 311

Configurations starting and stoppping, 313

production workstation, 17 Data Repeater module

single workstation/single station, 16 menu bar. 304

Configuring quick tour, 303

Audio Server module, 60 starting, 302

Clock Builder module, 215 tool bar, 305

File Manager module, 181 DECKTIMER macro, 342
File Server module, 40
FTP Server module, 299

Import-Merge module, 256

Deleting
categories, 73
data repeater, 312

Mobile Gateway/Client module, 320 items from the program log, 120

studio client module items, 134 Device configuration settings, Audio Server module, 75
Connections List, File Server module, 39 DEVICE macro, 343

Connections tab, Audio Server module, 58 Devices tab, 58

CONSOLEOUT macro, 341

Conventions in this document, 11

Disabling
Virtual Audio Server, 46
Copying Voictrack Transfer module, 47

events to program log, 153 Document conventions, 11
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Ducking levels, 168

Editing

audio tagging info, 196

carts, 278

categories, 73

data repeater, 311

items to the program log, 118
local audio file tagging info, 193
new carts, 189

program log, 151

program log events, 276

Enabling

Virtual Audio Server, 46

Voictrack Transfer module, 47

Events

adding to Hot Keys, 154

adding to program log, 151
changing cue types, 276

copying, 153

for Hot Keys, 156

loading into Voicetrack Editor, 164
moving from program log, 152

removing from program log, 152

F

FADECURRENT macro, 344
FADEOUTLASTITEM macro, 344
File library, using to add audio files, 274
File Manager module
quick tour, 176
starting, 175
File Server module
adding a common folder to a station, 44
adding a folder to a station, 44
adding stations, 42
configuring, 40
Connections List, 39
menu bar, 36
quick tour, 35
starting, 34

Index

Station Folder List, 39
tool bar, 38
Files
added to carts, 190
copying from file server, 185
copying to file server, 183
Final Manager module, 181

Folders

adding a common folder to a station, 44

adding a new folder to a station, 44
FTP Server module

configuring, 299

menu bar, 295

quick tour, 294

tool bar, 297
FTP Server, starting and stoppping, 299

G

General configuration settings
Audio Server module, 62
Import-Merge module, 257
Studio Client module, 135

GETFILLFILES macro, 345

GETPROGRAMLOGS macro, 346

GETVOICETRACKS macro, 346

H

Hot Key pages

loading from file server, 160
navigating, 160

refreshing, 160

saving, 160

Hot Keys

adding an event, 154
list of events, 156
properties, 157
rotating, 155

Import formats configuration settings, 258

Importing

music log, 247
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third-party logs, 255
Import-Merge module
adding audio files using file library, 274
adding new program log events, 275
block marker configuration settings, 265
changing cue types for program log events, 276
configuring, 256
editing program log events, 276
general configuration settings, 257
import formats configuration settings, 258
importing music log, 247
log type configuration settings, 261
menu bar, 250
quick tour, 249
replacing text configuration settings, 267
starting, 248
tool bar, 253
Info Editor module
quick tour, 281
starting, 280
Inserting voicetracks into program log, 169
Installing
OpX, 19
OpX system requirements, 18
USB registration key, 25

Intro times, 289

Loading
audio events into the Voicetrack Editor, 164
Hot Key pages from the file server, 160
program log, 115, 148
LOADLOG macro, 347
LOADLOGFROMSERVER macro, 348
LOADSCHED macro, 348
LOADSCHEDULEDEVENTS macro, 349
LOADTRIGGERS macro, 350
Local audio file tagging info, 193
Local files added to carts, 190
Log type configuration settings, 261
Logs

importing music, 247

Index

Macros, 332

ADDTORUNLOG, 335
APPLICATION, 336
ATTIME, 336
AUTOFILLENABLE, 337
CHANNELRELAY, 337
CLEARSYNC, 338
CLOSURE, 338
COMMENT, 339

COMMERCIALBREAKBEGIN, 340
COMMERCIALBREAKEND, 341

CONSOLEOUT, 341
DECKTIMER, 342
DEVICE, 343
FADECURRENT, 344
FADEOUTLASTITEM, 344
GETFILLFILES, 345
GETPROGRAMLOGS, 346
GETVOICETRACKS, 346
LOADLOG, 347

LOADLOGFROMSERVER, 348

LOADLOGSCHED, 348

LOADSCHEDULEDEVENTS, 349

LOADTRIGGERS, 350
MIXFADE, 351
MIXVOLUME, 352
MODE, 353

PADENABLE, 354
PADOUT, 354

PAUSE, 355

PLAYASYNC, 355
PLAYTIMESHIFT, 356
RECORD, 357

RELAY, 359

RESETCART, 360
RUNAPPLICATION, 361
SATSHOW, 362
SATSHOWTIMER, 363
SAVEPROGRAMLOG, 361
SCHED, 364
SCHEDULEDEVENTS, 365
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SENDPAD, 366 Mode configuration settings, Studio Client module, 139
SERIALOUT, 366 MODE macro, 353

START, 367 Moving events in program log, 152

STARTDECK, 367 Multi-hour satellite show

STARTENABLE, 368 clocks, 238

STARTNEXT, 368 example, 243

STEPTHROUGH, 369

STOP, 370 N

STOPDECK, 370
SYNCRECORDSFOLDER, 371
SYNCRUNLOGSFOLDER, 371
TCPOUT, 372
TIMEDBLOCKEND, 374 o)
TIMEDBLOCKSTART, 373

TIMEEVENTS, 375

TIMESCALEITEM, 376

TRIGGERS, 377

TRIM, 378

Navigating Hot Key pages, 160
Network interface and port, Data Repeater module, 313

New events, adding, 275

Operating modes for Studio Client module, 144
OpX modules

AS Watchdog, 322

Audio Server, 49

Auxiliary Audio Server, 122

Clock Builder, 204

Data Repeater, 301

Matching users with OpX modules, 14
Menu bar
Clock Builder module, 208

descriptions, 13
Data Repeater module, 304

File Manager, 174
File Server, 33

FTP Server, 292

File Audio Server module, 52

File Audio Server Watchdog module, 325
File Server module, 36

FTP Server module, 295

Import-Merge module, 250

Mobile Gateway/Client module, 318

Import-Merge, 247

Info Editor, 279

matching users, 14

Mobile Gateway/Client, 314, 332
Remote Voice Track Transfer, 48

Studio Client, 124

Mixers

configuration settings for Audio Server module, 97

creating and editing for Audio Server module, 97
MIXFADE macro, 351 P
MIXVOLUME macro, 352

Mobile Gateway/Client module PADENABLE macro, 354

PADOUT macro, 354
PAUSE macro, 355
PLAYASYNC macro, 355

configuring, 320

menu bar, 318

quick tour, 317

starting, 315 Playback configuration settings

tool bar, 319 Audio Server module, 65
Mobile Gateway/Client, starting and stoppping, 321 Studio Client module, 140
Mode and log configuration settings, Audio Server Playback tab, Audio Server module, 55
module, 108 Playing back

items from the program log, 120
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program log, 150 satellite show, 238
PLAYTIMESHIFT macro, 356 voicetracks, 165
Previewing voicetracks, 167 Refreshing Hot Key pages from the file server, 160
Production workstation configuration, 17 Registering the OpX system, 31
Program log Registration key, 25
adding events, 151, 275 RELAY macro, 359
adding items, 116 Remote Voice Track Transfer module, 48
changing event cue types, 276 Removing
copying events, 153 events to program log, 152
deleting items, 120 Replacing text configuration settings, 267
display on Audio Server module, 59 Requirements for importing third-party logs, 255
editing, 151 RESETCART macro, 360
editing events, 276 Rotating Hot Keys, 155
editing items, 118 RUNAPPLICATION macro, 361
inserting voicetracks, 169 Running automation reports, 202

loading, 115, 148

S

moving events, 152

playing back, 150 Sample clocks, 240

playing back items, 120 background recording, 242

removing events, 152 multi-hour satellite show, 243

verifying, 146 satellite music show, 241

Properties, Hot Keys, 157 satellite talk show with top-of-the-hour news, 240

time-shift playback, 243

Q

utility tasks without satellite show audio, 246

Quick tour Satellite
Audio Server module, 51 adding show start event, 227
Audio Server Watchdog module, 324 background recording example, 242
Clock Builder module, 207 commercial break event, 229
Data Repeater module, 303 creating show start event, 217
File Manager module, 176 custom event, 234
File Server module, 35 multi-hour satellite show example, 243
FTP Server module, 294 multi-hour show clocks, 238
Import-Merge module, 249 music show example, 241
Info Editor module, 281 record show, 238
Mobile Gateway/Client module, 317 stop satellite show event, 236
Studio Client module, 126 talk show with top-of-the-hour news, 240

time-shift playback example, 243
R time-shifting show, 238
utility tasks without satellite show audio example,
246
SATSHOW macro, 362

SATSHOWTIMER macro, 363

Record configuration settings, Audio Server module, 70
RECORD macro, 357
Record tab, Audio Server module, 56

Recording
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SAVEPROGRAMLOG macro, 361
Saving

carts, 278

Hot Key pages, 160
SCHED macro, 364

Scheduled event set configuration settings, Audio Server

module, 104
SCHEDULEDEVENTS macro, 365
Segue

start points, 167

times, 289
SENDPAD macro, 366
SERIALOUT macro, 366
Single workstation/single station configuration, 16
START macro, 367
STARTDECK macro, 367
STARTENABLE macro, 368
Starting

data repeater, 313

FTP Server, 299

Mobile Gateway/Client, 321

OpX modules

Audio Server, 50
Audio Server Watchdog, 323
Aucxiliary Audio Server, 123
Clock Builder, 205
Data Repeater, 302
File Manager, 175
File Server, 34
Import-Merge, 248
Info Editor, 280
Mobile Gateway/Client, 315
Studio Client, 125
STARTNEXT macro, 368
Station Folder List, File Server module, 39
Stations

adding a common folder, 44

adding a folder, 44

adding to a file server, 42
Status tab, Audio Server module, 57
STEPTHROUGH macro, 369
STOP macro, 370

Stop Satellite show event, creating, 236
STOPDECK macro, 370
Stopping
data repeater, 313
FTP Server, 299
Mobile Gateway/Client, 321
Studio Client module
audio/cue configuration settings, 143
configuring, 134
general configuration settings, 135
mode configuration settings, 139
operating modes, 144
playback configuration settings, 140
quick tour, 126
starting, 125
verifying program log, 146
voicetracking configuration settings, 141
Studio Client, changing appearance, 170
SYNCRECORDSFOLDER macro, 371
SYNCRUNLOGSFOLDER macro, 371

System requirements, 18

TCPOUT macro, 372
Third-party log import requirements, 255
TIMEDBLOCKEND macro, 374
TIMEDBLOCKSTART macro, 373
TIMEEVENTS macro, 375
TIMESCALEITEM macro, 376
Time-shift

playback example, 243

satellite show, 238
Tool bar

Clock Builder module, 210

Data Repeater module, 305

File Server module, 38

FTP Server module, 297

Import-Merge module, 253

Mobile Gateway/Client module, 319

Trigger set configuration settings, Audio Server module,

93
TRIGGERS macro, 377
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TRIM macro, 378 loading audio events, 164
previewing voicetracks, 167
recording voicetracks, 165

USB registration key, 25 seque start points, 167

Utility tasks without satellite show audio, 246 Voicetrack Transfer module, enabling or disabling, 47

Voicetracking configuration settings
V Studio Client module, 141

Voicetracks
Verifying program log, 146
creating, 164
Virtual Audio Server, enabling or disabling, 46
ducking levels, 168
Voicetrack Editor
inserting into program log, 169
creating voicetracks, 164
previewing, 167
ducking levels, 168
recording, 165
inserting voicetracks into program log, 169
seque start points, 167
interface, 163
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